Section I

Breaking Away™ Overlay

For GoldMine Premium Edition version 8x
# Section I Table of Contents

GoldMine Premium Edition version 8x  
Revised 1-18-10

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>A - Technical Support</td>
<td>1</td>
</tr>
<tr>
<td>B - Field Definitions</td>
<td>1</td>
</tr>
<tr>
<td>Main View</td>
<td>1</td>
</tr>
<tr>
<td>Personal Contact Record</td>
<td>1</td>
</tr>
<tr>
<td>Business Contact Record</td>
<td>4</td>
</tr>
<tr>
<td>Summary Tab</td>
<td>9</td>
</tr>
<tr>
<td>Fields Tab</td>
<td>11</td>
</tr>
<tr>
<td>Personal Contact Record</td>
<td>11</td>
</tr>
<tr>
<td>Business Contact Record</td>
<td>14</td>
</tr>
<tr>
<td>Paperwork Tab</td>
<td>16</td>
</tr>
<tr>
<td>Personal Contact Record</td>
<td>16</td>
</tr>
<tr>
<td>Business Contact Record</td>
<td>18</td>
</tr>
<tr>
<td>Favorites Tab</td>
<td>19</td>
</tr>
<tr>
<td>Personal Record Type</td>
<td>20</td>
</tr>
<tr>
<td>C - Detail Type Definitions</td>
<td>1</td>
</tr>
<tr>
<td>15 Questions</td>
<td>1</td>
</tr>
<tr>
<td>Account</td>
<td>1</td>
</tr>
<tr>
<td>Asset/Liability</td>
<td>2</td>
</tr>
<tr>
<td>Beneficiary</td>
<td>3</td>
</tr>
<tr>
<td>Dependent</td>
<td>4</td>
</tr>
<tr>
<td>Estate Planning</td>
<td>5</td>
</tr>
<tr>
<td>Event</td>
<td>5</td>
</tr>
<tr>
<td>Financial Planning</td>
<td>6</td>
</tr>
<tr>
<td>Gift</td>
<td>7</td>
</tr>
<tr>
<td>Hobby</td>
<td>7</td>
</tr>
<tr>
<td>Life Insurance</td>
<td>7</td>
</tr>
<tr>
<td>Login Information</td>
<td>8</td>
</tr>
<tr>
<td>Long-Term Care</td>
<td>8</td>
</tr>
<tr>
<td>Other Insurance</td>
<td>9</td>
</tr>
<tr>
<td>Random Act of Kindness™</td>
<td>9</td>
</tr>
<tr>
<td>Tax</td>
<td>10</td>
</tr>
<tr>
<td>D - Filter &amp; SQL Query Definitions</td>
<td>1</td>
</tr>
<tr>
<td>E-1 - GoldMine Report Definitions</td>
<td>1</td>
</tr>
<tr>
<td>Labels and Envelopes</td>
<td>1</td>
</tr>
<tr>
<td>Mail To</td>
<td>1</td>
</tr>
<tr>
<td>Pri Name/Contact</td>
<td>1</td>
</tr>
<tr>
<td>Sec Name</td>
<td>1</td>
</tr>
<tr>
<td>E-2 - Crystal Reports Definitions</td>
<td>2</td>
</tr>
<tr>
<td>Reports</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Contact Reports</td>
<td>2</td>
</tr>
<tr>
<td>Accounts Report</td>
<td>2</td>
</tr>
<tr>
<td>Asset/Liability Report</td>
<td>2</td>
</tr>
<tr>
<td>Birthday Gift Order Report</td>
<td>2</td>
</tr>
<tr>
<td>Birthday Report (Pri Name)</td>
<td>3</td>
</tr>
<tr>
<td>Birthday Report (Sec Name)</td>
<td>3</td>
</tr>
<tr>
<td>Client Anniversary with Firm Report</td>
<td>4</td>
</tr>
<tr>
<td>Contact List</td>
<td>4</td>
</tr>
<tr>
<td>Dependants Report</td>
<td>4</td>
</tr>
<tr>
<td>E-mail Address List</td>
<td>4</td>
</tr>
<tr>
<td>Estate Planning Report</td>
<td>5</td>
</tr>
<tr>
<td>Financial Planning Report</td>
<td>5</td>
</tr>
<tr>
<td>History Report</td>
<td>6</td>
</tr>
<tr>
<td>Hobbies Report</td>
<td>6</td>
</tr>
<tr>
<td>Life Insurance Report</td>
<td>6</td>
</tr>
<tr>
<td>Long-Term Care Insurance Report</td>
<td>7</td>
</tr>
<tr>
<td>Market Commentary Recipients</td>
<td>7</td>
</tr>
<tr>
<td>Other Insurance Report</td>
<td>7</td>
</tr>
<tr>
<td>Tax Planning/Return Report</td>
<td>8</td>
</tr>
<tr>
<td>Wedding Anniversary Report</td>
<td>8</td>
</tr>
<tr>
<td>Calendar Printouts</td>
<td>8</td>
</tr>
<tr>
<td>Completed Activities Report</td>
<td>8</td>
</tr>
<tr>
<td>Daily Calendar Report</td>
<td>9</td>
</tr>
<tr>
<td>Pending Activities Report</td>
<td>9</td>
</tr>
<tr>
<td>Analysis Reports</td>
<td>9</td>
</tr>
<tr>
<td>Client Gift &amp; RAK Tracking Report</td>
<td>9</td>
</tr>
<tr>
<td>Client ID’s Due to Expire</td>
<td>10</td>
</tr>
<tr>
<td>Client’s Missing Important Info</td>
<td>10</td>
</tr>
<tr>
<td>Client’s Not Contacted in Time Period</td>
<td>10</td>
</tr>
<tr>
<td>Clients of a Certain Age by Year’s End</td>
<td>11</td>
</tr>
<tr>
<td>Clients with Referrals Report</td>
<td>11</td>
</tr>
<tr>
<td>Clients with RMD Required by Year’s End</td>
<td>11</td>
</tr>
<tr>
<td>Clients without Random Acts of Kindness™</td>
<td>12</td>
</tr>
<tr>
<td>Clients without Referrals Report</td>
<td>12</td>
</tr>
<tr>
<td>Completed Transactions Summary Report</td>
<td>12</td>
</tr>
<tr>
<td>Forecasted Transactions Report</td>
<td>13</td>
</tr>
<tr>
<td>Prospect to Client Conversion Report</td>
<td>13</td>
</tr>
<tr>
<td>Labels and Envelopes</td>
<td>13</td>
</tr>
<tr>
<td>Avery 5160 Event Sign In Labels</td>
<td>13</td>
</tr>
<tr>
<td>Avery 5395 Nametags</td>
<td>14</td>
</tr>
<tr>
<td>Other Reports</td>
<td>14</td>
</tr>
<tr>
<td>Appointment Sheet by Date (Long)</td>
<td>14</td>
</tr>
<tr>
<td>Appointment Sheet by Date (Short)</td>
<td>15</td>
</tr>
<tr>
<td>Appointment Sheet by SSN (Long)</td>
<td>15</td>
</tr>
<tr>
<td>Appointment Sheet by SSN (Short)</td>
<td>15</td>
</tr>
<tr>
<td>Events Report</td>
<td>16</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Update Preparation Report by Date</td>
<td>16</td>
</tr>
<tr>
<td>Update Preparation Report by SSN</td>
<td>16</td>
</tr>
<tr>
<td>Update Scheduling Report</td>
<td>16</td>
</tr>
<tr>
<td>F - Automated Process Definitions</td>
<td>1</td>
</tr>
<tr>
<td>Annual Surveys – Monthly Groups</td>
<td>1</td>
</tr>
<tr>
<td>Annual Surveys – Quarterly Groups</td>
<td>1</td>
</tr>
<tr>
<td>Client Anniversaries with Firm</td>
<td>2</td>
</tr>
<tr>
<td>Client Birthdays</td>
<td>6</td>
</tr>
<tr>
<td>Client Wedding Anniversaries</td>
<td>11</td>
</tr>
<tr>
<td>New Client</td>
<td>15</td>
</tr>
<tr>
<td>Periodic Updates/Reviews</td>
<td>21</td>
</tr>
<tr>
<td>First Year RMD Notification – Pri Name</td>
<td>25</td>
</tr>
<tr>
<td>First Year RMD Notification – Sec Name</td>
<td>27</td>
</tr>
<tr>
<td>Successive Years RMD Notification – Pri</td>
<td>29</td>
</tr>
<tr>
<td>Successive Years RMD Notification – Sec</td>
<td>31</td>
</tr>
</tbody>
</table>
A - Technical Support

Technical support availability:

- Technical support is available to current Breaking Away™ members.
- TICOMIX’s technical support staff are available Monday through Friday from 8 am to 5 pm, CST (excluding holidays).
- Support via e-mail may be obtained by going to our website, www.ticomix.com, logging in to the Members Only section, clicking on the Breaking Away™ link, clicking on the Request Support link, filling out the support request form, and clicking the SUBMIT button.
- Support via phone may be obtained by calling 1-866-TICOMIX.
- Training sessions (via webinar) can be requested by going to our website, www.ticomix.com, logging in to the Members Only section, clicking on the Breaking Away™ link, clicking on the Training Request link, filling out the training request form, and clicking the SUBMIT button.

Technical support will be provided by TICOMIX according to the following guidelines:

- TICOMIX will provide technical support that is directly related to your GoldMine®/Breaking Away system. Issues pertaining to your internal network, other software, etc. must be handled by someone other than TICOMIX, such as your firm's internal Information Technology professional.
- Support provided via e-mail is free.
- Limited free technical support by phone includes addressing issues where there is a technical problem with your GoldMine®/Breaking Away system that must be resolved by a TICOMIX technical support staff member.
- Technical support will be provided at the sole discretion of TICOMIX in that we reserve the right to handle each situation in the most appropriate manner. As a result, there may be instances where we deem it necessary and/or more efficient to address an issue/question via phone rather than by e-mail and vice-versa.
- Additional “live” technical support is available at the rate of $120/hr (in 15 minute increments with a $30 minimum). This includes, but is not limited to, training, customizations, synchronization configuration, support for iGoldMine®, new PC/server set up and configuration, etc.
- Breaking Away members who are current with their GoldMine® maintenance have access to limited technical support from FrontRange Solutions. Such support is not specific to Breaking Away. Therefore, all technical support requests should go through TICOMIX to ensure that your questions/issues are followed-up on in the most effective and efficient manner possible. If necessary, we will direct you to FrontRange Solutions for support (e.g., for GoldMine® or iGoldMine® software-specific issues beyond TICOMIX’s control).

Please Note: Any issues or questions of a non-urgent nature should be submitted via the Request Support link on our website as described above. A member of our technical support staff will attempt to contact you within 24 hours (i.e., one business day).
Main View

The Main View contains primary contact information such as names, address, and phone numbers as well as several other fields.

Contact Type – This is where you would identify whether the contact record is a Personal or Business contact record. This field is meant to be set once and not changed in the future. To assist with consistency, choose the contact type from the Lookup List. The fields that correspond to each contact type are described in detail below.

Personal Contact Record

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pri Name</td>
<td>This field is where you would put the full legal name of the primary contact.</td>
</tr>
<tr>
<td>Gender</td>
<td>These fields are to designate the gender of the corresponding contact name.</td>
</tr>
<tr>
<td>Sec Name</td>
<td>This field would generally be for a client’s spouse/partner and should also</td>
</tr>
<tr>
<td>Company</td>
<td>This field is where you would put the contact’s company name if applicable.</td>
</tr>
<tr>
<td>Dear</td>
<td>This is what would appear in the greeting of written correspondence literally</td>
</tr>
<tr>
<td></td>
<td>after the “Dear” and before the comma. If the client has a nickname, you</td>
</tr>
<tr>
<td></td>
<td>would enter that here. Typically, in a husband/wife scenario, the Dear field</td>
</tr>
</tbody>
</table>

© TICOMIX™ 2009, All Rights Reserved
contain both of their first names. This field is automatically populated when adding a new contact with the first "words" in the Pri Name and Sec Name fields but it can be changed manually.

**Last** – This field is automatically populated with the last "word" in the Pri Name field, but it can be changed manually. Note that anytime the Pri Name is changed, the Last field is automatically updated. The main purpose of this field is for searching and sorting.

**Mail To** – This field is for the first line of an address when printing envelopes, labels, etc. You can manually populate this field or make a selection from the Lookup List.

**Add** – This field is where you enter the primary mailing address for the contact. There are two lines for you to use.

**City, State, Zip** – The “City:” and “State:” fields will be automatically populated when you enter the zip code, unless a particular zip code is not located in the database. Then, you would be prompted to enter the city and state associated with the zip code and it would then be stored in the database for future use.

**Country** – This field should be left blank unless the client is located outside the United States. The reason for this is that you do not want U.S.A. to appear in the address on mailing labels, envelopes, etc.

**Merge** – This field allows you to enter a code (e.g., WMC) in order to create a targeted subset of contact records associated with a particular activity, event, etc. Multiple merge codes may be entered by separating them with a comma. Note that these should only be used for temporary designations and should be cleared out of the Merge field when no longer used or applicable.

**Home Phone, Pri Work Phone, Sec Work Phone, Pri Cell Phone, Sec Cell Phone, Alt Phone, and Fax** – These fields are for the contact’s phone numbers. “Pri” fields are associated with the “Pri Name:” and “Sec” fields are associated with the “Sec Name:”.

**Ext** – These fields allow for entering numbers and/or characters. This way you can specify an extension or use the “Ext:” field to clarify what a number corresponds to (e.g., Beeper).

**Phone Pref** – This field allows you to designate which phone number the contact prefers you to use when calling them. It’s Lookup List should not be changed so as to allow the selections to properly flag the specified phone number by coloring it green.

**LookUp List Entries:**
Alt Phone
Fax
Home Phone

Pri Cell Phone // a.k.a. Cell Phone – this selection should be used to designate the “Cell Phone:” for Business contact records

Pri Work Phone // a.k.a. Work Phone – this selection should be used to designate the “Work Phone:” for Business contact records

Sec Cell Phone // N/A for Business – this selection does not pertain to Business contact records

Sec Work Phone // N/A for Business – this selection does not pertain to Business contact records

E-mail – This field is different from the other fields in that it is not actually a database field that stores one entry per contact record. The “E-mail:” field is actually stored as a detail record which supports the storage of multiple entries per contact record. When you click on an e-mail address, a window will pop up that allows you to add/delete/edit entries. It is very important that one of the entries is designated as the Primary e-mail address. You may also assign e-mail merge codes to each individual e-mail address to denote a specific subset of e-mail addresses to be utilized in correspondence. Note that these e-mail addresses will also appear on the Details tab. You may also utilize the hyperlink to access the primary e-mail address directly in the Main View.

Unsubscribes – This field indicates whether the contact has unsubscribed from any informational material sent in bulk (e.g., the Weekly Market Commentary). To assist with consistency, populate the Lookup List with the services in your office and then choose the one for the contact record from there.

Client Status – This field identifies the relationship of the contact record with your company. Choose one from the Lookup List to maximize filtering and reporting effectiveness.

LookUp List Entries:
Applicant – an individual applying for a position in your practice
Client – an individual or business that pays you as their financial advisor
COI // Center of Influence – an individual who provides prospective clients to the practice (e.g., CPA, Attorney)
Deceased – any contact record who is deceased
Drip – a prospect that may do business with your practice in the future for which you wish to remain in contact or a relative of a client who wants them to receive the Weekly Market Commentary
Employee – an individual who is employed with your firm
Former Client – a client who has left the practice and taken all assets to another advisor
Former Prospect – a prospect who has requested no additional contact or the advisor has indicated they no longer need to be invited to events or sent the Weekly Market Commentary
Other – make sure this is clearly defined in your office before using
Prospect – an individual or business who may become a client
Vendor – an individual or business that supports different functions of the practice (e.g., wholesalers, florist, home office personnel)

Advisor – This field should contain the GoldMine username of the main advisor that is associated with the contact. In the case of joint advisors, populate this field with the username for the advisor whose calendar should be updated by automated processes. This will be used for reporting, filtering, and scheduling purposes. Note it is best to consistently input these in all capital letters so that reports can pull the data correctly. To assist with consistency, populate the Lookup List with the advisors’ GoldMine usernames in your office and then choose the correct one for the contact record from there.

Rating – You will choose a rating of 0 through 5 for this field which corresponds to no rating, or A+ through D clients/prospects as mentioned in the Quest for Excellence™ (QFE) consulting program.

LookUp List Entries:
1 // A+ – clients who bring in the majority of your production, you genuinely like them and they provide you with quality referrals
2 // A – clients who have the potential of becoming A+ clients or refer A+ clients
3 // B – clients who have the potential of becoming A or A+ clients
4 // C – clients who are primarily transactional only
5 // D – not based on household assets only, but these clients should be fired

Rep ID # – You will populate this field with the Rep ID # or any other ID that identifies the advisor(s) responsible for this client. To assist with consistency, populate the Lookup List with the advisors’ Rep ID #’s (including joint advisor ID’s where appropriate) in your office and then choose the correct one for the contact record from there.

Unique Info – This is where you can put important information regarding the contact that people in your organization need to know. It is a good idea to date this information so that people looking at it know whether or not it is current.

Web Site – This field is different from the other fields in that it is not actually a database field that stores one entry per contact record. The Web Site field is actually stored as a detail record which supports the storage of multiple entries per contact record. When you click on a web site, a window will pop up that allows you to add/delete/edit entries. It is

© TICOMIX™ 2009, All Rights Reserved
very important that one of the entries is designated as the Primary website. Note that these websites will also appear on the Details tab. You may also utilize the hyperlink to access the primary website directly.

**Business Contact Record**

- **Company** – This field is where you would put the company name for the contact.

- **Contact** – This field is where you would put the full legal name of the main company contact.

- **Gender** – This field is to designate the gender of the company contact. To assist with consistency, choose the gender from the Lookup List.

- **Title** – This is the title the company contact goes by.

- **Dear** – This is what would appear in the greeting in written correspondence literally after the “Dear” and before the comma. If the client has a nickname, you would enter that here. This field is automatically populated when adding a new contact record with the first “word” in the Contact field, but it can be changed manually.

- **Last** – This field is automatically populated with the last “word” in the Contact field, but it can be changed manually. Note that anytime the Contact field is changed, the Last field is automatically updated. The main purpose of this field is for searching and sorting.

- **Mail To** – This field is for the first line of an address when printing envelopes, labels, etc. You can manually populate this field or make a selection from the Lookup List.

- **Add** – This field is where you enter the primary mailing address for the company. There are two lines for you to use.
City, State, Zip – The “City:” and “State:” fields will be automatically populated when you enter the zip code, unless a particular zip code is not located in the database. Then, you would be prompted to enter the city and state associated with the zip code and it would then be stored in the database for future use.

Country – This field should be left blank unless the client is located outside the United States. The reason for this is that you do not want U.S.A. to appear in the address on mailing labels, envelopes, etc.

Merge – This field allows you to enter a code (e.g., WMC) in order to create a targeted subset of contact records associated with a particular activity, event, etc. Multiple merge codes may be entered by separating them with a comma. Note that these should only be used for temporary designations and should be cleared out of the Merge field when no longer used or applicable.

Home Phone, Work Phone, Cell Phone, Alt Phone, and Fax – These fields are for the contact’s phone numbers.

Ext – These fields allow for entering numbers and/or characters. This way you can specify an extension or use the “Ext:” field to clarify what a number corresponds to (e.g., Beeper).

Phone Pref – This field allows you to designate which phone number the contact prefers you to use when calling them. It’s Lookup List should not be changed so as to allow the selections to properly flag the specified phone number by coloring it green.

LookUp List Entries:
Alt Phone
Fax
Home Phone
Pri Cell Phone // a.k.a. Cell Phone – this selection should be used to designate the “Cell Phone:” for Business contact records
Pri Work Phone // a.k.a. Work Phone – this selection should be used to designate the “Work Phone:” for Business contact records
Sec Cell Phone // N/A for Business – this selection does not pertain to Business contact records
Sec Work Phone // N/A for Business – this selection does not pertain to Business contact records

E-mail – This field is different from the other fields in that it is not actually a database field that stores one entry per contact record. The “E-mail:” field is actually stored as a detail record which supports the storage of multiple entries per contact record. When you click on an e-mail address, a window will pop up that allows you to add/delete/edit entries. It is very important that one of the
entries is designated as the Primary e-mail address. You may also assign e-mail merge codes to each individual e-mail address to denote a specific subset of e-mail addresses to be utilized in correspondence. Note that these e-mail addresses will also appear on the Details tab. You may also utilize the hyperlink to access the primary e-mail address directly on the Main View.

**Unsubscribe** – This field indicates whether the contact has unsubscribed from any informational material sent in bulk (e.g., the Weekly Market Commentary). To assist with consistency, populate the Lookup List with the services in your office and then choose the one for the contact record from there.

**Client Status** – This field identifies the relationship of the contact record with your company. Choose one from the Lookup List to maximize filtering and reporting efficiency.

*LookUp List Entries:*
- **Applicant** – an individual applying for a position in your practice
- **Client** – an individual or business that pays you as their financial advisor
- **COI // Center of Influence** – an individual who provides prospective clients to the practice (e.g., CPA, Attorney)
- **Deceased** – any contact record who is deceased
- **Drip** – a prospect that may do business with your practice in the future for which you wish to remain in contact or a relative of a client who wants them to receive the Weekly Market Commentary
- **Employee** – an individual who is employed with your firm
- **Former Client** – a client who has left the practice and taken all assets to another advisor
- **Former Prospect** – a prospect who has requested no additional contact or the advisor has indicated they no longer needs to be invited to events or sent the Weekly Market Commentary
- **Other** – make sure this is clearly defined in your office before using
- **Prospect** – an individual or business who may become a client
- **Vendor** – an individual or business that supports different functions of the practice (e.g., wholesalers, florist, home office personnel)

**Advisor** – This field should contain the GoldMine username of the main advisor that is associated with the contact. In the case of joint advisors, populate this field with the username for the advisor whose calendar should be updated by automated processes. This will be used for reporting, filtering, and scheduling purposes. Note it is best to consistently input these in all capital letters so that reports can pull the data correctly. To assist with consistency, populate the Lookup List with the advisors’ GoldMine usernames in your office and then choose the correct one for the contact record from there.
Section I

B – Field Definitions

Rating – You will choose a rating of 0 through 5 for this field which corresponds to no rating, or A+ through D clients as mentioned in the Quest for Excellence™ (QFE) consulting program.

LookUp List Entries:
1 // A+ – clients who bring in the majority of your production, you genuinely like them and they provide you with quality referrals
2 // A – clients who have the potential of becoming A+ clients or refer A+ clients
3 // B – clients who have the potential of becoming A or A+ clients
4 // C – clients who are primarily transactional only
5 // D – not based on household assets only, but these clients should be fired

Rep ID # – You will populate this field with the Rep ID # or any other ID that identifies the advisor(s) responsible for this client. To assist with consistency, populate the Lookup List with the advisors’ Rep ID #’s (including joint advisor ID’s where appropriate) in your office and then choose the correct one for the contact record from there.

Unique Info – This is where you can put important information regarding the contact that people in your organization need to know. It is a good idea to date this information so that people looking at it know whether or not it is current.

Web Site – This field is different from the other fields in that it is not actually a database field that stores one entry per contact record. The Web Site field is actually stored as a detail record which supports the storage of multiple entries per contact record. When you click on a web site, a window will pop up that allows you to add/delete/edit entries. It is very important that one of the entries is designated as the Primary web site. Note that these web sites will also appear on the Details tab. You may also utilize the hyperlink to access the primary web site directly.
## Summary Tab

The information contained here is automatically populated by the GoldMine® Calendar.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td>We recommend not using this field since a user will not often look at this tab. Instead, use the Unique Info field in the Main View. This is one of only three fields on the Summary tab that may be manually entered.</td>
</tr>
<tr>
<td>Prev Results</td>
<td>Displays the Reference information for the last action recorded on the record’s History Tab. This is one of only three fields on the Summary tab that may be manually entered, but it will be automatically updated in conjunction with completed activities.</td>
</tr>
<tr>
<td>Next Step</td>
<td>Displays the Reference information for the next scheduled activity on the record’s Pending tab. This is one of only three fields on the Summary tab that may be manually entered, but it will be automatically updated in conjunction with scheduled activities.</td>
</tr>
<tr>
<td>Next Action</td>
<td>Displays the date of the next scheduled Next Action.</td>
</tr>
<tr>
<td>Call Back</td>
<td>Displays the date of the next scheduled Call.</td>
</tr>
<tr>
<td>Appointment</td>
<td>Displays the date of the next scheduled Appointment.</td>
</tr>
<tr>
<td>Forecast</td>
<td>Displays the date of the next scheduled Forecasted Sale.</td>
</tr>
<tr>
<td>Last Contact</td>
<td>Displays the date of the last successful contact made with the client. Successful completions of calls, appointments, etc. will trigger this field to be updated.</td>
</tr>
<tr>
<td>Last Attempt</td>
<td>Displays the date of the last unsuccessful contact made with the client. Unsuccessful completions of calls, appointments, etc. will trigger this field to be updated.</td>
</tr>
<tr>
<td>Last Update</td>
<td>Displays the date the record was last updated as well as the GoldMine® username of the user who made the update.</td>
</tr>
</tbody>
</table>
Creation – Displays the date the record was created and the GoldMine® username of the user who created it.

Record – This field is not currently active.
**Fields Tab**

This tab is completely customized with fields for Breaking Away™.

**Personal Contact Record**

**Pri Birth Date, Sec Birth Date** – This field is the birth date for each contact name. This field holds 8 digits so make sure to enter the year as 4 digits. Otherwise, GoldMine® will consider ‘65’ to be ‘2065’ instead of ‘1965’. For example, 08091965.

**Age** – This field will automatically calculate the age for the corresponding birth date. It will display “Deceased” if the corresponding contact has a date entered in the “Date of Death:” field on the Paperwork tab. This field may not be manually modified.

**Marital Status** – This field indicates the marital status of the contact. To assist with consistency, choose the marital status from the Lookup List.

**Anniv. Date** – This field is the wedding anniversary for the client if the marital status is ‘Married’. The field holds 8 digits so make sure to enter the year as 4 digits. Otherwise, GoldMine will consider ‘65’ to be ‘2065’ instead of ‘1965’. For example, 08091965.

**# Yrs** – This field will automatically calculate the number of years the contact has been married if Marital Status is “Married” and an anniversary date is entered. This field may not be manually modified.

**Newsletter** – This field indicates whether the contact receives your organization’s newsletter.

**Stage** – This field is used to track what stage of the prospect/client process the contact is at. To assist with consistency, choose the stage from the Lookup List.

**LookUp List Entries:**

- **Prospect Packet** – Sent to prospect to review information, complete the Confidential Profile and return prior to Data Gathering Appointment
Data Gathering Appointment – Advisor holds appointment with prospect to review the Confidential Profile and determine if a client/advisor relationship should be formed for the benefit of both. At the conclusion of this appointment, the Proposal Appointment is set and a Financial Planning fee is collected.

Proposal Appointment – Advisor holds appointment with prospect and delivers financial plan. At the conclusion of this appointment, the Implementation Appointment is set to complete all necessary paperwork for the transfer of assets.

Implementation Appointment – Team Leader or Advisor holds appointment with prospect and has all paperwork completed and signed. At the conclusion of this appointment, an Allocation Appointment may be needed once all transfers have been completed.

Allocation Appointment – Advisor holds appointment to discuss the specific investment recommendations.

Initial Review/Update – If a client is Rated A+ or A, they will receive a notebook at their first update. This field will indicate to the team that a notebook should be ordered.

Periodic Review/Update – After the client’s Initial Review/Update, this field will remain at this level as long as the contact remains as a client.

Packet Status – This field is for tracking the stage of where the prospect is with requesting/sending/receiving their prospect packet. To assist with consistency, choose the packet status from the Lookup List.

LookUp List Entries:
- Not Requested – Used when a client brought a guest to an event but the prospect did not request a Prospect Packet.
- Received – Not Qualified – Prospect returned the Confidential Profile, but they didn’t meet account minimums or didn’t have reasonable expectations for their investments or the relationship.
- Received – Qualified – Review of the Confidential Profile indicates they meet our minimum requirements and a Data Gathering Appointment should be set.
- Refused to Return – Prospect indicates they don’t wish to return the Confidential Profile, won’t return repeated calls, or keeps delaying the return of the Confidential Profile.
- Requested – Prospect call, attends event, post a request on the website for information about your practice.
- Sent – Prospect Packet was sent no later than 48 hours after it was requested.

Survey Rating – This field will contain the actual survey rating from the client. The format is [score] – [year]. Use the Lookup List to choose a rating from 1 to 11 and it will automatically enter the current year.
**Client Start Dt** – This is the date the client actually became a client. This will be used for reporting the client’s anniversary with your organization.

**Init Cont Type** – This is the initial contact type and how the client became aware of your organization (e.g., newspaper, workshop, etc.). To assist with consistency, add to the Lookup List with the contact types in your office and then choose the one for the contact record from there.

**Source** – This field contains the details of the initial contact type (e.g., which paper, what event, etc.). If the Init Cont Type is Referral, then enter in that information on the Referrals tab.

**Estate Planning, Fin’l Planning, Life Insurance, Long-Term Care, and Tax Plan/Return** – These are Yes/No fields to indicate whether your organization is providing these respective services for the client. Additional information about these services will be entered on their corresponding tab.

**Update Freq** – Works closely with the Dt Last Updated field and dictates how often a client is to have an update meeting. It is very important that this field be populated for new clients as well to make sure they get an initial update. To assist with consistency, choose the update frequency from the Lookup List.

- **LookUp List Entries:**
  - Annual // i.e., once per year
  - Monthly // i.e., once per month
  - Quarterly // i.e., once every 3 months
  - Semi-Annual // i.e., once every 6 months
  - Tri-Annual // i.e., once every 4 months

**Dt Last Updated** – Works closely with the Update Freq field to determine when the client should have their next update meeting. It is very important that this field be populated for new clients as well to make sure they get an initial update. The date will appear green if an update is due in the current month and red if an update is overdue.

**Notebook Rec’d, Last NB Update** – We give our A+ and A clients notebook binder to keep broker/dealer (as well as outside-held) account statements. These fields track if it was received and the last date it was updated by us in the office.

**Household Assets** – This field contains the dollar amount of the total household assets you are managing for the client.
Business Contact Record

Stage – This field is used to track what stage of the prospect/client process the contact is at. To assist with consistency, choose the stage from the Lookup List.

LookUp List Entries:
Prospect Packet – Sent to prospect to review information, complete the Confidential Profile and return prior to Data Gathering Appointment
Data Gathering Appointment – Advisor holds appointment with prospect to review the Confidential Profile and determine if a client/advisor relationship should be formed for the benefit of both. At the conclusion of this appointment, the Proposal Appointment is set and a Financial Planning fee is collected.
Proposal Appointment – Advisor holds appointment with prospect and delivers financial plan. At the conclusion of this appointment, the Implementation Appointment is set to complete all necessary paperwork for the transfer of assets.
Implementation Appointment – Team Leader or Advisor holds appointment with prospect and has all paperwork completed and signed. At the conclusion of this appointment, an Allocation Appointment may be needed once all transfers have been completed.
Allocation Appointment – Advisor holds appointment to discuss the specific investment recommendations.
Initial Review/Update – If a client is Rated A+ or A, they will receive a notebook at their first update. This field will indicate to the team that a notebook should be ordered.
Periodic Review/Update – After the client’s Initial Review/Update, this field will remain at this level as long as the contact remains as a client.

Packet Status – This field is for tracking the stage of where the prospect is with requesting/sending/receiving their prospect packet. To assist with consistency, choose the packet status from the Lookup List.

LookUp List Entries:
Not Requested – Used when a client brought a guest to an event but the prospect did not request a Prospect Packet
Received – Not Qualified – Prospect returned the Confidential Profile, but they didn’t meet account minimums or didn’t have reasonable expectations for their investments or the relationship.

Received – Qualified – Review of the Confidential Profile indicates they meet our minimum requirements and a Data Gathering Appointment should be set.

Refused to Return – Prospect indicates they don’t wish to return the Confidential Profile, won’t return repeated calls or keeps delaying the return of the Confidential Profile.

Requested – Prospect call, attends event, post a request on the website for information about your practice.

Sent – Prospect Packet was sent no later than 48 hours after it was requested.

Survey Rating – This field will contain the actual survey rating from the client. The format is [score] – [year]. Use the Lookup List to choose a rating from 1 to 11 and it will automatically enter the current year.

Client Start Dt – This is the date the client actually became a client. This will be used for reporting the client’s anniversary with your organization.

Init Cont Type – This is the initial contact type and how the client became aware of your organization (e.g., newspaper, workshop, etc.). To assist with consistency, add to the Lookup List with the contact types in your office and then choose the one for the contact record from there.

Source – This field contains the details of the initial contact type (e.g., which paper, what event, etc.). If the Init Cont Type is Referral, then enter in that information on the Referrals tab.

Estate Planning, Fin’l Planning, Life Insurance, Long-Term Care, and Tax Plan/Return – These are Yes/No fields to indicate whether your organization is providing these respective services for the client. Additional information about these services will be entered on their corresponding tab.

Update Freq – Works closely with the Dt Last Updated field and dictates how often a client is to have an update meeting. It is very important that this field be populated for new clients as well to make sure they get an initial update. To assist with consistency, choose the update frequency from the Lookup List.

LookUp List Entries:

Annual // i.e., once per year
Monthly // i.e., once per month
Quarterly // i.e., once every 3 months
Semi-Annual // i.e., once every 6 months
Tri-Annual // i.e., once every 4 months
Dt Last Updated – Works closely with the Update Freq field to determine when the client should have their next update meeting. It is very important that this field be populated for new clients as well to make sure they get an initial update. The date will appear green if an update is due in the current month and red if an update is overdue.

Notebook Rec’d, Last NB Update – We give our A+ and A clients a notebook binder to keep broker/dealer (as well as outside-held) account statements. These fields track if it was received and the last date it was updated by us in the office.

Household Assets – This field contains the dollar amount of the total household assets you are managing for the client.

Newsletter – This field indicates whether the contact receives your organization’s newsletter.

**Paperwork Tab**

The fields on this tab are used to track information necessary for completing in-house paperwork. If the contact record contains a husband/wife entry then the Paperwork tab is divided so that each person has their own information.

**Personal Contact Record**

Prefix – This field holds the surname for the corresponding contact. To assist with consistency, choose the prefix from the Lookup List.
Soc Security # – This field holds the social security number for the corresponding contact. For consistency, we recommend including the dashes when entering the numbers.

Pri/Sec Birth Date – These fields populate from the “Pri Birth Date:” and “Sec Birth Date:” fields on the Fields tab respectively. Changing the field here will automatically change it on the Fields tab as well.

Age – This field will automatically calculate the age for the corresponding birth date. It will display “Deceased” if the corresponding contact has a date entered in the “Date of Death:” field on the Paperwork tab. This field may not be manually modified.

Date of Death – This field contains date of death information for the corresponding contact.

ID Type – This field indicates the type of identification each contact is using. To assist with consistency, choose the ID type from the Lookup List.

LookUp List Entries:
- Driver's License
- Military ID
- Passport

Place of Issue – This field indicates where the ID was issued for the corresponding contact.

ID Number – This is the identification number for the corresponding contact.

ID Issue Date – This field contains the date the ID was issued to the corresponding contact.

ID Exp Date – This field contains the expiration date for the identification for the corresponding contact.

Occupation – This field contains the type of employment for the corresponding contact.

Employer – This is the place of employment for the corresponding contact.

Add, City, State, Zip – This is the employer’s address for the corresponding contact.

Retired?, Retire Date – These fields indicate whether the contact is retired and when their retirement began or when retirement is anticipated to begin for the corresponding contact.
Inv Objective – This identifies the contact’s investment objective. To assist with consistency, choose the objective from the Lookup List.

- **LookUp List Entries:**
  - Aggressive Growth
  - Growth
  - Growth W/ Income
  - Income W/ Capital Preservation
  - Income W/ Moderate Growth

Net Worth – This field contains the net worth for the corresponding contact. To assist with consistency, choose the amount from the Lookup List.

Fed Tax Bracket – This field indicates what the Federal tax bracket is for the corresponding contact.

Annual Income – This field contains the total yearly income for the corresponding contact. To assist with consistency, choose the amount from the Lookup List.

Liquid Nt Worth – This field contains the liquid net worth for the corresponding contact. To assist with consistency, choose the amount from the Lookup List.

Income Source – This field indicates the source of income for the corresponding contact. To assist with consistency, add to the Lookup List with the income sources and then choose the one for the contact record from there.

Investment Experience - # of Years – This area lists the different type of investment types. Enter in the number of years experience the contact has in each of the categories.

Business Contact Record

- **Fields**
  - ID Type: Driver\'s License
  - Place of Issue: NE
  - ID Number: H1234567
  - ID Issue Date: 12/12/1999
  - ID Exp Date: May 20, 00
  - Expired ID

Inv Objective: Income w/ Capital Preservation
Prefix – This field holds the surname for the corresponding contact. To assist with consistency, choose the prefix from the Lookup List.

Co Tax ID # – This field holds the company tax identification number.

ID Type – This field indicates the type of identification the contact is using. To assist with consistency, choose the ID type from the Lookup List.

<table>
<thead>
<tr>
<th>LookUp List Entries:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Driver’s License</td>
</tr>
<tr>
<td>Military ID</td>
</tr>
<tr>
<td>Passport</td>
</tr>
</tbody>
</table>

Place of Issue – This field indicates where the ID was issued for the corresponding contact.

ID Number – This is the identification number for the corresponding contact.

ID Issue Date – This field contains the date the ID was issued to the corresponding contact.

ID Exp Date – This field contains the expiration date for the identification for the corresponding contact.

Inv Objective – This identifies the contact’s investment objective. To assist with consistency, choose the objective from the Lookup List.

<table>
<thead>
<tr>
<th>LookUp List Entries:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggressive Growth</td>
</tr>
<tr>
<td>Growth</td>
</tr>
<tr>
<td>Growth W/ Income</td>
</tr>
<tr>
<td>Income W/ Capital Preservation</td>
</tr>
<tr>
<td>Income W/ Moderate Growth</td>
</tr>
<tr>
<td>Trading</td>
</tr>
</tbody>
</table>

Favorites Tab
These fields are very important for Love-Affair Marketing™ and, specifically, to your Director of First Impressions. If the contact record is of a Personal type, there will be two columns to accommodate Pri Name and Sec Name information. If the contact record is of a Business type, there will be only one column to accommodate the main company contact’s information.

Most of the fields on this tab have Lookup lists. You can choose one from the list or manually enter one that does not appear on the list.
## Personal Record Type

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Method, Home Phone</td>
<td>WILLY SAMPLE</td>
<td>Contact Method, Cell Phone</td>
<td>PAMELA SAMPLE</td>
</tr>
<tr>
<td>Shirt Size, XL</td>
<td></td>
<td>Car</td>
<td>Dodge</td>
</tr>
<tr>
<td>Car</td>
<td>Chrysler</td>
<td>Wine, White Wine</td>
<td></td>
</tr>
<tr>
<td>Drink</td>
<td>Coke, Regular</td>
<td>Drink</td>
<td>Coke, Diet Coke</td>
</tr>
<tr>
<td>Coffee</td>
<td>Regular</td>
<td>Coffee</td>
<td>Diet</td>
</tr>
<tr>
<td>Chocolate</td>
<td>Dark</td>
<td>Chocolate</td>
<td>Milk</td>
</tr>
<tr>
<td>Flowers/Plant</td>
<td>Lilac</td>
<td>Newspaper</td>
<td>USA Today, Wall Street Journal</td>
</tr>
<tr>
<td>Movie Genre</td>
<td>Suspense, Thriller</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TV Show</td>
<td>NBC, News</td>
<td>TV Show</td>
<td>HBO, Anybody Anywhere</td>
</tr>
<tr>
<td>Snack</td>
<td>Popcorn</td>
<td>Snack</td>
<td>Potato Chips</td>
</tr>
<tr>
<td>Music</td>
<td>Heavy Metal</td>
<td>Music</td>
<td>Soft Pop</td>
</tr>
<tr>
<td>Gym Membership</td>
<td>Yes, Gold's Gym</td>
<td>Gym Membership</td>
<td>Yes</td>
</tr>
<tr>
<td>Hobbies</td>
<td>See Details Tab</td>
<td>Hobbies</td>
<td>See Details Tab</td>
</tr>
<tr>
<td>Home Affiliates</td>
<td>Zoe</td>
<td>Home Affiliates</td>
<td>LeFonda's</td>
</tr>
<tr>
<td>Restaurant</td>
<td>LeFonda's</td>
<td>Restaurant</td>
<td>LeFonda's</td>
</tr>
<tr>
<td>Author</td>
<td>Ron Cowen, Steve Sanders</td>
<td>Author</td>
<td>John Broen</td>
</tr>
<tr>
<td>Pet</td>
<td>None</td>
<td>Pet</td>
<td>Poodle, Ruddy the Poodle</td>
</tr>
<tr>
<td>Season Ticket</td>
<td>Yes - Husker Football</td>
<td>Season Ticket</td>
<td>Yes - Husker Football</td>
</tr>
</tbody>
</table>
C - Detail Type Definitions

15 Questions
In the Tested in the Trenches™ Systems Manual you will find a document that contains the 15 questions for potential clients that can be used with prospects. This information is then stored in GoldMine®, in the Details tab, and printed out on an “Appointment Sheet” report. Advisors have this report in-hand when meeting with prospects and clients.

Reference – Use the Lookup List to select each of the 15 questions for potential clients, separately asked at the Data Gathering Appointment.
Notes – Enter in the response to the question.

Account
To document the accounts that are not currently under the firm’s control, use the “Account” detail type. These appear on the “Appointment Sheet” reports. Breaking Away™ has given the “Account” detail type its own tab called, Accounts.

Reference – This will be the account number.
Acct Type – This will be the type of account.

LookUp List Entries:
401K
403b
529 Plan
Annuity
Brokerage
CD
Checking
Managed
Money Market
Oil & Gas
REITS
Savings
UGMA
UTMA

Registration – This is how the account is legally titled for tax purposes.

LookUp List Entries:
Community Property
Corporate
Custodian for Minor Estate
Guardianship
Individual
Investment Club
IRA
Joint – WROS
Non-Profit Org.
Partnership
Personal Trust
Qual Retirement Plan
SEP
SIMPLE
Tenants by Entirety
Tenants in Common
Transfer on Death
**Owner** – This is who owns the account.

LookUp List Entries:
- Company
- Primary Name
- Primary and Secondary Name
- Secondary Name

**Value** – This is the monetary value of the account. This may be updated as needed.

**As of Date** – This is the date the value was updated.

**Add’l Owners** – This is used if there is more than two account owners.

**Beneficiaries?** – This is used to indicate if beneficiary information is available.

LookUp List Entries:
- Not Yet Obtained
- Not Applicable
- Yes – See the Beneficiaries tab

**Asset/Liability**

The “Asset/Liability” detail type allows you to keep track of all the different assets and liabilities the client has outside your firm’s control.

**Reference** – This will be the type of asset or liability including an account number when appropriate.

LookUp List Entries:
- 2nd Home
- Automobile
- Credit Card
- Home
- Line of Credit
- Mortgage

**Owner** – This will be whose asset or liability it is.

LookUp List Entries:
- Company
- Primary Name
- Primary and Secondary Name
- Secondary Name

**Holder** – This is who money is owed to for a liability.

**Value/Amt Due** – This is the monetary amount or value of the asset or liability.

**Interest Rate** – This is the rate of interest on the liability.
Beneficiaries? – This is used to indicate if beneficiary information is available.

LookUp List Entries:
Not Yet Obtained
Not Applicable
Yes – See the Beneficiaries tab

Beneficiary
The “Beneficiary” detail type allows you to keep track of all beneficiaries for any given account or policy the client has. Make sure the “Acct Number:” field matches up with the correct field of the corresponding detail type – usually the “Reference:” field. Breaking Away™ has given the “Beneficiary” detail type its own tab called, Beneficiaries.

Reference – This is the beneficiary’s name.
Acct Number – This should contain the account number exactly as it is entered in the “Reference” field of the corresponding Account, Asset/Liability, Life Insurance, or Other Insurance detail record.
Relationship – This is the relationship that the beneficiary is to the client.

LookUp List Entries:
Aunt
Cousin
Daughter
Daughter-in-law
Granddaughter
Grandson
Nephew
Niece
Son
Son-in-law
Spouse
Uncle

Type – This identifies the type of beneficiary.

LookUp List Entries:
Contingent
Primary

Percentage – This is the percentage of the account that the beneficiary is entitled to.
State – The state that the beneficiary resides in.
Zip – The zip code for the beneficiary.
Street Address – The address for the beneficiary.
City – The city that the beneficiary resides in.

Dependent
The “Dependent” detail type allows you to track the dependents of a contact who would not have their own contact record. Generally, if they are under age they are considered a dependent.

Reference – This is the dependent’s name. After you enter in the name you can select a relationship from the Lookup List that will be appended to the Reference (e.g., “Billy Sample, Son”).

LookUp List Entries:
Daughter
Granddaughter
Grandson
Son
Step Daughter
Step Son

Parent/Guardian – This is the dependent’s parent or guardian’s name.

LookUp List Entries:
Primary Name
Primary and Secondary Name
Secondary Name

SSN – This is the dependent’s social security number.

Date of Birth – This is the dependent’s date of birth.

Extra Curricular – This is where you can document activities the dependent is active in.

LookUp List Entries:
Band
Baseball
Basketball
Choir
Dance
Drama
Football
Hockey
Martial Arts
Soccer
Softball
Wrestling

College Plans – This is where you can document the dependent’s college plans.

LookUp List Entries:
(No plan)
Associate
Bachelor’s
Doctorate
Law
Masters
Medical
Trade/Technical
**Estate Planning**

The “Estate Planning” detail type should be added for each estate planning document the firm is responsible for. Breaking Away™ has given the “Estate Planning” detail type its own tab called, Estate.

**Reference** – This is the name of the individual the document is prepared for.

LookUp List Entries:
- Primary Name
- Primary and Secondary Name
- Secondary Name

**Document Type** – This is the legal document that has been prepared.

LookUp List Entries:
- Durable POA
- Medical POA
- Trust
- Will

**Doc Location** – This is the physical location of the document.

LookUp List Entries:
- Attorney
- eMoney Vault
- Family Member
- Safe Deposit Box

**Attorney Name** – This is the name of the person who prepared the document.

**Last Revised** – This is the date the document was last revised.

**Event**

The “Event” detail type is designed to keep track of each individual who attended and/or RSVP’d for an event as well as their rating of the event. Clients will be attending several events, and several guests may be coming along with them. Each person gets a separate detail record added for each event they attend. Breaking Away™ has given the “Event” detail type its own tab called, Events.

**Event Date** – This is the actual date the event is held.

**Reference** – This is the name and the year of the event (e.g., Half Time Report 2006).

**NameTag Type** – This is the type of individual attending the event (e.g., Client, Guest, etc.).
LookUp List Entries:
Client – Pri
Client – Sec
Employee
Guest
Presenter
Prospect
Vendor

RSVP’d – This indicates if the client RSVP’d, attended, or if they were a no show.

LookUp List Entries:
No
No – Attended (i.e., Walk-in)
Yes
Yes – Cancelled
Yes – No Show

Rating (1-10) – This is how the contact rated the event on the evaluation.

Nametag – This is how the person attending wishes their nametag to appear.

Financial Planning
The “Financial Planning” detail type should be added for each financial planning service the client has authorized. Breaking Away™ has given the “Financial Planning” detail type its own tab called, Finl_Plan.

Reference – This is the stage of the financial planning process the contact is in.

LookUp List Entries:
Initial
Maintenance
Review
Rework

Agreement Dt – This is the date the financial services agreement was signed.

Delivery Date – This is the date the service was delivered to the client or pending delivery.

Fee-Amount – This is the amount the client is being charged for the financial service.

Fee-Amt Paid – This is the amount paid towards the financial service fee to date.

Fee-Date Paid – This is the date the last payment was received.

Planning Areas – These are the areas the advisor has agreed to deliver to the client in the financial service.

LookUp List Entries:
AM // Asset Management
Gift

The “Gift” detail type allows you to track gifts, other than random acts of kindness, you have given your clients (e.g., birthday or anniversary gifts).

Reference – This is the reason for the gift as well as who received it and what it is (e.g., Birthday – Pam – Gift Basket).

LookUp List Entries:
Birthday
Client Anniversary with Firm
Wedding Anniversary

Notes – This is where details of the gift and/or reason for the gift can be entered.

Recipient – This is the person that received the gift for the purpose of tracking and assigning gift expenditures.

LookUp List Entries:
Company // for Business contacts
Pri Name // for Personal contacts
Sec Name // for Personal contacts

Amt Spent – This is the amount of money that was spent on the gift.

Hobby

The “Hobby” detail type is meant to store the hobbies of your contacts.

Reference – This is the type of hobby and the person involved (e.g., Golf - Bill).

Notes – This is where specifics or interesting facts about the hobby can be entered.

Life Insurance

The “Life Insurance” detail type is used to track life insurance policies. Breaking Away™ has given the “Life Insurance” detail type its own tab called, Life_Ins.

Reference – This is the policy number.
Insured – This is the name of the person insured.

LookUp List Entries:
Primary Name
Secondary Name

**Owner** – This is the name of the person who owns the policy.

**LookUp List Entries:**
Irrevocable Life Ins. Trust
Other
Third Party Custodian
Primary Name
Secondary Name

**Ins Company** – This is the company that issued the policy.

**Death Benefit** – This is the amount of coverage in the policy.

**Policy Type** – This defines the type of policy.

**LookUp List Entries:**
Term
Universal Life
Variable Universal Life
Whole

**Issue Date** – This is the date the policy was issued.

**Cash Value** – This is the actual cash value of the policy.

**Beneficiaries?** – This is used to indicate if beneficiary information is available.

**LookUp List Entries:**
Not Yet Obtained
Not Applicable
Yes – See the Beneficiaries tab

**Login Information**
The “Login Information” detail type allows you to keep track of various login credentials for web-based account management programs for your clients.

**Reference** – This is the application the login is for.

**Username** – This is the username to enter in the login screen of the application.

**Password** – This is the password to enter in the login screen of the application.

**Long-Term Care**
The “Long-Term Care” detail type is used to track long-term care insurance policies. Breaking Away™ has given the “Long-Term Care” detail type its own tab called, LTC.

**Reference** – This is the policy number.

**Insured** – This is the individual who benefits from the insurance.
LookUp List Entries:
Primary Name
Primary and Secondary Name
Secondary Name

**Benefit Amount** – This is the dollar amount provided per day.

**Benefit Period** – This is the amount of time the benefit amount will be paid.

**Elimin Period** – This is the amount of time to wait before benefits are paid.

**Indemnity Rdr** – This is an optional rider that can be added to a Long-Term Care policy.

**Inflation Rider** – This is an optional rider that can be added to a Long-Term Care policy.

**Insurance Co** – This is the company that issued the policy.

**Other Insurance**
The “Other Insurance” detail type allows you to keep track of the other insurance policy types that a contact owns.

**Reference** – This is the account number of the policy.

**Owner** – This is the name of the person insured.

LookUp List Entries:
Company
Primary Name
Primary and Secondary Name
Secondary Name

**Insurance Type** – This is the type of insurance.

LookUp List Entries:
Disability
Health
Succession Planning

**Beneficiaries?** – This is used to indicate if beneficiary information is available.

LookUp List Entries:
Not Yet Obtained
Not Applicable
Yes – See the Beneficiaries tab

**Random Act of Kindness™**
The “Random Act of Kindness” detail type is for recording random acts of kindness as opposed to gifts that are given for special occasions or events.
Reference – This is what random act of kindness (i.e., RAK) was performed and to who (e.g., Sent Flowers - Pam).

Notes – This is where you can document why the act was performed.

Recipient – This is the person that received the RAK for the purpose of tracking and assigning gift expenditures.

LookUp List Entries:
Company // for Business contacts
Pri Name // for Personal contacts
Sec Name // for Personal contacts

Amt Spent – This is the amount of money that was spent on the RAK.

Tax
The “Tax” detail type allows you to track information related to your client’s tax planning or tax returns. Breaking Away™ has given the “Tax” detail type its own tab called, Tax.

Reference – This is the tax issue that is being addressed.

LookUp List Entries:
Planning
Return

Taxpayer – This is the name of the person liable for the tax.

LookUp List Entries:
Company
Primary Name
Primary and Secondary Name
Secondary Name

Start Date – This is the beginning date.
Completed Date – This is the date of resolution.

Fee Amount – This is the dollar amount collected for the tax advice.
Last Contact – This is for any contact that may happen after the completed date.
D - Filter & SQL Query Definitions

View Breaking Away™ filters and SQL queries, from the Main Menu and choose Filters and Groups. Filters are located on the Filters tab and SQL queries are located on the SQL Query tab. The available filters and queries will be listed here.

“A” Clients – This filter will include contact records that have a “Client Status:” equal to Client and a Rating equal to 2 (A).

“A+” & “A” Clients – This filter will include contact records that have a “Client Status:” equal to Client and a Rating equal to either 1 (A+) or 2 (A).

“A+” and Non-local “A” Clients – This filter will include contact records that have a “Client Status:” equal to Client and a “Rating:” equal to 1 (A+) or a “Rating:” equal to 2 (A) and a “City:” that does not equal your local city.

In order to use this filter you will need to enter your local city into the filter. You do this by going to the Tools menu and choosing Filters and Groups. Make sure you are on the Filters tab. Select the filter titled “A+” and Non-local “A” Clients and click on the Properties button. The Filter dialog window will display. Make sure that “dBASE Expr” is selected at the bottom. Click on the Edit Expression button. You will now be able to type in the name of your city, all in capital letters, into the filter where it says “TYPE CITY NAME HERE IN ALL CAPS”, keeping the quotes (e.g., “OMAHA”). Click OK. Next, select “SQL Query” at the bottom. Click on the Edit Expression button. You will now be able to type in the name of your city, all in capital letters, into the query where it says ‘TYPE CITY NAME HERE IN ALL CAPS’, keeping the single quotes (e.g., ‘OMAHA’). Click OK twice to save and close.

“A+” Clients – This filter will include contact records that have a “Client Status:” equal to Client and a Rating equal to 1 (A+).

“B” Clients – This filter will include contact records that have a “Client Status:” equal to Client and a Rating equal to 3 (B).

“C” Clients – This filter will include contact records that have a “Client Status:” equal to Client and a Rating equal to 4 (C).

“D” Clients – This filter will include contact records that have a “Client Status:” equal to Client and a Rating equal to 5 (D).
(Pri) Clients Aged >= 59.5 by End of Yr – This filter will include Primary contact records that have a “Client Status:” equal to Client and their age will be 59 and a half years or older by the end of the year.

(Pri) Clients Aged >= 70.5 by End of Yr – This filter will include Primary contact records that have a “Client Status:” equal to Client and their age will be 70 and a half years or older by the end of the year.

(Sec) Clients Aged >= 59.5 by End of Yr – This filter will include Secondary contact records that have a “Client Status:” equal to Client and their age will be 59 and a half years or older by the end of the year.

(Sec) Clients Aged >= 70.5 by End of Yr – This filter will include Secondary contact records that have a “Client Status:” equal to Client and their age will be 70 and a half years or older by the end of the year.

All Clients – This filter will include contact records that have a “Client Status:” equal to Client.

All Drips – This filter will include contact records that have a “Client Status:” equal to Drip.

All Prospects – This filter will include contact records that have a “Client Status:” equal to Prospect.

Clients Not Contacted in Last 90 Days – This filter will include contact records that have a “Client Status:” equal to Client and the date in the “Last Contact:” field on the Summary tab is older than 90 days. Note that a contact that does not have a value in the “Last Contact” field will not display in this filter.

Clients with Expired ID’s – This filter will include contact records that have a “Client Status:” equal to Client and the “ID Exp Date:” on the Paperwork tab for the Primary or Secondary contact are less than today’s date and do not equal 0.

Clients without E-mail Addresses – This filter will include contact records that have a “Client Status:” equal to Client and do not have an e-mail address associated with them.

Estate Planning Clients – This filter will include contact records that have a “Client Status:” equal to Client and the “Estate Planning:” field on the Fields tab is equal to “Yes”.

Financial Planning Clients – This filter will include contact records that have a “Client Status:” equal to Client and the “Fin’l Planning:” field on the Fields tab is equal to “Yes”.

© TICOMIX™ 2009, All Rights Reserved
Life Insurance Clients – This filter will include contact records that have a “Client Status:” equal to Client and the “Life Insurance:” field on the Fields tab is equal to “Yes”.

Long-Term Care Clients – This filter will include contact records that have a “Client Status:” equal to Client and the ”Long-Term Care:” field on the Fields tab is equal to “Yes”.

Merge Code – This filter will include contact records that contain a specified Merge Code (i.e., “Merge:”) on the Main View of GoldMine.

In order to use this filter you will need to enter the Merge Code into the filter. You do this by going to the Tools menu and choosing Filters and Groups. Make sure you are on the Filters tab. Select the filter titled “Merge Code” and click on the Properties button. The Filter dialog window will display. Make sure “dBASE Expr” is selected at the bottom. Click on the Edit Expression button. You will now be able to type in the Merge Code into the filter where it says "Enter Value Here", keeping the quotes (e.g., “BBQ”). Click OK. Next, select “SQL Query” at the bottom. Click on the Edit Expression button. You will now be able to type in the Merge Code into the filter where it says "%ENTER VALUE HERE%", keeping the single quotes and percent signs (%) (e.g., "%BBQ"). Click OK twice to save and close.

Newsletter Recipients – This filter will include contact records that the “Newsletter:” field on the Fields tab is not equal to “No”.

Prospects - Packet Sent but not Returned – This filter will include prospects (i.e., “Client Status:” = “Prospect”) who have been sent a prospect packet, but have either not returned it yet (i.e., “Packet Status:” = “Sent”), or they have refused to return it (i.e., “Packet Status:” = “Refused To Return”). This will help in identifying contact records for cold prospects in order to determine whether their “Client Status:” should be changed to “Drip” or “Former Prospect”.

Retired Clients – This filter will include contact records that have “Client Status:” equal to Client and either the “Retire Date:” is less than today’s date or “Retired?” is equal to Yes for either the primary or secondary contact.

Tax Planning/Return Clients – This filter will include contact records that have a “Client Status:” equal to Client and the “Tax Planning/Return:” field on the Fields tab is equal to “Yes”.

Tracks Attached to Contacts (SQL) – This SQL query will provide a list of names of all the automated processes that are currently attached to contact records.
Weekly Market Commentary Recipients – This filter will include contact records that the “Unsubscribes:” field in the Main View does not contain “WMC”.
E-1 - GoldMine Report Definitions

Labels and Envelopes
The Breaking Away™ specific label and envelope reports are identified by a “BA” at the end of the report name (e.g., Avery 4143 Mail To – BA). These Breaking Away reports allow for three different ways to address the label or envelope.

Mail To
The label or envelope will use the “Mail To:” field to address the contact name. (e.g., Avery 4143 Mail To – BA)

Pri Name/Contact
The label or envelope will use the “Pri Name:” field for Personal contact types and the “Contact:” field for Business contact types to address the contact name. For Business contact types, “c/o” followed by the Company name will automatically be placed beneath the contact’s name. (e.g., Avery 4143 Pri Name/Contact – BA)

Sec Name
The label or envelope will use the “Sec Name:” field to address the contact name. This is for Personal contact records only. (e.g., Avery 4143 Sec Name – BA)
E-2 - Crystal Reports Definitions

Contact Reports

Accounts Report

Purpose: Use this report for a list of accounts held by outside companies. This can include accounts under the Advisor's custody (e.g., REITS) or under another Advisor's custody (e.g., an account at Merrill Lynch). This report is helpful during preparations for a contact's update.

Frequency: As needed

Description: A contact will be displayed if they have a detail type (on the Details tab) of "Account". All the account information will display such as Account Number, Type, and Beneficiary information.

Parameters to Choose: SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status), and Account Type (as listed in the detail record and you may choose an individual account or all accounts).

Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

Asset/Liability Report

Purpose: Use this report to track a contact's Assets (e.g., checking or savings accounts) and liabilities (e.g., mortgage, credit cards, etc.). This report is helpful for financial planning.

Frequency: As needed

Description: A contact will be displayed if they have a detail type (on the Details tab) of "Asset/Liability". All asset/liability information will display such as Type, Holder, and Beneficiary information.

Parameters to Choose: SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status).

Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

Birthday Gift Order Report

Purpose: Use this report to give you a list of contacts, with a list of their favorites (from the Favorites tab) and their Hobbies (from the Detail tab). You can use this report for planning birthday gifts for contacts. The information contained in this report works well for sending to a vendor to send gifts. For a list of just contacts with birthdays, refer to the Birthday Report (Pri Name) and the Birthday Report (Sec Name).
Section I

E-2 – Crystal Reports Definitions

Frequency: Monthly

Description: A contact will appear on this list if they have a birthday in the month chosen in the parameters (this is determined from the “Pri Birth Date:” and “Sec Birth Date:” fields), they do not have a date entered in their corresponding “Date of Death:” field, and if they are a personal contact (i.e. “Contact Type” = Personal).

Parameters to Choose: Month (choose the month that the birthday occurs), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status), and Gender.

Report Sort: Rep ID #, then by Last Name, and then by Pri Name. Due to the presence of two birthday fields per contact record, this report is unable to sort the birthdays in chronological order.

Birthday Report (Pri Name)

Purpose: Use this report to give you a list of contacts’ Pri Name, with address and phone information. You can use this report to view who has a birthday in a specific month. Advisors often want a printed list as this report provides.

Frequency: Monthly

Description: A contact will appear on this list if they have a birthday in the month chosen in the parameters (this is determined from the “Pri Birth Date:” field), they do not have a date entered in their corresponding “Date of Death:” field, and if they are a Personal contact (i.e., “Contact Type:” = Personal).

Parameters to Choose: Month (choose the month that the birthday occurs), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status), and Gender.

Report Sort: The report is sorted by Rep ID #, then by birth date (without regard to year), then by Last Name, and then by Pri Name.

Birthday Report (Sec Name)

Purpose: Use this report to give you a list of contacts’ Sec Name, with address and phone information. You can use this report to view who has a birthday for a specific month. Advisors often want a printed list as this report provides.

Frequency: Monthly

Description: A contact will appear on this list if they have a birthday in the month chosen in the parameters (this is determined from the “Sec Birth Date:” field), they do not have a date entered in their corresponding “Date of Death:” field, and if they are a Personal contact (i.e., “Contact Type:” = Personal).

Parameters to Choose: Month (choose the month that the birthday occurs), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status), and Gender.

Report Sort: The report is sorted by Rep ID #, then by birth date (without regard to year), then by Last Name, and then by Sec Name.
Client Anniversary with Firm Report
Purpose: Use this report to give you a list of contacts, with address and phone information. You can use this report to view who has an anniversary with your firm for a specific month. Advisors often want a printed list as this report provides. This report can also be used to send to vendors to send gifts.
Frequency: Monthly
Description: A contact will appear on this list if they have an anniversary in the month chosen in the parameters (this is determined from the “Client Start Dt:” field), and if their status in a client (i.e., “Client Status:” = Client).
Parameters to Choose: Month (choose the month that the anniversary occurs), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), and Rating (you may choose more than one rating).
Report Sort: The report is sorted by Rep ID #, then by Client Start Dt (without regard to the year), then by Last Name, and then by Pri Name/Contact.

Contact List
Purpose: Use this report for a list of contacts which includes their address, phone numbers, and primary e-mail address. Advisors may use this to create groups or to segment clients.
Frequency: As needed
Description: A contact will appear on this list if they meet the criteria of each parameter value entered.
Parameters to Choose: Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Client Status (you may choose an individual status or all status), and Rating (you may choose more than one rating).
Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

Dependents Report
Purpose: Use this report for a list of contacts and their dependent information.
Frequency: As needed
Description: A contact will be displayed if they have a detail type (on the Details tab) of “Dependent”. All the dependent information will display such as Name and Date of Birth.
Parameters to Choose: SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status).
Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

E-mail Address List
Purpose: Use this report to give you a list of contacts and their e-mail addresses.
Frequency: As needed
Description: A contact will be displayed if they have an e-mail address and they have an e-mail merge code that you have chosen in the parameters. The merge code is located in the E-mail Address Properties.

Parameters to Choose: Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Client Status (you may choose an individual status or all status), and Merge Code (you may enter an individual merge code or choose all or no merge codes)

Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

**Estate Planning Report**

Purpose: Use this report to give you a list of contacts and their Estate Planning information. This report is useful for financial planning.

Frequency: As needed

Description: A contact will be displayed if they have a detail type (on the Details tab) of “Estate Planning”. All the estate planning information will display such as who it is prepared for and the document type.

Parameters to Choose: SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status), and Document Type (as listed in the detail record and you may choose an individual document or all documents).

Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

**Financial Planning Report**

Purpose: Use this report to give you a list of contacts and their Financial Planning information. This report can be used to track clients who have not paid a fee for years and those due for review.

Frequency: As needed

Description: A contact will be displayed if they have a detail type (on the Details tab) of “Financial Planning”. All the financial planning information will display such as the planning type and the agreement date.

Parameters to Choose: SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status), Fin’l Planning Type (as listed in the detail record and you may choose an individual planning type or all types), and Delivery Date (you may choose all dates or those that are pending).

Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.
History Report
Purpose: Use this report to give you a list of contacts with all the history records (including notes) associated with them.
Frequency: As needed
Description: A contact will be displayed if they have history records (on the History tab) that fall in a specific date range and activity type(s) as chosen in the parameters.
Parameters to Choose: SSN / Co Tax ID # (exactly as entered into the Main View of the contact or all ID #s), Activity type (you may choose more than one activity type), and Date Range (for the time period you wish to check for history).
Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, then by First Name, and then by date with the more recent history records listed first.

NOTE: E-mail records will NOT have the body of the e-mail displayed.

Hobbies Report
Purpose: Use this report to give you a list of contacts and their Hobby information.
Frequency: As needed
Description: A contact will be displayed if they have a detail type (on the Details tab) of “Hobby”. All the hobby information will display such as the hobby and notes.
Parameters to Choose: Keyword (to search within the reference field or leave blank to show all hobbies), SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status), City (you may choose a city or all cities), and State (you may choose a state or all states).
Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

Life Insurance Report
Purpose: Use this report to give you a list of contacts and their Life Insurance information.
Frequency: As needed
Description: A contact will be displayed if they have a detail type (on the Details tab) of “Life Insurance”. All life insurance information will display such as account number, who is insured, and Beneficiary information.
Parameters to Choose: SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status), and Policy Type (as listed in the detail record and you may choose an individual policy type or all types),
Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

**Long-Term Care Insurance Report**

**Purpose:** Use this report to give you a list of contacts and their Long-Term Care information.

**Frequency:** As needed

**Description:** A contact will be displayed if they have a detail type (on the Details tab) of “Long-Term Care”. All long-term care information will display such as account number and who is insured.

**Parameters to Choose:** SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), and Client Status (you may choose an individual status or all status).

**Report Sort:** This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

**Market Commentary Recipients**

**Purpose:** Use this report to give you a list of contacts and all primary e-mail addresses and additional/other e-mail addresses associated with them that are set up to receive the Market Commentary. You should keep this list of who was sent the Market Commentary each week which compliance requires.

**Frequency:** Weekly after sending the Market Commentary

**Description:** A contact will display if they have “WMC” in the “E-mail Merge:” field of at least one e-mail address, they do not have "WMC" in their respective “Unsubscribes” field, and they have at least one e-mail address.

**Parameters to Choose:** Rep ID # (exactly as entered into the Main View of the contact or all ID #s).

**Report Sort:** This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

**Other Insurance Report**

**Purpose:** Use this report to give you a list of contacts and their Other Insurance information. The list includes health insurance and disability insurance.

**Frequency:** As needed

**Description:** A contact will be displayed if they have a detail type (on the Details tab) of “Other Insurance”. All other insurance information will display such as account number, insurance type, and Beneficiary information.

**Parameters to Choose:** SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status), and Insurance Type (as listed in the detail record and you may choose an individual insurance type or all types).

**Report Sort:** This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.
Tax Planning/Return Report

Purpose: Use this report to give you a list of contacts and their Tax Planning/Return information. This report is useful for financial planning.

Frequency: As needed

Description: A contact will be displayed if they have a detail type (on the Details tab) of “Tax”. All tax planning/return information will display such as tax type and tax payer.

Parameters to Choose: SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating), Client Status (you may choose an individual status or all status), and Tax Type (as listed in the detail record and you may choose an individual tax type or all types).

Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

Wedding Anniversary Report

Purpose: Use this report to give you a list of contacts, with address and phone information. You can use this report to view who has a wedding anniversary for a specific month. Advisors often want a printed list as this report provides. This report will also be used to send to vendors to send gifts.

Frequency: Monthly

Description: A contact will appear on this list if they have a wedding anniversary in the month chosen in the parameters (this is determined from the “Anniv Date:” field), if they are a Personal contact (i.e., “Contact Type:” = Personal), and if they are married (i.e., “Marital Status:” = Married).

Parameters to Choose: Month (choose the month that the anniversary occurs), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), Rating (you may choose more than one rating) and Client Status (you may choose an individual status or all status).

Report Sort: The report is sorted by Rep ID #, then by Anniv Date (without regard to the year), then by Last Name, and then by Pri Name.

Calendar Printouts

Completed Activities Report

Purpose: Use this report to create a list of completed activities with the reference and notes information for a chosen user. Advisors find this useful to track the team’s contact with clients.

Frequency: Daily or as needed

Description: Completed activities will be listed for the user, date range and activity type that are chosen in the parameters.

Parameters to Choose: Date Range (that the activity was completed), Username (exactly as displayed in GoldMine or all users), Activity Type (you may choose more than one activity type or all types).
Report Sort: This report is sorted by Username and then chronologically by date and time. Activities that do not have a time associated with them will appear at the top of the list.

**Daily Calendar Report**

Purpose: Use this report to create a list of all the pending activities on a user’s calendar for a specific date. Advisors working outside the office find having a printed copy of their calendar helpful.

Frequency: Daily or as needed

Description: This report displays a list of all the pending activities with the reference, notes and the contacts they are linked to for an activity type, date, and user chosen in the parameters.

Parameters to Choose: Date (that the activities are scheduled), Username (exactly as displayed in GoldMine or all users), and Activity Type (you may choose more than one activity type or all types)

Report Sort: This report is sorted by Username and then chronologically by the pending activity time. Activities that do not have a time associated with them will appear at the top of the list.

**Pending Activities Report**

Purpose: Use this report to create a list of pending activities with the reference and notes information for a chosen user.

Frequency: Daily or as needed

Description: Pending activities will be listed for the user, date range and activity type that are chosen in the parameters. This report displays a list of all the pending activities of a chosen type and for a chosen date range and user.

Parameters to Choose: Date Range (that the activity was scheduled), Username (exactly as displayed in GoldMine or all users), Activity Type (you may choose more than one activity type or all types).

Report Sort: This report is sorted chronologically by date and time and then by Username. Activities that do not have a time associated with them will appear at the top of the list.

**Analysis Reports**

**Client Gift & RAK Tracking Report**

Purpose: Use this report to track the number of clients who have received a random act of kindness or gift during a specific time period. You can also track the amount spent on each client in that time period.

Frequency: Quarterly

Description: This report will give you a list of contacts and their Random Act of Kindness and Gift information. It will display all contacts with detail records (on the Details tab) of “Random Act of Kindness” or “Gift” that were entered/updated within the chosen date range for clients (i.e., “Client Status:” = Client).
Parameters to Choose: Rep ID # (exactly as entered into the Main View of the contact or all ID #s), and Rating (you may choose more than one rating), and a Date Range (for the time period you wish to check for random acts).

Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, then by First Name, and then by the date the detail record was last updated.

**Client ID’s Due to Expire**

**Purpose:** Use this report to create a list of contacts for whom updated ID numbers and expiration dates are required.

**Frequency:** Monthly

**Description:** This report displays a listing of all clients (i.e., “Client Status:” = Client) that have an ID due to expire within the next 30 days, no ID expiration date, or an ID that is already expired.

**Parameters to Choose:** Rep ID # (exactly as entered into the Main View of the contact or all ID #s), and Rating (you may choose more than one rating).

**Report Sort:** This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

**Client’s Missing Important Info**

**Purpose:** Use this report to obtain information from contacts with missing important Breaking Away™ field data.

**Frequency:** Quarterly

**Description:** This report displays a listing of all clients (i.e., “Client Status:” = "Client") whose contact records are missing important information pertaining to Breaking Away™. The specific fields that are missing data will be listed accordingly.

**Report Sort:** This report is sorted by Company name (for Business contacts only), then by Last Name, and then by First Name.

**Client’s Not Contacted in Time Period**

**Purpose:** Use this report to track those contacts who have not received monthly or quarterly calls.

**Frequency:** Monthly

**Description:** This report displays a list of all clients (i.e., “Client Status:” = "Client") that have not been contacted within a chosen date range. For the purpose of this report, "contacted" refers to the existence of at least one history record that:

1. has an Activity Type of either "Call Back" or "Call Out",
2. has an Activity Code entered (i.e., not blank),
3. has a Result Code of "COM", and
4. was completed successfully (i.e., Success = "Successful").

**Parameters to Choose:** Rep ID # (exactly as entered into the Main View of the contact or all ID #s), and Rating (you may choose more than one rating), and a Date Range (for the time period you wish to check for contact)
Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

NOTE: Clients with absolutely no history records whatsoever will NOT appear on this report. This is due to a limitation of the reporting engine.

Clients of a Certain Age by Year’s End
Purpose: Use this report to obtain a list of contacts attaining a certain age (i.e., clients reaching retirement age).
Frequency: As needed
Description: This report will list contact and birthday information for contacts who will attain a certain age by the end of the current year. It will display a listing of all Personal (i.e., “Contact Type:” = Personal) clients (i.e., “Client Status:” = Client).
Parameters to Choose: Attained Age (for the client by year’s end), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), and Rating (you may choose more than one rating)
Report Sort: This report is sorted by Rep ID #, then by Last Name, then by (Pri) First Name, and then by (Sec) First Name.

Clients with Referrals Report
Purpose: Use this report to exclude clients who have provided a referral from receiving the “Seeking Referral Letter”.
Frequency: Quarterly
Description: This report displays a listing of all “Referrals” for a contact, from the Referrals Tab, that were entered/updated within the chosen date range for clients (i.e., “Client Status:” = Client).
Parameters to Choose: Rep ID # (exactly as entered into the Main View of the contact or all ID #s), and Rating (you may choose more than one rating), and a Date Range (for the time period you wish to check for referrals)
Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

Clients with RMD Required by Year’s End
Purpose: Use this report to assure all contacts who have attained the age of 70 take their RMD in the timeframe required by the IRS.
Frequency: Quarterly
Description: This report displays a list of all Personal (i.e., “Contact Type:” = Personal) clients (i.e., “Client Status:” = Client) who will be required to take a RMD by the end of the year if they have qualifying funds. The report will further indicate which clients may opt to wait to take their first RMD by April 1st of the following year.
Parameters to Choose: Rep ID # (exactly as entered into the Main View of the contact or all ID #s)
Report Sort: This report is sorted by Rep ID #, then by Last Name, then by (Pri) First Name, and then by (Sec) First Name.
NOTE: Clients without a birth date entered on their contact record will NOT be evaluated by this report.

**Clients without Random Acts of Kindness™**

**Purpose:** Use this report to determine the clients who should receive a random act of kindness for the quarter.

**Frequency:** Quarterly

**Description:** This report displays a listing of all clients (i.e., “Client Status:“ = Client) that do not have any "Random Act of Kindness" detail records (on the Details tab) entered/updated within the chosen date range.

**Parameters to Choose:** Rep ID # (exactly as entered into the Main View of the contact or all ID #s), and Rating (you may choose more than one rating), and a Date Range (for the time period you wish to check for random acts)

**Report Sort:** This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

NOTE: Clients with absolutely no details records whatsoever (including e-mail addresses) will NOT appear on this report. This is due to a limitation of the reporting engine.

**Clients without Referrals Report**

**Purpose:** Use this report to create a group of those clients who should receive the “Seeking Referral Letter”.

**Frequency:** Quarterly or as needed

**Description:** This report displays a listing of all clients (i.e., “Client Status:“ = Client) that do not have any "Referrals" on the Referrals tab entered/updated within the chosen date range.

**Parameters to Choose:** Rep ID # (exactly as entered into the Main View of the contact or all ID #s), and Rating (you may choose more than one rating), and a Date Range (for the time period you wish to check for referrals)

**Report Sort:** This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

NOTE: Clients with absolutely no details records whatsoever (including e-mail addresses) will NOT appear on this report. This is due to a limitation of the reporting engine.

**Completed Transactions Summary Report**

**Purpose:** Use this report to provide the Advisor with a list of all completed forecasted sales for the month.

**Frequency:** Monthly

**Description:** This report displays a listing of all contacts with completed forecasted sales within the chosen date range.

**Parameters to Choose:** Rep ID # (exactly as entered into the Main View of the contact or all ID #s), a Date Range (for the time period you wish to check for transactions), Minimum Amount (only enter numbers and no special characters),
Activity Code (you may choose an individual code or multiple codes), Result Code (you may choose an individual code or all codes), and Display Notes (to choose whether or not to display the Notes for each forecasted sale.)

Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

**Forecasted Transactions Report**

*Purpose*: Use this report to monitor outstanding forecasted sales at least every two weeks on items such as transfers.

*Frequency*: Weekly

*Description*: This report displays a listing of all contacts with pending forecasted sales within the chosen date range.

*Parameters to Choose*: Rep ID # (exactly as entered into the Main View of the contact or all ID #s), a Date Range (for the time period you wish to check for transactions), Minimum Amount (only enter numbers and no special characters), Activity Code (you may choose an individual code or all codes), and Display Notes (to choose whether or not to display the Notes for each forecasted sale.)

*Report Sort*: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

**Prospect to Client Conversion Report**

*Purpose*: Use this report no less than quarterly to determine where prospects are lost (or don't become clients).

*Frequency*: As needed

*Description*: This report displays all Clients, Prospects, Drips, Former Clients, and Former Prospects whose contact records were created within the chosen date range.

*Parameters to Choose*: Rep ID # (exactly as entered into the Main View of the contact or all ID #s), a Date Range (for the time period you wish to check for conversions).

*Report Sort*: This report is sorted by Rep ID #, then by Stage, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

**Labels and Envelopes**

**Avery 5160 Event Sign In Labels**

*Purpose*: Use this report to print sign-in labels for a specific event. The labels are then attached to the sign-in/evaluation form.

*Frequency*: As needed

*Description*: This report is formatted for Avery 5160 labels (1" x 2-5/8") and is intended to print labels to be affixed to event sign in/evaluation forms. The report pulls the names from the "Event" detail records (on the Details tab) whose Reference field equals the Event Name entered as a parameter value. You can also choose the Nametag Type (discriminates what labels to print based on the Nametag Type value from the "Event" detail record).
Parameters to Choose: Event Name (exactly as is appears in the Reference field of the Detail record), Nametag Type (you may choose an individual type or all types).

Report Sort: The labels are sorted by name.

**Avery 5395 Nametags**

**Purpose:** Use this report to print Nametags for every event.

**Frequency:** As needed

**Description:** This report is formatted for Avery 5395 labels (3-3/8" x 2-5/16") and is intended to print nametags for events. The report pulls the names from the "Event" detail records (on the Details tab) whose Reference field equals the Event Name entered as a parameter value. You can also choose the Nametag Type (discriminates what type of nametags to print based on the value from the "Event" detail record) and Event Date (used to determine where a contact's birthday falls with respect to the date of the event). Nametags will appear in all caps if the nametag type is "Client - Pri" or "Client - Sec". Nametags will appear in proper case if the nametag type is "Prospect" or "Guest". Nametags will appear in italics if the nametag type is "Vendor", "Presenter", or "Employee". Further, if a contact's birthday falls within 30 days prior or 30 days after the event date chosen, it will be indicated on the nametag with a small gray square at the bottom of the nametag. If the square appears on the left, that indicates that the person's birthday fell within the 30 days prior to the event date. If the square appears on the right, that indicates that the person's birthday falls within the 30 days after the event date. Finally, if the person's birthday falls on the event date, the square will appear in the middle.

Parameters to Choose: Event Name (exactly as is appears in the Reference field of the Detail record), Event Date, Nametag Type (you may choose an individual type or all types).

Report Sort: The nametags are sorted by name.

**Other Reports**

**Appointment Sheet by Date (Long)**

**Purpose:** Use this report to provide the advisor with extensive information about a contact that is coming in for an appointment on a specific day.

**Frequency:** Daily or as needed

**Description:** This report will display contact information that will assist you in preparing for an upcoming appointment. This report displays an appointment sheet containing a plethora of information for contacts that have an appointment scheduled on the date chosen. If the appointment is scheduled with an activity code of "DGA" (Prospect Data Gathering Appointment), the appointment sheet will be appended by the "Fifteen Questions for Potential Clients."

Parameters to Choose: Appointment Date and Rep ID # (exactly as entered into the Main View of the contact or all ID #s).
NOTE: If a contact has more than one pending appointment, the appointment sheet will be based on the date/time of the first scheduled appointment. The determination of whether or not the "Fifteen Questions for Potential Clients" will be displayed, however, will be based on whether or not the LAST scheduled appointment is coded as "DGA". This is a limitation of the reporting engine.

Appointment Sheet by Date (Short)

Purpose: Use this report to provide the Advisor with concise information regarding a client that is coming in for an appointment on a specific day.
Frequency: Daily or as needed
Description: This report displays an appointment sheet containing a 1-2 page summary of information for contacts that have an appointment scheduled on the date chosen. The "Fifteen Questions for Potential Clients" are NOT displayed with this report.
Parameters to Choose: Appointment Date and Rep ID # (exactly as entered into the Main View of the contact or all ID #s).

NOTE: If a contact has more than one pending appointment, the appointment sheet will be based on the date/time of the first scheduled appointment.

Appointment Sheet by SSN (Long)

Purpose: Use this report to provide the Advisor with extensive information about a specific contact coming in for an appointment.
Frequency: Daily or as needed
Description: This report will display contact information that will assist you in preparing for an upcoming appointment. This report displays an appointment sheet containing a plethora of information for the contact with the chosen SSN/Co Tax ID # if they have an appointment scheduled (on any date). If the appointment is scheduled with an activity code of "DGA" (Prospect Data Gathering Appointment), the appointment sheet will be appended by the "Fifteen Questions for Potential Clients."
Parameters to Choose: SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s),

NOTE: If a contact has more than one pending appointment, the appointment sheet will be based on the date/time of the first scheduled appointment. The determination of whether or not the "Fifteen Questions for Potential Clients" will be displayed, however, will be based on whether or not the LAST scheduled appointment is coded as "DGA". This is a limitation of the reporting engine.

Appointment Sheet by SSN (Short)

Purpose: Use this report to provide the Advisor with concise information regarding a specific contact that is coming in for an appointment.
Frequency: Daily or as needed
Description: This report displays an appointment sheet containing a summary of information for the contact with the chosen SSN/Co Tax ID # if they have an appointment scheduled (on any date). The "Fifteen Questions for Potential Clients" will NOT be displayed with this report.
Parameters to Choose: SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s).

Events Report
Purpose: Use this report to provide Advisors and compliance with attendees and no shows for events.
Frequency: As needed
Description: This report lists event information with a summary total of participants. It will pull this information from the “Event” detail records (on the Details tab).
Parameters to Choose: Event Name (exactly as is appears in the Reference field of the Detail record), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), and Nametag Type (you may choose an individual type or all types).
Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, then by First Name, and then by the Nametag.

Update Preparation Report by Date
Purpose: Use this report to prepare for updates scheduled on a particular day.
Frequency: As needed
Description: This report displays a summary of information pertinent to preparing a client update for clients (i.e., Client Status = "Client") that have an appointment scheduled on the date chosen. It will list history and pending activities as well as important detail records.
Parameters to Choose: Appointment Date and Rep ID # (exactly as entered into the Main View of the contact or all ID #s).

Update Preparation Report by SSN
Purpose: Use this report to prepare for updates scheduled for a specific client.
Frequency: As needed
Description: This report displays a summary of information pertinent to preparing a client update for clients (i.e., “Client Status:” = Client) that have an appointment scheduled. It will list history and pending activities as well as important detail records.
Parameters to Choose: SSN/Co Tax ID# (exactly as entered into the Main View of the contact or all ID #s), Rep ID # (exactly as entered into the Main View of the contact or all ID #s).

Update Scheduling Report
Purpose: Use this report to contact clients to schedule their update appointment.
Frequency: Monthly or as needed
Description: This report displays a list of all clients (i.e., “Client Status:” = Client) that have an update due in the chosen month (based on the “Update Freq:” and “Dt Last Updated:” fields). The report can be used to compile a list of future updates for planning.
Parameters to Choose: Month (choose the month that the update occurs), Rep ID # (exactly as entered into the Main View of the contact or all ID #s), and Rating (you may choose more than one rating).
Report Sort: This report is sorted by Rep ID #, then by Company name (for Business contacts only), then by Last Name, and then by First Name.

NOTE: This report will also display clients that are currently overdue for an update regardless of which month option is selected and clients who do not have a valid update frequency.
F - Automated Process Definitions

**Annual Surveys – Monthly Groups**

**Purpose:** Use this process to automatically schedule an Other Action for an assigned user to send the annual survey to a client. The scheduled actions are broken into monthly groups based on the last names of the clients.

**Event:** P 5 January A-B

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client) and have a specified rating (the default “Rating:” is A or A+ clients). The last name (i.e., “Last:”) will begin with the specified letter and the process will trigger on the 15th of every month.

**Action:** An Other Action to send the survey will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered. It will have an Activity Code of “SRV” and be color coded yellow (if a time is specified). The reference will say “Send Annual Survey”.

**Modifications:** You may modify what rating levels the clients must have to receive the annual survey. To do this, expand the automated process so that the events display. Double-click on the first event so the Wizard opens. Click **Next** to get to the Trigger window. Click on the **Options** button. Look in the dBASE expression for the entry “contact2- >uba_rating” and adjust that to be what you desire. For example, by default it is <3 which means A(1) and A+(2) clients. Change this number if you wish to send to other client ratings. Click **OK** and then **Finish**.

You may also modify the user whose calendar the Other Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on the first event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule, OK**, and then **Finish**.

Modifications to this process must be done to each event for consistency.

All other events in this process are the same as described above.

**Annual Surveys – Quarterly Groups**

**Purpose:** Use this process to automatically schedule an Other Action for an assigned user to send the annual survey to a client. The scheduled actions are broken into quarterly groups based on the last names of the clients.

**Event:** P 10 First Quarter A-F
Section I  F- Automated Process Definitions

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client) and have a specified rating (the default “Rating:” is A or A+ clients). The last name (“Last:”) will begin with the specified letter and the process will trigger on the 15th of every month.

**Action:** An Other Action to send the survey will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered. It will have an Activity Code of “SRV” and be color coded yellow (if a time is specified). The reference will say “Send Annual Survey”.

**Modifications:** You may modify what rating levels the clients must have to receive the annual survey. To do this, expand the automated process so that the events display. Double-click on the first event so the Wizard opens. Click **Next** to get to the Trigger window. Click on the **Options** button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is <3 which means A(1) and A+(2) clients. Change this number if you wish to send to other client ratings. Click **OK**, and then **Finish**.

You may also modify the user whose calendar the Other Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on the first event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule, OK**, and then **Finish**.

Modifications to this process must be done to each step for consistency.

All other events in this process are the same as described above.

**Client Anniversaries with Firm**

**Purpose:** Use this process to perform a number of events related to a client’s anniversary with your firm. It will automatically schedule activities to send a gift, a card, make a phone call, send an e-mail, or any combination of these activities.

**Event:** **P 10 Schedule Annv w/ Firm Gift to be Sent**

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client) and have a specified rating (the default “Rating:” is all rating levels). The process will trigger 21 days prior to the client start date (“i.e., Client Start Dt:”) with the firm and the number of years is in a five year increment (i.e., 5, 10, 15).

**Action:** A Next Action to send a gift will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered. It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Send Anniversary w/ Firm Gift”.

© TICOMIX™ 2009, All Rights Reserved
Modifications: You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click Finish.

You may modify what rating levels the clients must have to receive the anniversary gift. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click on the Options button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click OK, and then Finish.

You may also modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Click the Activity Details button. Choose the name of the user from the drop-down under “Primary User”. Click Schedule, OK, and then Finish.

Event: **P 20 Schedule Mailing of Annv w/ Firm Card**

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client) and have a specified rating (the default “Rating:” is all rating levels). The process will trigger 14 days prior to the client start date (“i.e., Client Start Dt:”) with the firm.

**Action:** A Next Action to mail a card will be scheduled on a user’s calendar as you define. It will be scheduled on the same day that the process is triggered and it will be scheduled for 7 days into the future from the trigger date. It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Mail Anniversary w/ Firm Card”.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click Finish.

You may modify what rating levels the clients must have to receive the anniversary card. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click on the Options button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6
which means all rating levels. Change these numbers if you wish to send
to specific client ratings. Click OK, and then Finish.

You may also modify the user whose calendar the Next Action will be
scheduled for. To do this, expand the automated process so that the
events are displayed. Double-click on this event so the wizard opens.
Click Next three times to get to the Action window. Click the Options
button. Click the Activity Details button. Choose the name of the user
from the drop-down under “Primary User”. Click Schedule, OK, and then
Finish.

You may modify how many days in the future the Next Action is scheduled
from the trigger date. To do this, expand the automated process so that
the events are displayed. Double-click on this event so the wizard opens.
Click Next three times to get to the Action window. Click the Options
button. Change the number of days in the “Schedule x days into the
future” box. For example, by default it is set to 7 days in the future. Click
OK, and then Finish.

Event: P 30 Sched Annv w/ Firm Call for Advisor(M-F)
Trigger: The contact must be a client (i.e., “Client Status:” = Client) and
have a specified rating (the default “Rating:” is all rating levels). The
process will trigger 14 days prior to the client start date (i.e., “Client Start
Dt”) with the firm. This event will only trigger if the anniversary doesn’t fall
on a weekend.
Action: A Call Back will be scheduled on the advisor’s calendar. It will be
scheduled on the same day that the process is triggered and it will be
scheduled for 14 days into the future from the trigger date. It will have an
Activity Code of “LAM” and be color coded yellow (if a time is specified).
The reference will say “Anniversary w/ Firm Call”.
Modifications: You may disable this event from the process. To do this,
expand the automated process so that the events display. Double-click on
this event so the Wizard opens. Click Next to get to the Trigger window.
Click the down arrow for the “Trigger On” and select Disabled. Click
Finish.

You may modify what rating levels the clients must have to receive the
anniversary call. To do this, expand the automated process so that the
events are displayed. Double-click on this event so the Wizard opens.
Click Next to get to the Trigger window. Click on the Options button.
Look in the dBASE expression for the entry “contact2->uba_rating” and
adjust that to be what you desire. For example, by default it is >0 and <6
which means all rating levels. Change these numbers if you wish to send
to specific client ratings. Click OK, and then Finish.

Event: P 31 Sched Annv w/ Firm Call for Advisor(Sat)
Section I

F- Automated Process Definitions

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client) and have a specified rating (the default “Rating:” is all rating levels). The process will trigger 14 days prior to the client start date (i.e., “Client Start Dt”) with the firm. This event will only trigger if the anniversary falls on a Saturday.

**Action:** A Call Back will be scheduled on the advisor’s calendar. It will be scheduled on the same day that the process is triggered and it will be scheduled for 13 days into the future from the trigger date (so that it is scheduled for the Friday prior to the anniversary as opposed to the Saturday of the anniversary). It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Anniversary w/ Firm Call >”.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events display. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.

You may modify what rating levels the clients must have to receive the anniversary call. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click on the **Options** button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click **OK**, and then **Finish**.

**Event:** P 32 Sched Annv w/ Firm Call for Advisor(Sun)

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client) and have a specified rating (the default “Rating:” is all rating levels). The process will trigger 14 days prior to the client start date (i.e., “Client Start Dt”) with the firm. This event will only trigger if the anniversary falls on a Sunday.

**Action:** A Call Back will be scheduled on the advisor’s calendar. It will be scheduled on the same day that the process is triggered and it will be scheduled for 12 days into the future from the trigger date (so that it is scheduled for the Friday prior to the anniversary as opposed to the Sunday of the anniversary). It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Anniversary w/ Firm Call >”.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events display. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.
You may modify what rating levels the clients must have to receive the anniversary call. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click on the **Options** button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click **OK**, and then **Finish**.

**Event:** P 40 Send Anniversary w/ Firm E-mail  
**Trigger:** The contact must be a client (i.e., “Client Status::” = Client). The process will trigger on the client start date (i.e., “Client Start Dt::”) with the firm.  
**Action:** An e-mail message will be sent to the primary address for the client. The “Thank You for Doing Business With [Enter Company Name Here]!” template will be used to send the e-mail. Make sure that you have edited the template to reflect your company name in both the subject of the e-mail and in the body prior to running this process. The e-mail will be sent immediately upon being triggered.  
**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select “Disabled”. Click **Finish**.

You may modify the e-mail to queue for delivery instead of sending it immediately. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Recipient** tab. Click the down arrow for the “Delivery Options” at the bottom. Select “Queue for delivery”. Click **OK**, and the **Finish**.

**Client Birthdays**  
**Purpose:** Use this process to perform a number of events related to a client’s birthday. This process will look for both primary and secondary contact names. It will automatically schedule activities to send a gift, a card, make a phone call, send an e-mail, or any combination of these activities.

**Event:** P 10 Schedule Birthday Gift to be Sent (Pri)  
**Trigger:** The contact must be a client (i.e., “Client Status::” = Client), be a personal contact type (“Contact Type::” = Personal), have a blank “Date of Death::” field, and have a specified rating (the default “Rating::” is all rating levels). The process will trigger 21 days prior to the primary name’s birth date.
Action: A Next Action to send a gift will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered. It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Send Birthday Gift to [Pri Name]”.

Modifications: You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click Finish.

You may modify what rating levels the clients must have to receive the birthday gift. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click on the Options button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click OK, and then Finish.

You may also modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Click the Activity Details button. Choose the name of the user from the drop-down under “Primary User”. Click Schedule, OK, and then Finish.

Event: P 20 Schedule Birthday Gift to be Sent (Sec)
This event is the same as Schedule Birthday Gift to be Sent (Pri) except that it will trigger on the birth date for the secondary name of the contact record.

Event: P 30 Schedule Mailing of Birthday Card (Pri)
Trigger: The contact must be a client (i.e., “Client Status:” = Client), be a personal contact type (i.e., “Contact Type:” = Personal), have a blank “Date of Death:” field, and have a specified rating (the default “Rating:” is all rating levels). The process will trigger 14 days prior to the primary name’s birth date.
Action: A Next Action to mail a card will be scheduled on a user’s calendar as you define. It will be scheduled on the same day that the process is triggered and it will be scheduled for 7 days into the future from the trigger date. It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Mail Birthday Card to [Pri Name]”.

© TICOMIX™ 2009, All Rights Reserved
Section I  F- Automated Process Definitions

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.

You may modify what rating levels the clients must have to receive the birthday card. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click on the **Options** button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click **OK**, and then **Finish**.

You may also modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule, OK**, and then **Finish**.

You may modify how many days in the future the Next Action is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 7 days in the future. Click **OK**, and then **Finish**.

**Event:** P 40 Schedule Mailing of Birthday Card (Sec)
This event is the same as Schedule Mailing of Birthday Card (Pri) except that it will trigger on the birth date for the secondary name of the contact record.

**Event:** P 50 Schedule B-day Call (Pri, M-F) for Advisor
**Trigger:** The contact must be a client (i.e., “Client Status:” = Client), be a personal contact type (i.e., “Contact Type:” = Personal), have a blank “Date of Death:” field, and have a specified rating (the default is all rating levels). The process will trigger 14 days prior to the primary name’s birth date. This event will only trigger if the birthday doesn’t fall on a weekend.
**Action:** A Call Back will be scheduled on the advisor’s calendar. It will be scheduled on the same day that the process is triggered and it will be scheduled for 14 days into the future from the trigger date. It will have an
Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Happy Birthday Call for [Pri Name]”.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.

You may modify what rating levels the clients must have to receive the birthday call. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click on the **Options** button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click **OK**, and then **Finish**.

**Event:** P 51 Schedule B-day Call (Pri, Sat) for Advisor

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client), be a personal contact type (i.e., “Contact Type:” = Personal), have a blank “Date of Death:” field, and have a specified rating (the default is all rating levels). The process will trigger 14 days prior to the primary name’s birth date. This event will only trigger if the birthday falls on a Saturday.

**Action:** A Call Back will be scheduled on the advisor’s calendar. It will be scheduled on the same day that the process is triggered and it will be scheduled for 13 days into the future from the trigger date (so that it is scheduled for the Friday prior to the birthday as opposed to the Saturday of the birthday). It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Happy Birthday Call for [Pri Name]”.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.

You may modify what rating levels the clients must have to receive the birthday call. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click on the **Options** button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click **OK**, and then **Finish**.

**Event:** P 52 Schedule B-day Call (Pri, Sun) for Advisor
Section I

F- Automated Process Definitions

Trigger: The contact must be a client (i.e., “Client Status:” = Client), be a personal contact type (i.e., “Contact Type:” = Personal), have a blank “Date of Death:” field, and have a specified rating (the default is all rating levels). The process will trigger 14 days prior to the primary name’s birth date. This event will only trigger if the birthday falls on a Sunday.

Action: A Call Back will be scheduled on the advisor’s calendar. It will be scheduled on the same day that the process is triggered and it will be scheduled for 12 days into the future from the trigger date (so that it is scheduled for the Friday prior to the birthday as opposed to the Sunday of the birthday). It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Happy Birthday Call for [Pri Name].”

Modifications: You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click Finish.

You may modify what rating levels the clients must have to receive the birthday call. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click on the Options button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click OK, and then Finish.

Event: P 60 Sched B-day Call (Sec, M-F) for Advisor
This event is the same as Sched B-day Call (Pri, M-F) for Advisor except that it will trigger on the birth date for the secondary name of the contact record.

Event: P 61 Sched B-day Call (Sec, Sat) for Advisor
This event is the same as Sched B-day Call (Pri, Sat) for Advisor except that it will trigger on the birth date for the secondary name of the contact record.

Event: P 62 Sched B-day Call (Sec, Sun) for Advisor
This event is the same as Sched B-day Call (Pri, Sun) for Advisor except that it will trigger on the birth date for the secondary name of the contact record.

Event: P 70 Send Birthday E-mail to Pri Name
Trigger: The contact must be a client (i.e., “Client Status:” = Client), be a personal contact type (i.e., “Contact Type:” = Personal), and have a blank
“Date of Death:” field. The process will trigger on the primary name’s birth date.

**Action:** An e-mail message will be sent to the primary address for the client. The “Happy birthday from [Enter Company Name Here]!” template will be used to send the e-mail. Make sure that you have edited the template to reflect your company name in both the subject and in the body of the e-mail prior to running this process. The e-mail will be queued for delivery upon being triggered. You will then send it from the E-mail Center’s Outbox after you have verified that the e-mail address is correct.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select “Disabled”. Click **Finish**.

**Event:** **P 80 Send Birthday E-mail to Sec Name**

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client), be a personal contact type (i.e., “Contact Type:” = Personal), and have a blank “Date of Death:” field. The process will trigger on the secondary name’s birth date.

**Action:** An e-mail message will be sent to the primary address for the client. The “Happy Birthday from [Enter Company Name Here]!” template will be used to send the e-mail. Make sure that you have edited the template to reflect your company name in both the subject and in the body of the e-mail prior to running this process. The e-mail will be queued for delivery upon being triggered. You will then send it from the E-mail Center’s Outbox after you have verified that the e-mail address is correct.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select “Disabled”. Click **Finish**.

**Client Wedding Anniversaries**

**Purpose:** Use this process to perform a number of events related to a client’s wedding anniversary. It will automatically schedule activities to send a gift, a card, make a phone call, send an e-mail, or any combination of these activities.

**Event:** **P 10 Schedule Wedding Annv Gift to be Sent**

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client), be a personal contact type (i.e., “Contact Type:” = Personal), have a marital status of Married, and have a specified rating (the default “Rating:” is all rating levels). The process will trigger 21 days prior to the client’s wedding anniversary date and the number of years is in a five year increment (i.e., 5, 10, 15).
**F- Automated Process Definitions**

**Action:** A Next Action to send a gift will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered. It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Send Wedding Anniversary Gift”.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.

You may modify what rating levels the clients must have to receive the anniversary gift. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click on the **Options** button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click **OK**, and then **Finish**.

You may also modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule, OK**, and then **Finish**.

**Event:** P 20 Schedule Mailing of Wedding Anv Card

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client), be a personal contact type (i.e., “Contact Type:” = Personal), have a marital status of Married, and have a specified rating (the default is all rating levels). The process will trigger 14 days prior to the client’s wedding anniversary date.

**Action:** A Next Action to mail a card will be scheduled on a user’s calendar as you define. It will be scheduled on the same day that the process is triggered and it will be scheduled for 7 days into the future from the trigger date. It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Mail Wedding Anniversary Card”.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.
You may modify what rating levels the clients must have to receive the anniversary card. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click on the Options button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click OK, and then Finish.

You may also modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Click the Activity Details button. Choose the name of the user from the drop-down under “Primary User”. Click Schedule, OK, and then Finish.

You may modify how many days in the future the Next Action is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 7 days in the future. Click OK, and then Finish.

**Event:** P 30 Sched Wedding Annv Call for Advisor(M-F)
**Trigger:** The contact must be a client (“Client Status:” = Client), be a personal contact type (i.e., “Contact Type:” = Personal), have a marital status of Married, and have a specified rating (the default “Rating:” is all rating levels). The process will trigger 14 days prior to the client’s wedding anniversary date. This event will only trigger if the anniversary doesn’t fall on a weekend.
**Action:** A Call Back will be scheduled on the advisor’s calendar. It will be scheduled on the same day that the process is triggered and it will be scheduled for 14 days into the future from the trigger date. It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Wedding Anniversary Call”.
**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click Finish.

You may modify what rating levels the clients must have to receive the anniversary call. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens.
Click **Next** to get to the Trigger window. Click on the **Options** button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click **OK**, and then **Finish**.

**Event:** P 31 Sched Wedding Annv Call for Advisor(Sat)

**Trigger:** The contact must be a client (“Client Status:” = Client), be a personal contact type (i.e., “Contact Type:” = Personal), have a marital status of Married, and have a specified rating (the default “Rating:” is all rating levels). The process will trigger 14 days prior to the client’s wedding anniversary date. This event will only trigger if the anniversary falls on a Saturday.

**Action:** A Call Back will be scheduled on the advisor’s calendar. It will be scheduled on the same day that the process is triggered and it will be scheduled for 13 days into the future from the trigger date (so that it is scheduled for the Friday prior to the anniversary as opposed to the Saturday).

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.

You may modify what rating levels the clients must have to receive the anniversary call. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click on the **Options** button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is >0 and <6 which means all rating levels. Change these numbers if you wish to send to specific client ratings. Click **OK**, and then **Finish**.

**Event:** P 32 Sched Wedding Annv Call for Advisor(Sun)

**Trigger:** The contact must be a client (“Client Status:” = Client), be a personal contact type (i.e., “Contact Type:” = Personal), have a marital status of Married, and have a specified rating (the default “Rating:” is all rating levels). The process will trigger 14 days prior to the client’s wedding anniversary date. This event will only trigger if the anniversary falls on a Sunday.

**Action:** A Call Back will be scheduled on the advisor’s calendar. It will be scheduled on the same day that the process is triggered and it will be scheduled for 12 days into the future from the trigger date (so that it is scheduled for the Friday prior to the anniversary as opposed to the Saturday).
Sunday of the anniversary). It will have an Activity Code of “LAM” and be
color coded yellow (if a time is specified). The reference will say
“Wedding Anniversary Call >”.

**Modifications:** You may disable this event from the process. To do this,
expand the automated process so that the events are displayed. Double-
click on this event so the Wizard opens. Click **Next** to get to the Trigger
window. Click the down arrow for the “Trigger On” and select Disabled.
Click **Finish**.

You may modify what rating levels the clients must have to receive the
anniversary call. To do this, expand the automated process so that the
events are displayed. Double-click on this event so the Wizard opens.
Click **Next** to get to the Trigger window. Click on the **Options** button.
Look in the dBASE expression for the entry “contact2->uba_rating” and
adjust that to be what you desire. For example, by default it is >0 and <6
which means all rating levels. Change these numbers if you wish to send
to specific client ratings. Click **OK**, and then **Finish**.

**Event:** P 40 Send Wedding Anniversary E-mail

**Trigger:** The contact must be a client (“Client Status:” = Client), be a
personal contact type (i.e., “Contact Type:” = Personal), and have a
marital status of Married. The process will trigger on the client’s wedding
anniversary date.

**Action:** An e-mail message will be sent to the primary address for the
client. The “Happy Anniversary from [Enter Company Name Here]!”
template will be used to send the e-mail. Make sure that you have edited
the template to reflect your company name in both the subject of the e-
mail and in the body prior to running this process. The e-mail will be sent
immediately upon being triggered.

**Modifications:** You may disable this event from the process. To do this,
expand the automated process so that the events are displayed. Double-
click on this event so the Wizard opens. Click **Next** to get to the Trigger
window. Click the down arrow for the “Trigger On” and select “Disabled”.
Click **Finish**.

You may modify the e-mail to queue for delivery instead of sending it
immediately. To do this, expand the automated process so that the
events are displayed. Double-click on this event so the wizard opens.
Click **Next** three times to get to the Action window. Click the **Options**
button. Click the **Recipient** tab. Click the down arrow for the “Delivery
Options” at the bottom. Select “Queue for delivery”. Click **OK**, and the
**Finish**.

**New Client**

**Purpose:** Use this process to perform a number of events related to a contact
becoming a client. It will automatically update the “Client Status:”, “Client St
Date:”, and “Dt Last Updated:” fields. It will attach the Love-Affair Marketing™ automated procedures. It will also schedule a welcome call, gifts and thank you letters or any combination of these.

Event: P 10 Change CLIENT STATUS to ”Client”
- **Trigger:** This event will trigger immediately upon executing the process.
- **Action:** The “Client Status:” field will be updated with the value of “Client”.
- **Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select “Disabled”. Click **Finish**.

Event: P 15 Chg CLIENT START DT to current day
- **Trigger:** This event will trigger immediately upon executing the process.
- **Action:** The “Client Start Dt:” field will be updated with the current date.
- **Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select “Disabled”. Click **Finish**.

Event: P 20 Chg DT LAST UPDATED to current day
- **Trigger:** This event will trigger immediately upon executing the process.
- **Action:** The “Dt Last Updated:” field will be updated with the current date.
- **Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select “Disabled”. Click **Finish**.

Event: P 25 Attach ”Periodic Updates/Rev” Process
- **Trigger:** This event will trigger immediately upon executing the process as long as the “Contact Type:” is Personal.
- **Action:** The Periodic Updates/Reviews automated process will be attached to the clients contact record. It can be viewed on the Tracks tab.
- **Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select “Disabled”. Click **Finish**.

Event: P 30 Attach ”Client Birthdays” Process
- **Trigger:** This event will trigger immediately upon executing the process as long as the “Contact Type:” is Personal.
Section I  F- Automated Process Definitions

**Action**: The Client Birthdays automated process will be attached to the clients contact record. It can be viewed on the Tracks tab.

**Modifications**: You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select “Disabled”. Click **Finish**.

**Event**: P 35 Attach "Client Anniversaries..." Process

**Trigger**: This event will trigger immediately upon executing the process.

**Action**: The Client Anniversaries with Firm automated process will be attached to the clients contact record. It can be viewed on the Tracks tab.

**Modifications**: You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select “Disabled”. Click **Finish**.

**Event**: P 40 Attach "Client Wedding Annv" Process

**Trigger**: This event will trigger immediately upon executing the process as long as the “Contact Type” is “Personal”.

**Action**: The Client Wedding Anniversaries automated process will be attached to the clients contact record. It can be viewed on the Tracks tab.

**Modifications**: You may disable this event from the process. To do this, expand the automated process so that the events display. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select “Disabled”. Click **Finish**.

**Event**: P 45 Attach "Annual Surveys..." Process

**Trigger**: This event will trigger immediately upon executing the process.

**Action**: The Annual Surveys - Monthly Groups automated process will be attached to the clients contact record. It can be viewed on the Tracks tab.

**Modifications**: You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select “Disabled”. Click **Finish**.

You may change the automated process to be attached from Annual Surveys- Monthly Group to Annual Surveys – Quarterly Groups. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Select Annual Surveys – Quarterly Groups from the list. Click **OK**, and **Finish**.
Event: **P 50 Sched Welcome Call for Advisor - A+,A’s**

**Trigger:** This event will trigger immediately upon executing the process as long as the contact “Rating:” is a 1 (A+) or a 2(A).

**Action:** A Call Back will be scheduled on the advisor’s calendar. It will be scheduled on the same day that the process is triggered and it will be scheduled for 14 days into the future from the trigger date. It will have an Activity Code of “NCW” and be color coded yellow (if a time is specified). The reference will say “New Client Welcome Call”.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.

You may modify what rating levels the clients must have to receive the welcome call. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** two times to get to the Additional Trigger window. Click on the **Filter** button. Look in the dBASE expression for the entry “contact2->uba_rating” and adjust that to be what you desire. For example, by default it is =1 or =2 which means all rating levels of A+ or A. Change these numbers if you wish to send to specific client ratings. Click **OK**, and then **Finish**.

You may modify how many days in the future the Call Back is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 14 days in the future. Click **OK** and then **Finish**.

Event: **P 55 Sched Gift to be Ordered - A+,A,B’s**

**Trigger:** This event will trigger immediately upon executing the process as long as the contact “Rating:” is a 1 (A+) or 2(A) or 3(B).

**Action:** A Next Action to order a gift will be scheduled on a user’s calendar as you define. It will be scheduled on the same day that the process is triggered and it will go on the calendar 1 day into the future from the trigger date. It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Order Gift for New Client”.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.
You may modify what rating levels the clients must have to receive the welcome gift. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next two times to get to the Additional Trigger window. Click on the Filter button. Look in the dBASE expression for the entry “contact2>uba_rating” and adjust that to be what you desire. For example, by default it is =1 or =2 or =3 which means all rating levels of A+, A, or B. Change these numbers if you wish to send to specific client ratings. Click OK, and then Finish.

You may also modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Click the Activity Details button. Choose the name of the user from the drop-down under “Primary User”. Click Schedule, OK, and then Finish.

You may modify how many days in the future the Next Action is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 1 day in the future. Click OK and then Finish.

**Event:** P 60 Sched Wind Jacket Order - A+,A's

**Trigger:** This event will trigger immediately upon executing the process as long as the contact “Rating:” is a 1 (A+) or 2(A).

**Action:** A Next Action to order a wind jacket will be scheduled on a user’s calendar as you define. It will be scheduled on the same day that the process is triggered and it will be scheduled for 1 day into the future from the trigger date. It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Order Wind Jacket for New Client”.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click Finish.

You may modify what rating levels the clients must have to receive the wind jacket. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next two times to get to the Additional Trigger window. Click on the Filter
button. Look in the dBASE expression for the entry “contact2-
>uba_rating” and adjust that to be what you desire. For example, by
default it is =1 or =2, which means all rating levels of A+, or A. Change
these numbers if you wish to send to specific client ratings. Click OK, and
then Finish.

You may also modify the user whose calendar the Next Action will be
scheduled for. To do this, expand the automated process so that the
events are displayed. Double-click on this event so the wizard opens.
Click Next three times to get to the Action window. Click the Options
button. Click the Activity Details button. Choose the name of the user
from the drop-down under “Primary User”. Click Schedule, OK, and then
Finish.

You may modify how many days in the future the Next Action is scheduled
from the trigger date. To do this, expand the automated process so that
the events are displayed. Double-click on this event so the wizard opens.
Click Next three times to get to the Action window. Click the Options
button. Change the number of days in the “Schedule x days into the
future” box. For example, by default it is set to 1 day in the future. Click
OK, and then Finish.

Event: P 65 Sched Thank You Letter to New Client
Trigger: This event will trigger immediately upon executing the process.
Action: A Next Action to send the Thank You letter will be scheduled on a
user’s calendar as you define. It will be scheduled on the same day that
the process is triggered and it will be scheduled for 14 days into the future
from the trigger date. It will have an Activity Code of “LAM” and be color
coded yellow (if a time is specified). The reference will say “Send Thank
You Letter - New Client”.
Modifications: You may disable this event from the process. To do this,
expand the automated process so that the events are display. Double-
click on this event so the Wizard opens. Click Next to get to the Trigger
window. Click the down arrow for the “Trigger On” and select Disabled.
Click Finish.

You may also modify the users whose calendar the Next Action will be
scheduled for. To do this, expand the automated process so that the
events are display. Double-click on this event so the wizard opens. Click
Next three times to get to the Action window. Click the Options button.
Click the Activity Details button. Choose the name of the user from the
drop-down under “Primary User”. Click Schedule, OK, and then Finish.

You may modify how many days in the future the Next Action is scheduled
from the trigger date. To do this, expand the automated process so that
the events are displayed. Double-click on this event so the wizard opens.
Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 14 days in the future. Click **OK**, and then **Finish**.

**Event:** **P 70 Sched New Client Referral Thank You**  
**Trigger:** This event will trigger immediately upon executing the process.  
**Action:** A Next Action to send the Referral Thank You letter will be scheduled on a user’s calendar as you define. It will be scheduled on the same day that the process is triggered and it will be scheduled for 14 days into the future from the trigger date. It will have an Activity Code of “LAM” and be color coded yellow (if a time is specified). The reference will say “Send Referral Thank You Letter - Became Client if referred by someone”.  
**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.

You may also modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events display. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule, OK**, and then **Finish**.

You may modify how many days in the future the Next Action is scheduled from the trigger date. To do this, expand the automated process so that the events display. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 14 day in the future. Click **OK**, and then **Finish**.

**Event:** **S 100 Remove this Track**  
**Trigger:** This event will trigger immediately upon executing the process as long as all the previous events have completed.  
**Action:** The automated process titled New Client will remove itself from the contact record.

**Periodic Updates/Reviews**  
**Purpose:** Use this process to perform a check to verify that a contact record has a valid update frequency and to schedule reminders to update that field. This process will also check to see when an update/review is due and start the appointment setting process.
Section I

F- Automated Process Definitions

Event:  P 10 Check for Valid Update Frequency

Trigger:  The contact must be a client (i.e., “Client Status:” = Client), and the update frequency must be invalid (i.e., “Update Freq:” is not equal to Annual, Semi-annual, Tri-Annual, Quarterly, or Monthly.  The process will trigger each day until a valid update frequency is selected.

Action:  A Next Action to update the field accordingly will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered. The reference will say “Select a Valid Entry for the "Update Freq" Field on the Fields Tab”.

Modifications:  You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click Finish.

You may also modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next three times to get to the Action window. Click the Options button. Click the Activity Details button. Choose the name of the user from the drop-down under “Primary User”. Click Schedule, OK, and then Finish.

Event:  P 20 Sched Nxt Action to Set Up Update/Review

Trigger:  The contact must be a client (i.e., “Client Status:” = Client), and have an update/review due within approximately 45 days of the current date (15 days for clients with an update frequency of Monthly). The process will trigger immediately following the criteria being met.

Action:  A Next Action will be scheduled on a user’s calendar as you define. It will be scheduled on the same day that the process is triggered. It will have an Activity Code of “UPD”. The reference will say “Schedule Periodic Update/Review>”. The Notes will indicate to call or send a letter.

Modifications:  You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click Finish.

You may also modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click Next three times to get to the Action window. Click the Options button. Click the Activity Details button. Choose the name of the user
from the drop-down under “Primary User”. Click **Schedule, OK**, and then **Finish**.

You may modify how many days in the future the Next Action is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 0 days in the future. Click **OK**, and then **Finish**.

**Event:** **S 100 Sched Appt Reminder to be Sent**  
**Trigger:** The contact must have a successfully completed History record of a Next Action with the reference beginning with “Schedule Periodic Update/”. The process will trigger immediately following the criteria being met.  
**Action:** A Next Action will be scheduled on a user’s calendar as you define. It will be scheduled on the same day that the process is triggered. It will have an Activity Code of “UPD”. The reference will say “Send Appointment Reminder”.  
**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.

You may also modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule, OK**, and then **Finish**.

You may modify how many days in the future the Next Action is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 0 days in the future. Click **OK**, and then **Finish**.

**Event:** **S 110 Sched Update Literature Request**  
**Trigger:** This event is triggered immediately after event S 100 is triggered.
**Section I**

**F- Automated Process Definitions**

**Action:** An update/review Literature Request will be scheduled on a user’s calendar as you define. It will be scheduled on the same day that the process is triggered.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.

You may also modify the user whose calendar the Literature Request will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Assigned To”. Click **Schedule**, **OK**, and then **Finish**.

You may modify how many days in the future the Literature Request is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 0 days in the future. Click **OK**, and then **Finish**.

**Event:** **S 120 Sched to Update “Dt Last Updated” Field**

**Trigger:** The contact must have a successfully completed History record of an appointment with the reference of “Periodic Review/Update Appt.”. The process will trigger immediately following the criteria being met.

**Action:** A Next Action will be scheduled on a user’s calendar as you define. It will be scheduled on the same day that the process is triggered. It will have an Activity Code of “UPD”. The reference will say “Update the "Dt Last Updated" Field w/ Last Update/Review Date”.

**Modifications:** You may disable this event from the process. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** to get to the Trigger window. Click the down arrow for the “Trigger On” and select Disabled. Click **Finish**.

You may also modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule**, **OK**, and then **Finish**.
You may modify how many days in the future the Next Action is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the Wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 0 days in the future. Click **OK**, and then **Finish**.

**First Year RMD Notification – Pri Name**

**Purpose:** Use this process to automatically schedule a reminder to send the RMD letter and to give a call to the client (primary name) to remind them of taking their required minimum distribution if they turn 70 years of age in the current year.

**Event:** **P 10 Goto Event 130 if Born Jul-Dec**

**Trigger:** This event will trigger if the primary name’s birth month is in July through December. This is so that the process can determine whether or not the client will be 70½ by the end of the year.

**Action:** The automated process will skip the next three events and start at event number 130.

**Event:** **S 100 Sched. Activity to Send RMD Letter #1**

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client), and a personal contact type (i.e., “Contact Type:” = Personal). The process will trigger on the primary name’s 70th birthday.

**Action:** A Next Action to send the RMD letter will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Send RMD Letter #1 to [Pri Name]”.

**Modifications:** You may modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule, OK**, and then **Finish**.

**Event:** **S 110 Sched. RMD Reminder Call**

**Trigger:** This event will trigger immediately upon the completion of the previous event.

**Action:** A Call Back will be scheduled on the advisor’s calendar to remind the client they must take their RMD before the end of the year. It will be scheduled on the same day that the process is triggered and it will be scheduled for 150 days into the future from the trigger date. It will have an
Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Call [Pri Name] to Remind About RMD”.

**Modifications:** You may modify how many days in the future the Call Back is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 150 days in the future (approximately 5 months in the future but before the end of the year). Click **OK**, and then **Finish**.

**Event:** S 120 Goto Event 150
- **Trigger:** This event will trigger immediately upon the completion of the previous event.
- **Action:** The automated process will skip the next two events and start at event number 150.

**Event:** S 130 Sched. Activity to Send RMD Letter #1
- **Trigger:** The contact must be a client (i.e., “Client Status:” = Client), and a personal contact type (i.e., “Contact Type:” = Personal). The process will trigger on the primary name’s 70th birthday.
- **Action:** A Next Action to send the RMD letter will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered and it will be scheduled for 184 days into the future from the trigger date. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Send RMD Letter #1 to [Pri Name]”.
- **Modifications:** You may modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule, OK**, and then **Finish**.

**Event:** S 140 Sched. RMD Reminder Call
- **Trigger:** This event will trigger immediately upon the completion of the previous event.
- **Action:** A Call Back will be scheduled on the advisor’s calendar to remind the client they must take their RMD before the end of the year. It will be scheduled on the same day that the process is triggered and it will be scheduled for 334 days into the future from the trigger date. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Call [Pri Name] to Remind About RMD”.
- **Modifications:** You may modify how many days in the future the Call Back is scheduled from the trigger date. To do this, expand the automated
process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 334 days in the future (approximately 11 months in the future but before the end of November of next year). Click OK, and then Finish.

Event: S 150 Attach RMD Process #2 - Pri Name
Trigger: This event will trigger immediately on completion of the previous event or when branched to by event number 120.
Action: The Successive Years RMD Notification - Pri automated process will be attached to the clients contact record. It can be viewed on the Tracks tab.

Event: S 160 Remove this Track
Trigger: This event will trigger immediately as long as all the previous events have completed.
Action: The automated process titled First Year RMD Notification – Pri Name will remove itself from the contact record.

**First Year RMD Notification – Sec Name**

**Purpose**: Use this process to automatically schedule a reminder to send the RMD letter and to give a call to the client (secondary name) to remind them of taking their required minimum distribution if they turn 70 years of age in the current year.

Event: P 10 Goto Event 130 if Born Jul-Dec
Trigger: This event will trigger if the secondary name’s birth month is in July through December. This is so that the process can determine whether or not the client will be 70½ by the end of the year.
Action: The automated process will skip the next three events and start at event number 130.

Event: S 100 Sched. Activity to Send RMD Letter #1
Trigger: The contact must be a client (i.e., “Client Status:" = Client), and a personal contact type (i.e., “Contact Type:" = Personal). The process will trigger on the secondary name’s 70th birthday.
Action: A Next Action to send the RMD letter will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Send RMD Letter #1 to [Sec Name]”. Modifications: You may modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options
button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule, OK**, and then **Finish**.

**Event: S 110 Sched. RMD Reminder Call**

**Trigger:** This event will trigger immediately upon the completion of the previous event.

**Action:** A Call Back will be scheduled on the advisor’s calendar to remind the client they must take their RMD before the end of the year. It will be scheduled on the same day that the process is triggered and it will be scheduled for 150 days into the future from the trigger date. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Call [Sec Name] to Remind About RMD”.

**Modifications:** You may modify how many days in the future the Call Back is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 150 days in the future (approximately 5 months in the future but before the end of the year). Click **OK**, and then **Finish**.

**Event: S 120 Goto Event 150**

**Trigger:** This event will trigger immediately upon the completion of the previous event.

**Action:** The automated process will skip the next two events and start at event number 150.

**Event: S 130 Sched. Activity to Send RMD Letter #1**

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client), and a personal contact type (i.e., “Contact Type:” = Personal). The process will trigger on the secondary name’s 70th birthday.

**Action:** A Next Action to send the RMD letter will be scheduled on a user’s calendar as you define it. It will be scheduled for the same day that the process is triggered and it will be scheduled for 184 days into the future from the trigger date. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Send RMD Letter #1 to [Sec Name]”.

**Modifications:** You may modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule, OK**, and then **Finish**.
Event:  **S 140 Sched. RMD Reminder Call**  
**Trigger:** This event will trigger immediately upon the completion of the previous event.  
**Action:** A Call Back will be scheduled on the advisor’s calendar to remind the client they must take their RMD before the end of the year. It will be scheduled on the same day that the process is triggered and it will be scheduled for 334 days into the future from the trigger date. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Call [Sec Name] to Remind About RMD”.  
**Modifications:** You may modify how many days in the future the Call Back is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 334 days in the future (approximately 11 months in the future but before the end of November of next year). Click **OK**, and then **Finish**.  

Event:  **S 150 Attach RMD Process #2 - Sec Name**  
**Trigger:** This event will trigger immediately on completion of the previous event or when branched to by event number 120.  
**Action:** The Successive Years RMD Notification - Sec automated process will be attached to the clients contact record. It can be viewed on the Tracks tab.  

Event:  **S 160 Remove this Track**  
**Trigger:** This event will trigger immediately as long as all the previous events have completed.  
**Action:** The automated process titled First Year RMD Notification – Sec Name will remove itself from the contact record.  

**Successive Years RMD Notification – Pri**  
**Purpose:** Use this process to automatically schedule a reminder to send the RMD letter and to give a call to the client (primary name) to remind them of taking their required minimum distribution for the year. This process should be executed after the First Year RMD Notification – Pri process has been executed (it will automatically attach). If you wish to attach this process separately, you will need to modify the events so that the activities are scheduled to fit your needs.  

Event:  **P 10 Goto Event 130 if Born Jul-Dec**  
**Trigger:** This event will trigger if the primary name’s birth month is in July through December.  
**Action:** The automated process will skip the next three events and start at event number 130.  

Event:  **S 100 Sched. Activity to Send RMD Letter #2**
Section I

F- Automated Process Definitions

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client), and a personal contact type (i.e., “Contact Type:” = Personal). The process will trigger on the primary name’s birthday if they are over 70 years of age.

**Action:** A Next Action to send the RMD letter will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Send RMD Letter #2 to [Pri Name]”.

**Modifications:** You may modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Click the **Activity Details** button. Choose the name of the user from the drop-down under “Primary User”. Click **Schedule**, **OK**, and then **Finish**.

**Event:** **S 110 Sched. RMD Reminder Call**

**Trigger:** This event will trigger immediately upon the completion of the previous event.

**Action:** A Call Back will be scheduled on the advisor’s calendar to remind the client they must take their RMD before the end of the year. It will be scheduled on the same day that the process is triggered and it will be scheduled for 122 days into the future from the trigger date. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Call [Pri Name] to Remind About RMD”.

**Modifications:** You may modify how many days in the future the Call Back is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click **Next** three times to get to the Action window. Click the **Options** button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 122 days in the future (approximately 4 months in the future but before the end of the year). Click **OK**, and then **Finish**.

**Event:** **S 120 Goto Event 150**

**Trigger:** This event will trigger immediately upon the completion of the previous event.

**Action:** The automated process will skip the next two events and start at event number 150.

**Event:** **S 130 Sched. Activity to Send RMD Letter #2**

**Trigger:** The contact must be a client (i.e., “Client Status:” = Client), and a personal contact type (i.e., “Contact Type:” = Personal). The process will trigger on the primary name’s birthday.

**Action:** A Next Action to send the RMD letter will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that...
the process is triggered and it will be scheduled for 184 days into the future from the trigger date. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Send RMD Letter #2 to [Pri Name]”. Modifications: You may modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Click the Activity Details button. Choose the name of the user from the drop-down under “Primary User”. Click Schedule, OK, and then Finish.

Event: S 140 Sched. RMD Reminder Call
Trigger: This event will trigger immediately upon the completion of the previous event.
Action: A Call Back will be scheduled on the advisor’s calendar to remind the client they must take their RMD before the end of the year. It will be scheduled on the same day that the process is triggered and it will be scheduled for 306 days into the future from the trigger date. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Call [Pri Name] to Remind About RMD”.
Modifications: You may modify how many days in the future the Call Back is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 306 days in the future (approximately 10 months in the future but before the end of October of next year). Click OK, and then Finish.

Event: S 150 Restart this Process
Trigger: This event will trigger after 1 day has elapsed from the completion of the previous event or when branched to by event number 120.
Action: The automated process will branch to Event 10 and restart.

Successive Years RMD Notification – Sec

Purpose: Use this process to automatically schedule a reminder to send the RMD letter and to give a call to the client (secondary name) to remind them of taking their required minimum distribution for the year. This process should be executed after the First Year RMD Notification – Sec process has been executed (it will automatically attach). If you wish to attach this process separately, you will need to modify the events so that the activities are scheduled to fit your needs.

Event: P 10 Goto Event 130 if Born Jul-Dec
Section I

F- Automated Process Definitions

Trigger:  This event will trigger if the primary name’s birth month is in July through December.
Action:  The automated process will skip the next three events and start at event number 130.

Event:  S 100 Sched. Activity to Send RMD Letter #2
Trigger:  The contact must be a client (i.e., “Client Status:” = Client), and a personal contact type (i.e., “Contact Type:” = Personal). The process will trigger on the secondary name’s birthday if they are over 70 years of age.
Action:  A Next Action to send the RMD letter will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Send RMD Letter #2 to [Sec Name]”.
Modifications:  You may modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Click the Activity Details button. Choose the name of the user from the drop-down under “Primary User”. Click Schedule, OK, and then Finish.

Event:  S 110 Sched. RMD Reminder Call
Trigger:  This event will trigger immediately upon the completion of the previous event.
Action:  A Call Back will be scheduled on the advisor’s calendar to remind the client they must take their RMD before the end of the year. It will be scheduled on the same day that the process is triggered and it will be scheduled for 122 days into the future from the trigger date. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Call [Sec Name] to Remind About RMD”.
Modifications:  You may modify how many days in the future the Call Back is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 122 days in the future (approximately 4 months in the future but before the end of the year). Click OK, and then Finish.

Event:  S 120 Goto Event 150
Trigger:  This event will trigger immediately upon the completion of the previous event.
Action:  The automated process will skip the next two events and start at event number 150.
Event: S 130 Sched. Activity to Send RMD Letter #2
  Trigger: The contact must be a client (i.e., “Client Status:” = Client), and a personal contact type (i.e., “Contact Type:” = Personal). The process will trigger on the secondary name’s birthday if they are over 70 years of age.
  Action: A Next Action to send the RMD letter will be scheduled on a user’s calendar as you define. It will be scheduled for the same day that the process is triggered and it will be scheduled for 184 days into the future from the trigger date. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Send RMD Letter #2 to [Sec Name]”.
  Modifications: You may modify the user whose calendar the Next Action will be scheduled for. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Click the Activity Details button. Choose the name of the user from the drop-down under “Primary User”. Click Schedule, OK, and then Finish.

Event: S 140 Sched. RMD Reminder Call
  Trigger: This event will trigger immediately upon the completion of the previous event.
  Action: A Call Back will be scheduled on the advisor’s calendar to remind the client they must take their RMD before the end of the year. It will be scheduled on the same day that the process is triggered and it will be scheduled for 306 days into the future from the trigger date. It will have an Activity Code of “RMD” and be color coded yellow (if a time is specified). The reference will say “Call [Sec Name] to Remind About RMD”.
  Modifications: You may modify how many days in the future the Call Back is scheduled from the trigger date. To do this, expand the automated process so that the events are displayed. Double-click on this event so the wizard opens. Click Next three times to get to the Action window. Click the Options button. Change the number of days in the “Schedule x days into the future” box. For example, by default it is set to 306 days in the future (approximately 10 months in the future but before the end of October of next year). Click OK, and then Finish.

Event: S 150 Restart this Process
  Trigger: This event will trigger after 1 day has elapsed from the completion of the previous event or when branched to by event number 120.
  Action: The automated process will branch to Event 10 and restart.
Section II

Systems Manual Template Implementation

For GoldMine Premium Edition version 8x
Section II Table of Contents
GoldMine Premium Edition version 8x
Revised 1-29-09

A – Contact Window ................................................................. 1
  Creating a New Contact Record .................................................. 1
  Creating a Referral .................................................................... 3
  Creating/Editing an Additional Contact in the Contacts Tab .......... 4
  Creating/Editing Detail Records .................................................. 6
  Modify a Contact Record for a Deceased Client ......................... 7
  Adding a Client’s Picture ............................................................ 8
  Linking Files to a Contact Record ............................................. 9
  Editing Linked Word Documents ............................................ 10

B – Selecting Contacts ................................................................. 1
  Creating a Group Based on a Filter ............................................. 1
  Deleting Members from a Group ............................................... 3
  Power Searches ...................................................................... 4
  Tagging Contact Records ........................................................ 6
  Editing a Filter ...................................................................... 7

C – Calendar Activities ............................................................... 1
  Scheduling a Call, Appointment, Next Action, or Other Action .... 1
  Editing a Scheduled Call, Appointment, Next Action, or Other Action ................................................................................ 3
  Completing a Scheduled Call, Appointment, Next Action, or Other Action ................................................................. 4
  Completing Unscheduled Activities ......................................... 5
  Scheduling a Forecasted Sale .................................................... 6
  Editing a Forecasted Sale ........................................................ 7
  Completing a Forecasted Sale ................................................... 8
  Scheduling a Recurring Activity ............................................... 9
  Scheduling a Literature Request ............................................. 11
  Completing a Scheduled Literature Request ............................. 13

D – Correspondence .................................................................. 1
  Viewing/Printing Knowledge Base Items ..................................... 1
  Editing Knowledge Base Items .................................................... 2
  Editing a Document Template .................................................... 4
  Cloning a Document Template ................................................... 6
  Cloning/Editing an E-mail Template .......................................... 7
  Merging a Letter to a Contact ................................................... 8
  Merging an E-mail to a Contact ............................................... 10
  Merging a Letter to Multiple Contacts ..................................... 11
  Sending the Weekly Market Commentary ................................. 13

E – Reports .................................................................................. 1
  Printing Labels & Envelopes ...................................................... 1
Creating a New Contact Record

When adding a new contact record to your database, you have two types to choose from. The Main View and the Fields tab will display different fields based on which record type you choose.

**Business Contact:** – Choose this if you are working with a company as a whole.

-Or-

**Personal Contact:** – Choose this if you are working with a household.

- For a description of the fields that appear in each record type please see Section I-B | “Main View”, “Fields Tab”, “Paperwork Tab”, and “Favorites Tab”

1. Create a new contact record from the Main Menu, selecting File→New and then choose between **New Breaking Away – Business Record…** and **New Breaking Away – Personal Record…**

2. Fill out as much information as possible (especially the red labeled fields) and click **OK**.
3. The new contact record is created and visible, letting you add any other information you might already have.
Creating a Referral

1. If you haven’t already done so, create a contact record for the referee.
   - Please see Section II-A | “Creating a New Contact Record”

2. Return to the referrer’s contact record and go to the Referrals tab.

3. Right-click anywhere inside the tab and select New.

4. This opens up the Contact Search Center for you to search for the referee (whom you may have just created). Double-click on the contact when you find it.

5. This opens the “Referral Properties” window. Use the “Reference:” fields to define the relationship between the referee and the referrer.
   - Example: “Mother” and “Daughter” or “Neighbor” and “Neighbor”

6. Click OK to finish creating the link between the two.

7. Notice how double-clicking on any referral record will take you to that particular contact record.
Creating/Editing an Additional Contact in the Contacts Tab

1. With the appropriate contact record open, click on the Contacts tab.

2. **Create:** – Right-click anywhere within the tab and select **New**.
   - Or -
   **Edit:** – Right-click on the appropriate additional contact record and select **Edit**.

3. **Name:** – Type in the full legal name of the additional contact.

4. **Title:** – Select from the lookup list the relation this contact has with the primary contact. Type it in if there isn’t a desirable selection.

5. **Reference:** – Type in how you will address this contact (on the front of labels, envelopes, etc.). If this additional contact is for a seasonal address you can select from the lookup list to easily input the correct prefix for this contact, followed by the name in the “Pri Name:” field.

6. The “Address” section allows you to type in the mailing address of this contact.

7. **E-mail:** – Each additional contact can have its own e-mail address if you ever need to send them an e-mail. This will have to be typed in manually.

8. **E-mail Merge:** – Type in or select from the lookup list to help create specific subsets of addresses that will receive certain e-mail correspondence.
   - Example: “WMC // Weekly Market Commentary”

9. **Phone:** – Type in the phone number most likely to reach this contact.
10. **“Ext:”** – Type the extension number that reaches this contact directly or use it as a way to be more specific as to which phone this physically reaches. Example: “Cell” or “Car” or “Office”

11. **“Fax:”** – Type in the fax number if applicable.

12. **“Dear:”** – Type in the common name of this contact to appear after the “Dear” and before the comma in the greeting of letters and e-mails. If this additional contact is for a seasonal address then this field should be the same as the “Dear:” field shown in the Main View of the Contact Window.

13. **“Merge:”** – Type in code letters to create a subset of contacts associated with a certain activity or event. This is only accessible and useful when this additional contact has been swapped with the primary contact.

14. **“Notes:”** – Type any additional notes that will help to explain the purpose of this additional contact. This section does not get swapped when “swapping with the primary contact”.
   
   Example: “Seasonal Address: Oct – Mar in Florida”

15. Click **OK** to save the data you entered.
Creating/Editing Detail Records

1. With the appropriate contact record open, click on the Details tab.

2. **Create:** – Right-click anywhere within the tab and select New.

   **Edit:** – Right-click on the appropriate detail record and select Edit.

3. **Detail:** – Select from the lookup list the desired detail type by clicking on the arrow at the right of the field, clicking the detail type, and then clicking Select.

4. **Reference:** – Type in or select from the lookup list an appropriate description for the detail type.
   - For more information regarding each detail type please see Section I-C | “Detail Type Definitions”

5. **Notes:** – Type in extra information necessary for tracking the detail record. Depending on the detail type this section may not need to be used.
   - For more information regarding each detail type please see Section I-C | “Detail Type Definitions”

6. Depending on the detail type, the Info tab may have more fields for you to track specific information.
   - For more information regarding each detail type please see Section I-C | “Detail Type Definitions”

7. Click OK to save the data you entered.
Modify a Contact Record for a Deceased Client

There are three scenarios to consider when a client dies that will affect how you update their contact record.

1. If the primary owner dies (i.e., person stored in the “Pri Name:” field) and is survived by a secondary owner (i.e., person stored in the “Sec Name:” field):
   - Create an additional record in their Contacts tab to maintain the Deceased Client’s information in the following fields.
     - For steps on how to do this please see Section II-A | “Creating/Editing an Additional Contact in the Contacts Tab”
       i. “Name:” – Deceased Client’s full name
       ii. “Title:” – Social Security Number
       iii. “Ref:” – Date of Birth
       iv. “Phone:” – Date of Death
       v. “Notes:” – Use this area to maintain the information you will be removing in the following steps.
   - Remove primary owner information from their Main View, Fields tab, Favorites tab, Details tab, and Paperwork tab.
   - Move secondary owner information into the primary owner location in their Main View, Fields tab, Favorites tab and Paperwork tab.
   - Remove Wedding Anniversary Date from their Fields tab.
   - Remove any automated processes assigned to the Deceased Client in their Tracks tab.

2. If secondary owner dies (i.e., Person stored in the “Sec Name:” field):
   - Create a new record in their Contacts tab to maintain the Deceased Client’s information in the following fields.
     - For steps on how to do this please see Section II-A | “Creating/Editing an Additional Contact in the Contacts Tab”
       i. “Name:” – Deceased Client’s full name
       ii. “Title:” – Social Security number
       iii. “Ref:” – Date of Birth
       iv. “Phone:” – Date of Death
       v. “Notes:” – Use this area to maintain the information you will be removing in the following steps.
   - Remove secondary owner information from their Main View, Fields tab, Favorites tab and Paperwork tab.
   - Remove Wedding Anniversary from their Fields tab.
   - Remove any automated processes assigned to the Deceased Client in their Tracks tab.

3. If primary owner dies and there is no secondary owner:
   - Change “Client Status:” field to “Deceased”.
   - Update “Date of Death:” field in their Paperwork tab.
   - Remove any automated processes assigned to the Deceased Client in their Tracks tab. Do this by right-clicking and choosing Remove Process for each entry in their Tracks tab.
Adding a Client’s Picture

1. Using image editing software, save the photo as either a .bmp or .jpg file and save it to a place on the network where everyone has access to it.
   Example: V:\GoldMine\Client Photos:

2. With the appropriate contact record open, click on the Links tab. Right-click anywhere in the tab and select New. The “Linked Document” window will display.

3. “Document Name:” – Select from the Lookup list the appropriate photo type (in coordination with the desired GM+View layout – explained in step 7).
   - Pri Name/Contact Photo: For use with the “Contact Photo” layout
   - Sec Name Photo: For use with the “Contact Photo” layout
   - Company Photo: For use with the “Company Photo” layout

4. “File Name:” – Click the Browse button to locate the photo file. Once found, click on it and then click Open.

5. Click OK to link the photo to the contact record.

6. Go to the GM+View tab.

7. If the photo doesn’t appear, right-click in the display area and choose which photo type you would like to view (i.e., Company Photo, Contact Photos). You will then be able to view the photo(s) with the contact record.
**Linking Files to a Contact Record**

1. Save the file you want to link to somewhere on the network that everyone can access.  
   Example: V:\GoldMine\Linked Files\ 

2. With the appropriate contact record open, click on the **Links** tab. Right-click anywhere in the tab and select **New**. The “Linked Document” window will display.

3. **“Document Name:”** – Type in a name that describes the relevance of the file.  
4. **“Notes:”** – You can be more descriptive by writing any notes about the file here.  
5. **“File Name:”** – Click the **Browse** button to locate the file. Once found, click on it and then click **Open**.  
6. Click **OK** to link the file to the contact record.  
7. Once a link is created, you can double-click on its record in the **Links** tab in order to open/launch that file.
After a contact has been merged into a document template and then that merge saved as a “GoldMine linked document”, a separate Word document has been created and saved in the location you specified (i.e., V:\GoldMine\Linked Files\ ). Follow these steps to view/edit/print that document.

1. With the appropriate contact record open, click on the Links tab.

2. Locate the document you want to edit then double-click on it to open. You can also right-click and select Find… to search for a keyword that is in any of the columns of the Links tab.

3. Microsoft® Word opens the document where you can now make your edits by typing or pasting in previously copied text from somewhere else.

4. When satisfied with edits, save the document by going to File→Save.

5. To print the document, go to File→Print. Choose the printer you will be printing to and how many copies you want printed before clicking OK.
B – Selecting Contacts

Creating a Group Based on a Filter

Groups are static and based on membership. Filters, on the other hand, are dynamic and based on the field criteria by which they are built. Creating a group based on a filter allows for a stable list of contacts (originally based on field criteria) that can be added to or removed from by manually adding or deleting a contact’s membership to that group.

1. From the Main Menu, select Tools ➔ Filters and Groups. The “Filters and Groups” window will display.

2. Go to the Groups tab. Right-click in the group list area and select New. The “New Group” window will display.

3. Give the group a name and select the user you want to be the owner of the group (i.e., which username will the group be listed under). Leave the “Build the Group” check box selected and click the OK button.

4. The “Group Building Wizard” displays and gives you several options for building a group. To build a group based on an existing filter, select “Filtered Records”. Click on the Next button.

5. Select the username the desired filter is stored under (e.g., Public). Click on the down-arrow under “Build on a Filter” and choose the filter you wish to build the group from (e.g., “A+ Clients”). Click the Next button.
6. You can choose a database field to sort your group by. When the group is active, group members will be arranged alphabetically by this sort field (i.e., you can sort by last name by choosing “Last” from the drop-down list). You can also define a reference for the group which places the value you select in the “Reference” column for each group member. Both of these fields can also be left blank. Click the Next button.

7. Click the Finish button. Your group will be built for you. The group will display in the top section of the Groups tab and the members will display in the bottom half.

8. Keep in mind that the group is static and will not automatically add new members who have the same criteria or remove members that no longer meet the criteria. You can add new members to a group using the Group Building Wizard by right-clicking on the group and selecting Add New Member(s)...

9. You can also open the contact record of the person you wish to add, go to the Members tab, right-click and choose New. Pick the “User” where the group is located, such as Public, and then pick the group from the drop-down list and click OK.

REMEMBER: You will need to make the changes that will get this user’s “criteria” to fit with whatever the original criteria was used to create the group to begin with. In other words, if you add a user to a Hobbies group, you will have to manually add that particular hobby to their Details tab as well.
**Deleting Members from a Group**

There are two easy ways to delete members from a group. The first is more useful when there are just one or two contacts that need to be removed while the second is more useful when there are quite a few more contacts to remove.

1. **Using the Members tab:**
   - With the appropriate contact record open, click on the Members tab.
   - Locate the group name that you wish to remove them from, right-click on it and select **Delete**.
   - Click **Yes** when asked to confirm if you want to delete the contact from the group.

2. **Using the “Filters and Groups” window:**
   - Open the “Filters and Groups” window by clicking on the Filters button and then the Groups tab.
   - If the desired group isn’t listed, right-click in the top section, choose **Select User...** then choose the username that is storing the group (e.g., Public) and click **OK**.
   - Locate the desired group and left-click on it to display its current members in the bottom section.
   - For each contact you wish to remove from the group, right-click on their name, select **Delete...** and then click **Yes** to confirm.
Power Searches

The Contact Search Center has more functionality than just finding the contact whose record you want pulled up. It also allows for displaying the contacts of filters or groups and lets you print out the results or output them to another application for further manipulation. When a report doesn’t pull the data you want, a Power Search just may be the answer!

1. Open the Contact Search Center by clicking on the Search button on the toolbar.

2. You can perform a power search in two ways.
   - The first is to search using filters. This allows you to generate a search based on a filter that you create on-the-fly from within the Contact Search Center.
   - Second is to generate a search based on either an existing filter or group.

3. To view the search results of a pre-existing filter or group, click the blue dotted line on the left side of the Contact Search Center window. This will expand the left side of the Contact Search Center and display the two categories: Filters, and Groups. Expanding the desired category by clicking the ‘+’ next to it will reveal any pre-existing search criteria for the selected user. To change the user, click on the current one, select the desired user from the list, and click OK.

4. To activate a search on a certain pre-existing filter, or group, double-click on it in the left-hand side of the Contact Search Center.
   Example: Click on the “<Groups of: (USER)…>” icon to look for groups stored under a different username – where USER is the current name displayed but wanted changed.

5. Click No if asked to optimize and click the “OK” link if an alert comes up. The results will then display.

6. To create a filter within the Contact Search Center, use the textboxes at the top of the window. You will now be able to enter in the criteria for your search. Choose the field you wish to search by in the Lookup drop-down list.

7. Choose the operator to use from the next drop-down list.

8. Enter in what value you want to search for.
9. If additional criteria are needed to complete the filter, click on the **Plus (+) button** to the right of the expression. An additional set of textboxes display to add the criteria. You can change the AND condition to OR by clicking the down arrow and choosing it from the list.

10. As you create the filter, the results are updated in the window. You can press the **Enter** key to manually update the results.

11. You can customize what fields are included in the search results by clicking on the **Columns** button and choosing the desired fields from the “Available columns” list.

12. After you have completed your search, the data can then be exported to Word, Excel, the clipboard, or a printer by right-clicking on the search results and choosing **Output to** and then the desired destination. Please note that outputting to the printer will only display the first three columns specified.
Tagging Contact Records

Tagging contact records is a way to hand-pick multiple contacts to perform certain operations on. Tagged records are treated the same as an activated filter or group.

1. Open the Contact Search Center by clicking on the **Search** button on the toolbar.

2. Search for the contacts you want tagged. If they are part of a filter or group you can use a Power Search to display them quicker.  
   - Please see Section II-B | “Power Searches”

3. After the records display, select the checkbox of the first desired contact. This will select it.

4. Select the checkbox of the next desired contact and both will be considered tagged. To continue tagging additional names, keep selecting the respective checkboxes or hold down the <CTRL> key while clicking on a record.

5. The blue Title bar on the Contact Record window will show how many records are currently tagged.

![Contact Search Center](image)

6. Continue to perform additional searches as needed. The records will remain tagged until you release them. If you tagged a record you didn’t want tagged, remove the check mark and it will release the tag on that record. If you click within the Contact Search Center without the <CTRL> key down the system will ask if you want to release the tagged records.

7. To release all the tagged records, close the Contact Search Center or click on a record (not their checkbox) without the <CTRL> key pressed down and the system will prompt you to release all of the tagged records.
Editing a Filter

1. From the Main Menu, select **Tools→Filters and Groups**. The “Filters and Groups” window will display.

2. Select the filter you wish to edit and click on the **Properties** button at the right.

3. To edit the filter’s expression:
   - With the **Properties** tab displaying, select the radio button next to “dBASE Expr.” Click the **Edit Expression** button, manually make changes to the appropriate part of the code, and click **OK**.
   - Then select the “SQL Query” radio button. Click on the **Edit Expression** button, make the equivalent changes to the SQL code, and click **OK**.

4. Further editing options include sorting the display of contacts and narrowing the range of records selected based on the sorting field. To do this, click on the **Optimize** tab.
   - Select the desired field from the “Sort Order:” drop-down list that you wish to sort by.
     - Example: Choose “Last” for the filter to list contacts alphabetically by their last name.
   - Use the “Beginning Limit:” and “Ending Limit:” fields to create the range of letters the filter will be limited to. To continue our example, begin with “A” and end with “K” to allow the filter to only look at last names beginning with A through K.

5. Click **OK** to save and close.
Scheduling a Call, Appointment, Next Action, or Other Action

There are four types of activities that are identical in their functionality:

- Call
- Appointment
- Next Action
- Other Action

Therefore, scheduling one type is just like scheduling the other three.

1. With the appropriate Contact window open, go to the Schedule menu and select the desired activity type. This opens the "Schedule an <Activity>" window (where <Activity> is the activity type you chose).

2. "Primary User:" – Change to the employee who is responsible for this activity. Do this by clicking on the arrow to the right of the field and selecting the appropriate name.

3. If more than one staff member needs this on their calendar as well, click on the Users tab and double-click on the appropriate name(s) in the "User List:" column to add them to the "Selected Users:" column. Click on the Detail tab to finish scheduling this activity.

4. "Reference:" – Type a descriptive purpose for this activity. Include a greater-than sign ( > ) at the end to indicate there are additional comments in the "Notes:" Examples: "Prospect Packet Follow-up Call >" or "New Client Allocation Appt"
5. “Notes:” – Explain any information that would be needed prior to this activity taking place. Examples would be: What topics should be covered first during an appointment or any special instructions – like which phone number to call.

6. “Code:” – Select the appropriate activity code from the lookup list by clicking on the arrow to its right.
   
   Examples: “DTH // Estate Settlement” or “QTR // Quarterly Call”

7. “Date:” – Change to a date that indicates when the activity should take place. Do this by typing the date in this format: dd/mm/yyyy or by clicking on the arrow to the right and selecting the date from the graphical calendar.

8. “Time:” – Include the time-of-day for the call to take place by typing it in using this format: hh:mm am(pm) or by clicking on the arrow to the right and selecting the time.
   
   NOTE: If there is no preferred time, then leave this field blank and the activity will display in the Task List of the calendar.

9. “Duration:” – Approximate how long the activity will take. Type in the number or use the up and down arrows. You can also specify between minutes or hours.
   
   Example: “1.5” can be typed and “Hr” selected to indicate a one and-a-half hour activity.

10. “Alarm:” – Select this checkbox for the “Primary User” to get a pop-up reminder about the activity at the allotted time. The default is ten minutes prior but you can modify this as desired.

11. Click the Schedule button.

12. Notice the activity is on the calendar of the “Primary User” (in the task list if a time frame wasn’t given) and also in the contact’s Pending tab.

13. To track ongoing tasks you can continually edit the same activity adjusting the “Date:” and/or “Time:” fields each time.

   ▪ Please see Section II-C | “Editing a Scheduled Call, Appointment, Next Action, or Other Action”
Editing a Scheduled Call, Appointment, Next Action, or Other Action

Editing activities from a contact's Pending tab is a great way to track the ongoing process (e.g., any follow up actions taken) related to that activity.

1. With the appropriate Contact window open, go to the Pending tab.

2. Right-click on the pending activity you wish to update and choose Edit. This opens the "Schedule an <Activity>" window (where <Activity> is the activity type you are editing).

“Notes:” – Make a new line at the bottom of the text. Type the date and the follow-up action that just occurred.

“Date:” – Change to a date that indicates when the next follow-up will be regarding this activity or when it is expected to complete. Do this by typing the date in this format: dd/mm/yyyy or by clicking on the arrow to the right and selecting the date from the graphical calendar.

3. Click OK.
Completing a Scheduled Call, Appointment, Next Action, or Other Action

1. With the appropriate Contact window open, go to the Pending tab.

2. Right-click on the pending activity you wish to complete and choose Complete.

3. “User:” – If you are completing another user’s activity and want it to stay associated with that user, be sure to change this field back to their name.

4. “Notes:” – Clear out any unnecessary information that may have been included as “needed to know” prior to the activity. Type in or “copy-and-paste” a dictation that explains what took place during the course of this activity.

5. “Time:” – If necessary, adjust the start time of the activity by typing in the correct numbers using this format: hh:mm am(pm) or by clicking on the arrow to the right and selecting the time (in 15 minute increments) from the drop-down list.

6. “Duration:” – If necessary, type in how long the activity actually lasted using this format: hh:mm:ss

7. Click OK to complete the activity. Notice how the record automatically moves from the Pending tab to the History tab.
   NOTE: If you selected the “Schedule a Follow-up” checkbox, GoldMine® will immediately open a “Schedule a …” window to schedule the follow-up activity you choose.
Completing Unscheduled Activities

1. With the appropriate Contact window open, go to Complete ➔ Unscheduled Call ➔ Outgoing Call… If the activity wasn’t actually a call you can now change it to the correct activity type by clicking the arrow on the right of the “Activity:” field and making your selection from the resulting drop-down list.

2. “Reference:” – Type a descriptive reason for this activity or make a selection from its lookup list by clicking on the arrow to its right. Include a greater-than sign ( > ) at the end of the field if there will be anything in the “Notes:” section. Examples: “Loss of Client/Assets >” or “Address Update >”

3. “Code:” – Select the appropriate activity code from the lookup list by clicking on the arrow to its right.
   Example: “TRO // Transfer Out”

4. “Result:” – Select the appropriate result code from the lookup list by clicking on the arrow to its right.
   Example: “INM // In the mail”

5. “Time:” – Change to the time-of-day the activity started by typing it in using this format: hh:mm am/pm or by clicking on the arrow to the right and selecting the time (in 15 minute increments) from the drop-down list.

6. “Duration:” – Type in however many hours/minutes/seconds the activity took using this format: hh:mm:ss

7. “Notes:” – Type in any additional notes necessary to describe what went on or what was discussed during this activity.

8. Click OK to complete the activity.
Section II  C – Calendar Activities

Scheduling a Forecasted Sale

1. With the appropriate Contact window open go to the Schedule menu and select Forecasted Sale... to bring up the “Schedule a Forecasted Sale” window.

2. “Product:” – Type in where the money is coming from and going to.

3. “Code:” – Select the appropriate activity code from the lookup list by clicking on the arrow to its right. Examples: “ROL // Rollover” or “WTH // Withdrawal”

4. “User:” – Select the employee who is responsible for tracking the transaction process by clicking on the arrow to its right.

5. Keep the “Units:” field at 1 because each transaction will be tracked by its own Forecasted Sale.

6. Skip the “Price:” field because it will auto populate based on the “Amount:” field.

7. “Amount:” – Type the amount of money involved in this transaction. If the money is leaving an account, preface the number with a negative sign. Example: Typing in “-100000” (without the quotes) means $100,000 is being transacted away from your care.

8. “Sale Date:” – Change to a date that indicates when the next follow-up will be regarding this transaction or when it is expected to complete. Do this by typing the date in this format: dd/mm/yyyy or by clicking on the arrow to the right and selecting the date from the graphical calendar.

9. “Notes:” – Add to the “Notes:” section as much information as possible to assist in being knowledgeable in what is taking place [e.g., the company name, account number, any beneficiaries, owner(s), annuitant(s), etc.]. You will also reference the date and follow-up actions that help move the transaction along.

10. Click OK to schedule the activity. Notice that it will appear in the selected user’s Task List for the scheduled day and the linked contact’s Pending tab.
**Editing a Forecasted Sale**

1. With the appropriate Contact window open, go to the **Pending** tab.

2. Find the Forecasted Sale you need to update. Right-click on it and choose **Edit**. This will bring up the “Schedule a Forecasted Sale” window.

3. **Notes:** – Make a new line at the bottom of the text. Type the date and follow-up action that just occurred.

4. **Sale Date:** – Change to a date that indicates when the next follow-up will be regarding this transaction or when it is expected to complete. Do this by typing the date in this format: *dd/mm/yyyy* or by clicking on the arrow to the right and selecting the date from the graphical calendar.

5. Click **OK**.
Completing a Forecasted Sale

1. With the appropriate Contact window open, go to the **Pending** tab.

2. Find the Forecasted Sale you need to complete. Right-click on it and choose **Complete**. The “Complete a Sale” window appears.

3. **User:** – Change to the username of the advisor associated with the client by clicking on the arrow to its right.

4. **Result:** – Select the appropriate result code from the lookup list by clicking on the arrow to its right.
   
   Example: “COM // Complete”

5. **Success:** – Select the appropriate entry by clicking on the arrow to its right to determine if the transaction actually took place.
   
   Example: “Lost Sale” means the transaction was cancelled and no money had changed hands.

6. **Notes:** – Make a new line at the bottom of the text. Type the date and follow-up action that just occurred.

7. Click **OK** to complete the activity. Notice how the record automatically moves from the **Pending** tab to the **History** tab. Also notice that the activity gets time-stamped based on when it is actually completed – hence it will appear on the advisor’s calendar at that date and time instead of the Task List.
Scheduling a Recurring Activity

All activity types except for Literature Requests and To-Dos have a Recurring tab that allows you to schedule activities that have a regular occurrence.

1. With the appropriate Contact window open, schedule the activity type that is pertinent to the current situation.
   - Please see Section II-C | “Scheduling a Call, Appointment, Next Action, or Other Action”

2. Before clicking the Schedule button to finish scheduling the activity, click on the Recurring tab.

3. “Date Span:” – Enter in the starting and ending dates to schedule the recurring activity. If the recurring activity is weekly or biweekly, the start date will determine which day of the week the activities will fall. An activity will be scheduled on the ending date only if it is the correct day. It will not be scheduled after the ending date.

4. “Fixed Frequency:” – This allows you to select how often the activity is scheduled. You can select Daily through Yearly. You can manually select how many days will pass between activities. Skipping weekends will schedule the activity for the following Monday.

5. “Monthly Occurrence:” – Here you can select a specific day, rather than a date, to schedule the activity. You can select the First, Second, Third, Fourth, or Last week of the month, as well as the specific day of the week.
6. **“Reset:”** – Returns the setting to their original values. Use this function if you wish to remove the recurring option for the activity.

7. **“More:”** - Click this button to view more advanced settings:

   a. **“Date Span:”** – You can enter in the starting date and ending date as in the previous instructions. You may include a start and ending time for the activity. You may also choose the number of activities to be scheduled in that time span (i.e., 5 meetings starting on 7/5/06).

   b. **“Occurs:”** – Select one of the frequencies and complete the corresponding “Repeats:” rate and dates, which appear to the right, where applicable.

8. After setting the recurrence options you can click on the Details tab to finish making any modifications to the options for scheduling the activity or click the Schedule button. The Process Monitor will tell when all the activities have been scheduled.

**NOTE:** After scheduling, edit the last activity to include a reminder in the “Notes:” field to schedule more recurring activities if you haven’t started implementing Automated Processes yet.

**WARNING:** After editing/completing recurring activities you will get an ALERT message from GoldMine® prompting to automatically make the same changes with the other activities associated with the recurring one you are editing/deleting. Use great caution when answering the prompt because the affects are irreversible.
Scheduling a Literature Request

1. With the appropriate Contact window open, go to the Schedule menu and select Literature Request... to bring up the “Schedule a Literature Request” window.

2. **“Routing:”** – Specifies the mode of delivery. Should be set to Printer if you are choosing a generic document to be generated.

3. **“User:”** – Select the username that holds the desired document template if you wish to use a cover letter. Most likely you will select “(public)”.  

4. **“Cover Letter:”** – This field allows you to specify a document template to use as a cover letter if desired. Upon completion of this activity, the template chosen here will merge to the contact record and be sent to your default printer if Printer was selected for the routing method.

5. **“Literature List:”** – Allows you to specify the list category from which to select specific literature. By default, GoldMine® displays all list categories. The pane below this option displays titles that belong to the selected category(s). Check the box next to the title(s) you want to include in the Literature Request.

6. **“Assigned To:”** – Select the employee who is responsible for tracking the transaction process by clicking on the arrow to its right. The activity will appear on this user’s Task List.

7. **“Code:”** – Select the appropriate activity code from the lookup list by clicking on the arrow to its right.  
   Examples: “ACT // Accounts/Investments” or “FNL // Financial Planning”
8. **“Send Date:”** – Date on which the Literature Request should be fulfilled.

9. **“Alarm:”** – If selected, GoldMine® will alert the user of the scheduled Literature Request at the specified date/time.

10. **“RSVP:”** – If selected, this allows users to keep track of when and if Literature Requests they have scheduled for other users have been completed. GoldMine® will send an RSVP message to the user’s Inbox as soon as the activity has been completed or deleted. The RSVP record may then be viewed to see what the outcome of the activity was.

11. **“Special Instructions:”** – These would be special instructions needed to fulfill the Literature Request such as packing and shipping information. This information also appears in the “Reference” column of the History tab upon completion.

12. Click the **Schedule** button to finish scheduling the Literature Request.
Completing a Scheduled Literature Request

1. With the appropriate Contact window open, go to the Pending tab.

2. Right-click on the pending Literature Request you wish to complete and choose Complete.

3. If a cover letter was selected to be printed, it will merge with the appropriate contact record and print to your default printer at this time.
   a. If Microsoft® Word asks you about updating the template, click Yes.
   b. The Process Monitor will display what is happening.
   c. After printing, Word will ask you to save the merged document. This is similar to performing a mail merge to a contact record so save the document in the same location as other merged documents and notice a link is created in the contact record’s Links tab.

4. Notice how the activity automatically moves from the Pending tab to the History tab. Also notice that completed Literature Requests will stay in the Task List.
D – Correspondence

Viewing/Printing Knowledge Base Items

1. From the Main Menu, select Go To Knowledge Base.


3. Double-click on the appropriate sub-folder whose name directly correlates with the sections of the TNT Systems Manual.

4. Find the desired file (they are listed alphabetically in each sub-folder) and click on it once.

5. Click on the Launch attached file button in the Knowledge Base’s toolbar to open the file in its respective application.

6. Print the file by using the procedures described by the respective application it opens up in (usually by going to File Print).

7. If you need to edit the original document to fit it to your company’s style you will need to first make a copy of the file that we provide you.
   ▪ Please see Section II-D | “Editing Knowledge Base Items”
**Editing Knowledge Base Items**

The following steps are so your office has its own version of the forms, checklists, etc. that Breaking Away™ offers you in the Knowledge Base. These steps only need to be done once per document. Further editing/saving or printing would be done to your own version of the document.

1. From the Main Menu, select **Go To** « Knowledge Base »

2. Double-click on the “Knowledge Base” book (located in the left pane) and then click on “Systems Manual Docs” book.

3. Double-click on the appropriate sub-folder whose name directly correlates with the sections of the TNT Systems Manual.

4. Find the desired file (they are listed alphabetically in each sub-folder) and click on it once.

5. Click on the Launch attached file button in the Knowledge Base’s toolbar to open the file in its respective application.

6. Go to **File** » **Save As**… and add your company’s initials to the end of the file name to save it as your own document.

7. Change the “Save In:” field to the directory of the original document, click **Save** and then close the document.

   **Example:**  V:\GoldMine\Systems Manual Docs\New Clients

8. Back in GoldMine®, right-click on the same document as before and select **New** » **Page**…

© TICOMIX 2009, All Rights Reserved
9. Type the name of the document with your company’s initials at the end and press the <Enter> key on your keyboard.

10. Right-click on this new document and select Attach File...

11. Click on the button with three dots to browse for the file that was just saved. Once found, click on it and then click the Open button.

12. Click the OK button to finish.
Editing a Document Template

In order to edit a document template you must have Master Rights. Also, it is important to know that anytime you want to customize a Breaking Away™ template, you should clone it first and then edit the cloned version. This is so that in the event the Breaking Away™ templates are modified via an update, your version of the template does not get overwritten.

- For steps on cloning document templates please see Section II-D | “Cloning a Document Template”

1. Open the Document Management Center from the Main Menu, selecting Go To Document Templates.

2. “User:” – Change to the username the desired template is stored under (e.g., Public) by clicking on the arrow to the right.

3. Expand the Document Templates folder and then “Letters, Memos and Faxes”.

4. Right-click on the desired template and choose Properties. If asked to create your own version, click NO.

5. The “Document Template Properties” window will display. Click the Edit button. The template will open in Microsoft® Word. If you are prompted to update the document with data, choose Yes.

6. Make the changes you wish to make to the template. You can type in the changes or copy and paste from another file.
7. After all edits have been made go to the **GoldMine** menu and select **Save as GoldMine Template**.

8. The “Summary Info” window will display. Click **OK** without making any changes.

9. The “Save As” window will display. By default, the template should be saved into the Template folder in the GoldMine® root directory. Saving templates in this location will keep them centralized so they are accessible to everyone and they get backed up when GoldMine® does. Click **Save**.

10. Wait for the message “Document has been saved as a GoldMine Merge Form” to appear in the bottom left-hand corner of Word. Only after it appears can you close Word.

11. Return to GoldMine® and click the **OK** button in the “Document Template Properties” window to complete the edit.
Cloning a Document Template

Cloning a document template is the easiest way to create a new template. It is important to know that anytime you want to customize a Breaking Away™ template, you should clone it first and then edit the cloned version. This is so that in the event the Breaking Away templates are modified via an update, your version of the template does not get overwritten. Also, name the cloned template in a fashion that signifies which templates are your custom versions (e.g., Prospect Packet Letter – ABC Company).

- For steps on editing document templates please see Section II-D | “Editing a Document Template”

1. Open the Document Management Center from the Main Menu, selecting Go To Document Templates.

2. “User:” – Change to the username the desired template is stored under (e.g., Public) by clicking on the arrow to the right.

3. Expand the Document Templates folder and then “Letters, Memos and Faxes”.

4. Right-click on the desired template and choose Clone. The “Document Template Properties” window will display.

5. Modify the “Document Name:” field as appropriate. Keep in mind that it is the label for the template as displayed in the Document Management Center and it appears in the “Reference” column of a contact’s History tab after a mail merge. Example: Seeking Referral Letter #1 – ABC Company

6. The “Template Filename:” field is pointing to the new copy of the file that has been created. Click on the Browse button and locate it. Example: V:\GoldMine\Template\Copy of Seeking Referral Letter #1.dot

7. Right-click on it and select Rename. Give it the same name you used in the “Document Name:” field in the previous step but keep the extension at the end of the file name (.dot). Press <ENTER> on your keyboard to set the name.

8. The file will get reordered alphabetically and you will have to scroll to find it again. Double-click on it to return to the “Document Template Properties” window.

9. Click OK. The new template will be displayed in the Document Management Center.
**Cloning/Editing an E-mail Template**

Cloning an e-mail template is the easiest way to create a new template. It is important to know that anytime you want to customize a Breaking Away™ template, you should clone it first and then edit the cloned version. This is so that in the event the Breaking Away™ templates are modified via an update, your version of the template does not get overwritten.

1. From the Main Menu, select **Go To → Document Templates**.

2. **“User:”** – Change to the username the desired template is stored under (e.g., Public) by clicking on the arrow to the right.

3. Expand the “E-mail Templates” folder and any sub-folders the desired template is stored in.

4. Right-click on the desired template and select:
   a. **Clone**, if you want a copy of the template to edit. Then select which username to store the clone you are about to make.
      - or -
   b. **Edit**, if you just want to make changes to the body of the e-mail and do not need a copy of the original.

5. Make your changes to the body of the e-mail template as needed.

6. If you are cloning a template you will want to modify the “Subject:” line in order to tell the clone apart from the original (since the “Subject:” line acts as the name of the template as well).

7. When all edits are complete click on the **Save Template** button.
Merging a Letter to a Contact

1. With the appropriate contact record open, open the Document Management Center from the Main menu, selecting Go To Document Templates.

2. “User:” – Change to the username the desired template is stored under (e.g., Public) by clicking on the arrow to the right.

3. Expand the “Document Templates” folder and any sub-folders the desired template is stored in and double-click on the template you wish to merge with.

4. The “Select Contact” window will appear allowing you to select the primary contact record or an additional contact (stored in their Contacts tab). Select the appropriate name and click OK.

5. Microsoft® Word comes up and may ask you to update data from linked files. Click Yes.

6. If you wish to make any modifications to the letter, do so at this time.

7. If you wish to save this letter and have access to it from GoldMine® for future reference, go to the GoldMine menu in Word and select Save as GoldMine Linked Document.
8. Give the document a descriptive title (e.g. “Sample, William RMD 20070920 Reminder 1.doc”) and choose the appropriate directory on the network to save it to (e.g., V:\GoldMine\Linked Files\) and click the **Save** button.

9. After Word has saved the document you can print or close it.

10. Notice that, in GoldMine®, records appear in the contact’s **History** and **Links** tabs.

    ▪ **To refer back to or edit this document please see Section II-A | “Editing Linked Word Documents”**
Merging an E-mail to a Contact

1. With the appropriate contact record open, open the Document Management Center from the Main Menu, selecting Go To Document Templates.

2. **User:** – Change to the username the desired template is stored under (e.g., Public) by clicking on the arrow to the right.

3. Expand the “E-mail Templates” folder and any sub-folders the desired template is stored in and double-click on the template you wish to merge with.

4. The “Mail Merge Properties” window appears with two tabs:

   a. **File In History:** – If you are merging a template whose subject and body doesn’t change and it gets sent to a lot of people, you can deselect the checkbox labeled, “Save the template text in history” so that only a record of the e-mail is put in their History tab, but the body of the e-mail is not saved (because it doesn’t need to be since any reference to it can be viewed from the template itself). You can also give the e-mail an Activity or Result code based on your office’s systems and ways for tracking such things.

5. Click OK to finish the merge. If “Send Now” was selected in the Recipient tab then the e-mail will be sent out immediately.

6. If “Queue for delivery” was selected then you will see it resting in your Outbox. Double-click on it to verify the e-mail address and name is correct along with the information inside the body of the e-mail. Click the Send button.
Merging a Letter to Multiple Contacts

1. From the Main Menu, select **Actions**→**Begin Mail Merge**... The “Mail Merge Properties” window will display.

2. With the **Template** tab displaying, select the type of document you want to merge with (e.g., Letters, Memos and Faxes).

3. Select the GoldMine® user that the desired template is saved under (e.g., Public).

4. Select the desired template from the drop-down list.

5. Click on the **Recipient** Tab to choose who will be included in the mail merge. There are several ways to make a contact selection:
   - Select “This contact:” to merge with only the current contact that is open or an additional contact associated with the current contact.
   - Select “All contacts linked to” in order to merge with the current contact and all additional contacts stored in the Contacts tab.
   - Select “All contacts in the following filter or group:” to merge with all contacts, a filtered set of contacts, or a group of contacts.

6. To merge with the primary contact address for the selected contacts, select the “Primary” checkbox.
7. To merge with all additional contacts from the **Contacts** tab, select the “Additional” checkbox.

8. To further limit the merge using a merge code, click the “Merge Code” checkbox and enter the desired merge code. Only the people who are in the filter/group you use and have the selected merge code will be included in the merge.

9. Click the **OK** button. Microsoft® Word will open as GoldMine® starts to generate the mail merge. Word will then minimize and GoldMine® will reappear. Maximize Word again. Select **Yes** if prompted to “update the document with the data from the linked files”.

![Microsoft Word dialog](image)

10. Wait for a “Merge Destination” dialog window to display before doing anything else. You will be prompted whether or not you want to send the merge directly to the printer. Generally you should always select **No** so that you can preview the merge first.

![Merge Destination dialog](image)

11. Word will display a progress bar as GoldMine® history records are created based on the mail merge. The merge is not complete until the progress bar reaches 100%.

12. There is now a new toolbar in Word. It is called the Mail Merge toolbar. Use this toolbar to scroll through the different letters (triangles pointing left and right). If you make changes to one of the letters, the change is reflected in all of the letters. You can print the mail merge using the **Merge to Printer** button on this new toolbar.

13. Close Word and select **No** when asked to save the document.
Sending the Weekly Market Commentary

1. Edit last week’s Weekly Market Commentary e-mail template so that it will now include this week’s commentary instead. If you include the date in the subject of the e-mail, be sure you update it as well.
   - This involves editing an e-mail template. Please see Section II-D | “Cloning/Editing an E-mail Template”

2. From the Main Menu, select Actions → Begin E-Mail Merge…

3. The “Mail Merge Properties” window appears with three tabs:
   a. **“Template:”** – Select the appropriate username that is holding the Weekly Market Commentary template by clicking the arrow to the right of the “User:” field.

   Select the “Weekly Market Commentary” from the “Template:” field by clicking the arrow to its right.

   b. **“Recipient:”** – Select the radio button entitled, “All contacts in the following filter/group:” and then chose the desired filter/group from the drop-down list (e.g., Weekly Market Commentary Recipients).

   Select the “Primary” checkbox to merge with the primary e-mail address.

   Select the “Additional” checkbox to merge with all additional contacts from the Contacts tab that have e-mail
addresses.

Select the “Other” checkbox to merge with all other e-mail addresses associated with a contact (i.e., those that are not the primary address and are not linked to an additional contact in the Contacts tab).

To further limit the merge to just those with a certain e-mail merge code, click the “Limit to E-mail merge code:” checkbox and enter the desired merge code (e.g., WMC).

Then choose to have GoldMine® deliver the e-mail right away or store it in your Outbox for you to send it manually, at a later time.

c. “File In History:” – Deselect the checkbox labeled, “Save the template text in history” so that only a record of the e-mail is put in each contact’s History tab, but the body of the e-mail is not saved (because it doesn’t need to be since any reference to it can be viewed from the original Word document). You can also give the e-mail an Activity or Result code based on your office’s systems and ways for tracking such things.

4. Click OK to finish the merge. If “Send Now” was selected in the Recipient tab then the e-mails will be sent out immediately.

5. If “Queue for delivery” was selected then you will see them resting in your Outbox. Go through them to verify the e-mail addresses and names are correct along with the information inside the body of the e-mail. Click the Send All button.
E – Reports

Printing Labels & Envelopes

1. Open the Reports Center from the Main Menu, selecting Go To > Reports > Report Center.

2. Double-click on the “GoldMine Reports” folder, then the “Labels & Envelopes” folder. Custom Breaking Away™ reports end in “ - BA”.

3. Find the desired label/envelope size and double-click on it. The “Print Report” window appears.

4. If you are printing a label or envelope for just one contact record, then select the radio button entitled “Current contact only” and skip to step 6. Otherwise, select the radio button entitled “All contacts in the following filter or group:” then select “Filters of <USER>…” or “Groups of <USER>…” from the drop down list.

5. Select the desired filter/group from the list.

6. Select the radio button entitled “Window” and click the OK button.

7. Verify the report is displaying the proper names, place the envelopes or label sheets in the printer tray and click the Print button.
Running Crystal Reports

Crystal Reports® is a separate program that integrates with GoldMine®. Most have custom parameters built in that act like a GoldMine® filter, so, in general, you won’t need to use a GoldMine® filter.

1. Open the GoldMine® Reports Center from the Main Menu, selecting Go To→Reports→Report Center.

2. Double-click on the “Crystal Reports” folder and the sub-folder that holds the desired report.


4. Select “ALL Contact Records!” and click OK.

5. The Crystal Reports® viewer opens up, prompting you to enter in the appropriate parameters to pull the data you need. Click OK when that’s accomplished.
   a. For a description of the parameters of each report please see Section I-E-2

6. To print the report, click the Print Report button, select your printer, enter page numbers or ranges if desired, and click Print.

7. To export the data to another format (e.g., an Excel spreadsheet or an Adobe file), click on the Export Report button, select the desired format from the top drop-down list, and then select Disk file as the destination from the bottom drop-down list. Click OK, select the export options as are appropriate to the format chosen, and then click OK again.

8. Close the Crystal Reports® program when done.
F – Automated Processes

**Attaching Automated Processes to a Contact**

Breaking Away™ comes with many Automated Processes (AP) for you to clone and customize to better suite your office’s procedures (e.g., specify which employee will have a reminder activity scheduled on their calendar). When attaching an AP to a contact record, be sure you are attaching your own version of what we have provided. This assures that your changes will not get overwritten during a Breaking Away™ update.

1. With the appropriate contact record open, go to the **Tracks** tab.
2. Right-click anywhere in the tab and choose **Attach a Process**.
3. Click on the desired AP and click **OK**.

**NOTE:** Once your office starts to utilize Automated Processes and has them attached to the desired contact records you will need to have GoldMine® run them on a daily basis.

- For a description of how to run the Automated Processes daily please see Section II-F “Running Automated Processes”
Editing an Automated Process

To edit an Automated Process (AP) that has been provided in the Breaking Away™ overlay, you must Clone it first. Note that if the AP you are cloning contains an event that attaches another AP (e.g., “New Client”), that one will need to be cloned and edited as well.

1. From the Main Menu, select Tools → Automated Processes → Manage Processes.

2. Change the “User:” field to the username that holds the desired AP you are editing by clicking on the arrow to its right. Those provided by Breaking Away™ are stored under “(public)”.

3. To clone an AP:
   a. Right-click on it and select Clone.
   b. Rename the AP by deleting the “Copy of” text and adding your company’s initials at the end of the name (e.g., “Client Birthdays – CWMG”)
   c. Change “Owner:” field to the username that will hold this new AP. For consistency, store it under “(public)”.
   d. Click Next three times and then click Finish.

4. Editing the events of an AP requires knowledge of what that particular AP currently does and what you desire it to do moving forward.
   - For a description of how to modify/disable the events of a particular AP please see Section I-F
Running Automated Processes

The Automated Processes provided to you in Breaking Away™ are date sensitive and must be run each day in order to insure they do not miss getting triggered.

1. From the Main Menu, select Tools ➔ Automated Processes ➔ Execute Processes.

2. Click the Process button.

3. The Process Monitor will display the work it is doing and signify when it is done scanning all of the records.

4. If it is Friday you will want to run the processes for the weekend as well. To do this without having to come into the office on those days you can change the system clock and then run the processes again.

   a. Double-click on the clock that is in your Windows System Tray to open up the “Date and Time Properties” window.
   b. Select the upcoming Saturday’s date on the calendar and then click the Apply button.
   c. Back in GoldMine®, look at the bottom right-hand corner of the window and wait until the date reflects the change you made in Windows (this could take between 1 and 30 seconds).
   d. Now that GoldMine® thinks it is a different day, repeat steps 1 & 2 to run the processes “for that day”.
   e. When the Process Monitor signifies it has finished running the processes, return to the “Date and Time Properties” window to change the date to the upcoming Sunday’s date on the calendar. Click the Apply button again and repeat steps 4.c and 4.d.
   f. When Sunday’s processes are complete change the Windows date back to the current Friday’s date and click OK.
The following steps should be performed by the person designated as the Breaking Away™ Administrator (who has GoldMine® Master Rights).

1. If the new employee is replacing a former employee:
   a. **Licenses**: – No additional GoldMine® licenses should be necessary since there will be no additional people logging in at the same time.
   b. **New GoldMine User**: – You will want to add an additional user account in GoldMine® for the new employee while retaining the former employee’s user account. If you delete the former employee’s account, then you will lose the ability to view their unlinked activities/e-mail, filters, groups, reports, templates, etc. Therefore, this is not recommended.
      - From the Main Menu, select **Tools→Users’ Settings…** The “Users’ Master File” dialog box will display.
      - Right-click on the username of the former employee and select **Clone** to create a new GoldMine® user account that mirrors the settings of the person they are replacing. The “New User Properties” window will display.
      - Enter the username and the user’s full name. You may or may not want to give the user master rights depending on their job function. A password is optional and depends on what your company prefers.
• Click the OK button. You will notice that the user’s name is listed in the “Users’ Master File” window.
• With the new user highlighted, click the Preferences button.
• Click the E-mail tab. If your e-mail provider has already created an account for your new employee you can enter in their username, password, and return e-mail address here.

![Image of the New User Options window]

• Click the Accounts... button, the Edit... button, and then the Advanced Options... button. If the checkbox entitled “The server requires authentication” is selected you will need to type in the new employee’s e-mail username and password again.

![Image of the Advanced Account Settings window]

• Click OK four times and then click the Close button.
• The first time you log into GoldMine® using the new user’s username, it may or may not ask which database you would like to open. If it does, select Breaking Away (or the name of your primary GoldMine® contact set). You will now be able to log into GoldMine® using the new account on any of the computers in the office that are set up for GoldMine® access.
c. **Pending Activities:** You may want to have all of the former employee’s pending activities in GoldMine® moved to the new employee’s calendar. This is done by performing a Territory Realignment.

- From the Main Menu, select **Tools→Data Management→Territory Realignment**.
- You may get an alert suggesting that you backup your database first. If you do not have a recent backup, then please stop here and create a backup before continuing. Otherwise just click **OK**.
- Click the **Next** button.
- Select “All Contact Records” and click the **Next** button.
- Click the **Next** button again.
- Select the former employee’s name from the drop-down list of the “Reassign the activities of this user:” field.
- Select the new employee’s name from the drop-down list of the “To this user:” field.
- Configure the appropriate date range that the pending activities exist in and the type of activities to move.
- Click the **Next** button and then **Finish**.

![Image of Territory Realignment Wizard](image)

- **GMLink:** The new employee probably will be using the same computer as the former employee but will log into Windows under a different name. If this is the case, the GMLink will need to be uninstalled and then reinstalled under the new Windows User account.
  - **This involves uninstalling and reinstalling the GMLink. Please see Section II-G | “Installing/Reinstalling the GMLink”**

2. If the new employee is strictly an addition to the staff:

a. **Licenses:** You will need an additional GoldMine® license to allow the new employee to be logged into GoldMine® at the same time as everybody else.
Upon receipt of the license key, go to the Main Menu and select **Tools → Configure → License Manager**. The “GoldMine License Manager” window will display with the **Licenses** tab selected.

The number of licenses you currently have is displayed at the right (“Total users/dist.”).

Click the **New License** button in the bottom left. The “GoldMine License Upgrade” dialog box will display. After reading the license agreement, click the **I Agree** button to continue.

Type the Serial Number and Key Code. When finished click the **OK** button to return to the “GoldMine License Manager”.

You can now see that the total number of licenses has increased. Click the **Close** button to exit.

b. **New GoldMine User**: – You will need to create an additional username in GoldMine® for the new employee. See step 1.b on how to do this.

c. **New Computer**: – To setup a computer to access GoldMine® for the first time, it will need to be logged into Windows with administrative rights and connected to the network so a shortcut to GoldMine® can be created.

   - **Map Network Drive**: – Have your local IT/network consultant map a network drive to the GoldMine® shared directory on the server. The mapping must be exactly the same as it is on the other computers (e.g., Point “V:” to \server\GoldMine\). Then, open the new drive and locate the “gmw.exe” file to create a shortcut on the desktop of the new employee's desktop (preferably in the “All Users\Desktop” folder). Then, rename the shortcut to say “GoldMine”.

   - **GMLink**: – If the new employee will be working with Document Templates and performing mail merges into Word, the GMLink will need to be installed.

      - **This involves installing the GMLink. Please see Section II-G | “Installing/Reinstalling the GMLink”**
### Administering GoldMine® upon Employee Termination

The following steps should be performed by the person designated as the Breaking Away™ Administrator (who has Master rights) unless otherwise noted (e.g., step 2).

1. **Clean up:** – Deleting a GoldMine® username will cause all things associated with it to be inaccessible (but not deleted) if it is not linked to a contact record. This is unnecessary clutter in your database and can be cleaned up.
   
   a. **Filters:**
      
      i. From the Main Menu, select **Tools ➔ Filters and Groups…**, then select the appropriate username from the “View Filters:” drop-down list.
      
      ii. Move useful filters to another username by right-clicking on each, selecting **Properties…**, choosing the desired username from the “Owner:” drop-down list and clicking **OK**.
      
      iii. Delete unnecessary filters by right-clicking on each, selecting **Delete…** and then clicking **OK**.
   
   b. **Groups:**
      
      i. From the Main Menu, select **Tools ➔ Filters and Groups…** and click on the **Groups** tab and right-click in the top section to choose **Select User…** to pick the appropriate username from the resulting drop-down list.
      
      ii. Move useful groups to another username by right-clicking on each, selecting **Edit…**, choosing the desired username from the “User:” drop-down list and clicking **OK**.
      
      iii. Delete unnecessary groups by right-clicking on each, selecting **Delete…** and then clicking **OK**.
   
   c. **Reports:**
      
      i. From the Main Menu, select **Go To ➔ Reports ➔ Report Center** and select the appropriate username from the “User:” drop-down list.
      
      ii. Move useful reports to another username by right-clicking on each, selecting **Properties…**, choosing the desired username from the “Owner:” drop-down list and clicking **OK**.
      
      iii. Delete unnecessary reports by right-clicking on each and selecting **Delete…**. **NOTE:** Reports are separate files that are stored on your network, so if the “Delete the report-layout file also” checkbox is selected the actual report file will be permanently deleted off of the server as well. If you know someone else is using that exact same report file, deselect the checkbox before clicking **OK**.
   
   d. **Templates:**
      
      i. From the Main Menu, select **Go To ➔ Document Templates** and select the appropriate username from the “User:” drop-down list.
      
      ii. Move useful document templates to another username by right-clicking on each, selecting **Properties…**, choosing the desired username from the “Owner:” drop-down list and clicking **OK**.
      
      iii. Move useful e-mail templates to another username by right-clicking on each, selecting **Clone…**, choosing the desired username from the “Owner:” drop-down list and clicking **OK**.
username from the drop-down list, and clicking OK. Please note that the original will need to be deleted.

iv. Delete unnecessary templates by right-clicking on each, selecting Delete, and then clicking Yes to verify. NOTE: Templates are separate files that are stored on your network. Be aware that this does not delete the file from the network, just the “pointer” to it in GoldMine®.

e. Automated Processes:

i. From the Main Menu, select Tools→Automated Processes→Manage Processes and select the appropriate username from the “User:” drop-down list.

ii. If an automated process (currently being used or may be in the future) is stored under the former employee’s username, then move it to another by right-clicking on each, selecting Properties… and choosing the desired username from the “Owner:” drop-down list before clicking Finish. If it isn’t being used and won’t be used in the future, right-click on it and select Delete…

iii. If your office is using automated processes that contain events which are set up to schedule items on the former employee’s calendar, these processes need to be modified so these scheduled activities are put on a current employee’s calendar.

   ▪ This involves modifying automated processes. Please see Section I-F and look for the appropriate automated process.

iv. If you are not sure if an automated process is attached to any contact records you can use a SQL query to tell you. Click on the Filters button on the toolbar and click the SQL Query tab. Then change the username to MASTER and then choose “Tracks Attached to Contacts” from the drop-down list to the left before clicking on the Query button.

f. Removing from Lists:

i. User Groups – From the Main Menu, select Tools→User Groups… Select the appropriate user group on the left, click on the Members Setup button and if the name to be deleted appears in the “Group Members” column on the right, double-click on the
name, then click OK. After the last group has been reviewed, click Close.

ii. E-mail Distribution Lists – From the Main Menu, select Go To→Mail. Right-click anywhere and select Options→Set up Distribution Lists. Click on the Toggle View button in the upper left to see the public lists. Click on the lists (in the left pane) that this person is a part of and delete their entry (in the right pane) by right-clicking on it and selecting Delete. Next, log into GoldMine® as the former employee and open their Distribution List Center. Right-click on each private list and select Delete Distribution List.

2. E-mail: – While logged into GoldMine® as the former employee, a few other things should be checked on. Open the E-mail Center from the Main Menu by selecting Go To→Mail.
   a. Check the Inbox and forward any e-mails still in there to the appropriate employee. Ideally their e-mail account(s) have already been cancelled by now, but if not, click on the Online folder to have GoldMine® check for any more e-mail that may be out there still, right-click and select Get All.
   b. Check the Outbox and the Drafts folder for any pending e-mails that have yet to be sent out and determine if they need to be deleted or followed through.
   c. Check the Deleted folder. If it contains anything, right-click on the folder and select Empty trash can. At this point, the Inbox, Outbox, Deleted, and Drafts folders should all be empty.
d. Disable the e-mail account(s) by clicking on the **Actions** button in the E-mail Center’s local toolbar and select **Edit E-mail Preferences**. Click the **Accounts** button. Click the **Delete** button until there is only one account left. For the last account, click the **Edit...** button and delete the “Username:”, “Password:” and “Your return address:” fields. Click **OK** twice.

e. Check for unlinked, filed e-mail by using the Activity List. From the Main Menu, select **Go To** → **Activities**. Expand the “E-mail” folder in the Navigation Pane and click on the “Filed” folder. Click on the “Show” button in the local toolbar and select (all). Wait for GoldMine® to finish displaying all of the e-mails. Then look for blank entries in the “Contact” column. Right-click on these and choose **Read** to decide whether to delete it or link it to a contact. By linking it to a contact record, even if it’s the former employee’s, you ensure everyone’s ability to get at the e-mail from the contact’s history tab.

3. **Pending Activities**: – So nothing falls through the cracks you may want to move their pending activities to another employee’s calendar.  
   ▪ This involves performing a **Territory Realignment**. Please see Section II-G | “Administering GoldMine Upon New Hire” | Step 1.c

4. **Delete**: – After all the above has been checked and cleaned up, it is time to actually delete the GoldMine® username.
   a. Be logged into GoldMine® as a user with master rights.
   b. From the Main Menu, select **Tools** → **User Settings**.
   c. Highlight their username, click the **Delete** button and then **Yes** to confirm.
   d. It is recommended to keep a list of all usernames you have used in the past and are currently using so that you do not accidentally recreate a previously used username further down the road.

**NOTE**: These steps only pertain to GoldMine®/Breaking Away and do not cover steps regarding network security related issues and canceling accounts for other software programs or e-mail accounts. You will need to communicate such needs with a local IT/network consultant and your e-mail provider.
Installing/Reinstalling the GMLink

The GMLink is a plug-in to Microsoft® Word and Excel. It allows you to perform mail merges and edit document templates. The program installs under one Windows User account and can only be used when logged into Windows under that account. Therefore, if you have a new employee who will be using a previously used computer, you will need to reinstall the plug-in under the new Windows User account.

1. Uninstall the GMLink:
   a. With GoldMine® and Word closed, go to Window’s Add/Remove Programs (in the Control Panel), select “GoldMine® Plus for Microsoft® Office,” and click the Remove button.
   b. Search through the entire PC (all local disks and in hidden files and folders) for “gmlink.dot” and delete any instances found.
   c. Search through the entire PC (all local disks and in hidden files and folders) for “normal.dot” and delete any instances found.

2. Install the GMLink:
   a. Log into Windows as the user who will be using the GMLink. Please note that the user must have local administrator rights to the computer.
   b. Open Microsoft® Word, go to Tools→Macros→Security Settings and make sure “Medium” is selected, and then click OK.
   c. Close Word, and open GoldMine®.
   d. Now go to the “V:\GoldMine\Setup\” directory. Look for and double-click on “GMLinkInstaller.exe”. Then, follow the prompts.
   e. The GMLinkInstaller will automatically open Word and you will have to click the OK button a few times and the Save Preferences button on one of them.
   f. Close Word. You may then see a couple more windows prompting you. Once again, just click OK. The last one will allow you to click Finish.
   g. A new menu called GoldMine should now be present in Word when you open it. If not, then go to the Tools menu in Word, select Templates and Add-Ins..., and check the box next to GMLink.dot.
Section III Table of Contents
GoldMine Premium Edition version 8x
Revised 1-29-09

A - Frequently Asked Questions and Troubleshooting ................................................... 1
Calendar ......................................................................................................................... 1
Contact Records ......................................................................................................... 2
E-mail Center .............................................................................................................. 3
E-mail Merges ............................................................................................................ 4
Fields and Tabs .......................................................................................................... 5
General ...................................................................................................................... 5
Reports ....................................................................................................................... 7
Sync ............................................................................................................................ 8
Templates .................................................................................................................. 9

B - GoldMine Field Properties .................................................................................. 1

C - Breaking Away™ Hot Keys for Tabs Reference .................................................... 1

D - LPL Compliance .................................................................................................. 1
LPL Electronic Communications Policy ................................................................. 1

E - Customizing Breaking Away™ ........................................................................... 1
A - Frequently Asked Questions and Troubleshooting

Calendar

**Question:** How do I make activities on my calendar roll over to the next day if they were not completed.

- or -

**How do I stop activities from rolling over?**

**Answer:** Right-click in the Calendar window and select **Options → Preferences**. The column "Auto Roll-overs" on the right of the properties box allows you to choose which activities you would like to have automatically rollover if not completed.

**Warning!** Once you activate an auto roll-over and the uncompleted activities from the past do roll-over, this cannot be reversed except by restoring your calendar from backup. Also, if you change the date on your computer to a future date and open GoldMine®, the activities will roll to that future date and will not roll back to their original dates when you set your computer clock back to normal.

**Question:** When I schedule activities on my GoldMine® calendar, they say they are linked to the contact record that I specified, but they don't show up on the respective contact's Pending tab.

**Answer:** When you are scheduling activities, you deselected the "Link to selected Contact:" checkbox and manually typed the contact name rather than selecting it from the Contact Search Center. So, even though you are seeing the name you typed, the activity is actually not linked to anyone. To prevent this from happening and for things to work properly, do not manually enter contact names when scheduling activities. Instead, either open the record for the contact whom you want to schedule the activity for before scheduling the activity or, when scheduling the activity, change the contact name by clicking on the button to the left of the contact name field and selecting **Look up another contact...** from the drop-down list (this will open the Contact Search Center). If an activity has already been scheduled incorrectly, simply right-click on the activity, select **Edit...** and use the steps outlined above to change the contact.

**Question:** How do I make e-mail messages appear/not appear on the calendar?

**Answer:** With the GoldMine Calendar open, right-click in the calendar window and select **Activities**. The "Messages" checkbox under the "Scheduled Activities" column will toggle on/off displaying e-mails that are in your Inbox. The "Messages" checkbox under the "Completed Activities" column will toggle on/off displaying e-mails that have been sent and received e-mails that have been filed.
Contact Records

Question: How do I populate a field’s lookup list with an existing lookup list from another field? (i.e., How to give "Field2" the same lookup list as "Field1")

Answer: Here are the steps on how to auto-populate a lookup list:
1) Click the Lookup Arrow in the new field (i.e. "Field2") and select Lookup Window.
2) Click the Setup button.
3) At the bottom select "Import Lookup entries from another field" and choose the desired field (i.e. "Field1") from the drop-down menu.
4) Click OK to bring in the list and then Cancel to finish up.

Question: How do I modify or delete existing GoldMine® contact record alerts?

Answer: Once an alert has been created, it may be modified or deleted in the GoldMine Knowledge Base. From the Main Menu, select Go to Knowledge Base. Expand the "Knowledge Base" book by clicking on the "+" sign next to it. Then expand the "System" book and the "Contact Alerts" folder. You will now see a list of all the alerts that have been created. When an alert is select, its message can be modified from the right pane. Its properties can be edited by right-clicking on it and selecting Edit. To delete an alert, right-click on it and select Delete.

Question: How do I merge two or more contact records?

Answer: Here are the steps on how to merge contact records:
1) Open the Contact Search Center by clicking the Search button on the GoldMine toolbar and search for the contact record that you want to merge data into.
2) Place a check mark next to the contact record that you want to keep (the one to be merged into).
3) Place a check mark next to the contact record that is to be merged.
4) From the Main Menu, select Tools>Data Management>Merge/Purge Records>Merge Tagged Records.
6) When GoldMine is finished merging the contact records, the old records will be deleted automatically.

Question: Every time I try to enter data into a field using a selection from its Lookup list the current data gets overwritten. How can I allow multiple entries into a field (such as "Merge:" when selecting from a Lookup list?)

Answer: Each entry you add to a Lookup list has the ability to overwrite all current data in a field or append itself to the data. To make that particular entry append to data already entered in the field add a semi-colon to the entry lookup. Here is how you can do this:
1) Click on the arrow at the right end of the field you wish to have multiple entries for in order to open its Lookup list.
2) Click the New button to create a new Lookup entry or click on an existing entry that you wish to make this modification to and click the Edit button.
3) Give the new entry a name or leave the current name as is, but append a semicolon to the end of it (making it the last character in the entry). The semicolon should, however, precede the comment (beginning with //) if one exists.
4) Click OK to save the change.
5) Repeat steps 2-4 until you have modified all desired entries, then click **Cancel** to close the Lookup window.

Now when you append multiple entries (with the semicolon added) from a lookup list each entry will be separated by a comma. Please keep in mind that once you choose an entry without that semicolon it will overwrite any data already in the field.

---

**E-mail Center**

**Question:** How come I received this message, “A Protocol ERROR occurred in logging in or retrieving messages: -ERR UserName or Password is incorrect” after I clicked on the “Online” icon to check for new e-mails?

- or -

**Question:** I don’t seem to be getting e-mails lately, why?

**Answer:** Check your e-mail account settings in GoldMine® to make sure your username and password are set up correctly. Open the GoldMine® E-mail Center and right-click on the e-mail address account icon (in between the “Online” and “Inbox” icons) and select **Account Properties.** If your account requires authentication when sending e-mails, then click on the **Advanced Options** button, select the checkbox labeled “The server requires authentication” and then retype in the correct username and password you’re your e-mail account (there will always be asterisks in the “Password” field – even if it is truly blank – because it is encrypted) before clicking **OK.**

Note: You may have to double check with your e-mail provider or broker/dealer to verify and compare the information.

Tip: For those whose broker/dealer is LPL, your e-mail password is the same as your BranchWeb password.

**Question:** How do I create a general e-mail account that looks as though messages are being sent from “Info” or “Reservations” instead of one of my employees?

**Answer:** GoldMine® associates a name with every e-mail account. This name is pulled from the “Full Name” of the GoldMine® user who sends out the e-mail. Therefore, if you want an e-mail address to look like it came from “Info” then you will have to create a GoldMine® User who’s “Full Name” Field is “Info” and then set up the e-mail account in the GoldMine® E-mail Center.
**E-mail Merges**

**Question:** When I send a mass e-mail merge (like the Weekly Market Commentary) some e-mails will get sent out but then an error message pops up saying "Message Encoding Failed..." Sometimes, if I click OK, GoldMine® will close. Can I just leave the error message up while the other e-mails get sent out?

**Answer:** There are several environmental factors that can cause this general error but the most common are software interference and large e-mail size. You want to respond to the error right away because any other e-mails that “get sent” won’t necessarily contain any text. If GoldMine closes when you click OK then contact your Breaking Away™ Technical Support Analyst for further troubleshooting. Otherwise, try these troubleshooting techniques:

1. May be due to a bad e-mail address in the e-mail merge. Look through the addresses of the e-mails that are in your Outbox to verify they are all good.

2. Having anti-virus software installed that is scanning the e-mail as it is being sent (and not being able to keep up with the quantity) has been known to cause this error. Disabling the anti-virus e-mail scan (temporarily) before performing an e-mail merge may help. Also, try temporarily disabling any firewall programs (especially the Windows Firewall).

3. It could be a network congestion issue. It is helpful to keep an eye on the size of the e-mails that are getting sent out, how many total recipients there are, how many e-mails are sent before the error occurs, whether the merge was sent from someone’s workstation or from the server, and how many other software programs were open at the time. Here are some things to try:
   a. If the e-mails were being sent from someone’s workstation then try emptying out the many temp folders that Windows has (deleting the files Windows will allow you to at that time).
      - “C:\Temp\”
      - “C:\Documents and Settings\USER\Local Settings\Temp\”  <---where “USER” is your Windows logon name
      - “C:\Windows\Temp\”
   b. Send the e-mail merge from the server.
   c. Send the e-mails immediately (instead of queuing for delivery).
**Fields and Tabs**

**Question:** I've moved my tabs around a lot and want them back to the default "Breaking Away layout."

- or -

Our new hire does not have the same tab order as the rest of us. Is there an easy/fast way to get them right?

**Answer:** Yes, although it is a per user setting.

1) Close out of GoldMine®.
2) Open the GoldMine® root directory, then look for the file called MASTER.INI and open it. This is a text file that will open with Notepad.
3) Notice the file is broken into sections – denoted by their titles inside square brackets. Under the [GoldMine] section, look for the lines that start with "ROTabItemsOrder=" and "ROTabItemsHidden=". Highlight both lines and copy its text.
4) Locate "NEWHIRE.INI" (where 'NEWHIRE' is the GoldMine® username of the new employee) and open it up by double-clicking on it.
5) Look for and highlight over the same sections from step 3 and paste over it.
6) Save and close the file.
7) Open GoldMine® back up to see the new tab order.

**General**

**Question:** When I try to log into GoldMine®, I get the message, "Waiting for permission to login".

**Answer:** If you get this error message, it means that the GoldMine® license file has been locked. To resolve this, simply go to the GoldMine® root directory on the server (e.g., V:\GoldMine\), find the license.biu file, right-click on it, select the Rename option, and change the "u" to an "n." It should now read license.bin and you will be able to login to GoldMine®.

NOTE: If the license file is not displayed with the extension (e.g., .bin or .biu), then you will have to change your folder options to not hide known file extensions by going to the Tools menu in Windows Explorer, selecting Folder Options, clicking on the View tab, and deselecting the option for "Hide extensions for known file types".

**Question:** I received an e-mail from GoldMine® or Crystal Reports® telling me there is an update to the program. Should I follow the notification and do the upgrade?

**Answer:** You may receive update information from FrontRange Solutions (GoldMine®) or Business Objects (Crystal Reports®), however we are asking that you ignore this because we will notify you via a Breaking Away™ Newsletter when and if upgrades are necessary and/or prudent. This will help ensure that your GoldMine®/Breaking Away™ system runs as smoothly as possible.

**Question:** How can I print out the list of people that appear in my filter or group?

**Answer:** There are a couple of ways to do this.
One way is that you can use a GoldMine® report with your filter. Some reports to take a
look at are “Contact Info (top half of screen),” “Contact Profile (detailed),” and “Contact
Wide Line Report - Landscape”. To use a GoldMine report:
1) Click on the **Reports** button on the toolbar to open the Reports Center.
2) Go to the chosen report (e.g., “Contact Wide Line Report – Landscape”) under the
   “GoldMine Reports” folder and “Contact Reports” sub-folder of the *(public)* user.
3) Double-click on the report and choose the filter you would like to use from the drop-
   down list under “Allow contacts in the following filter or group”.
4) Click **OK** and the report will display.
5) Click the **Print** button to print the report.

Another way to print out the results is using a Power Search from the Contact Search
Center. To do this:
1) Click on the **blue dotted line** on the left side of the Contact Search window.
2) A list of filters and groups will appear in the left side of the window.
3) Click on “<Filters of: >” and choose *(public)* - or whatever user the filter is under.
   This will display the available filters to use.
4) Double-click on the filter you wish to use.
5) You will be asked if you want to limit the search to improve speed and performance if
   there are a lot of records. Choose **No**.
6) You may be alerted again about improving the performance. Click **OK** to run the
   filter.
7) The results will display in the Contact Search Center. If you wish to view additional
   fields, click on the **Columns** button and make your selection(s).
8) To print the results you will export them to another program like Microsoft® Word or
    Excel. Right-click on the results list and choose **Output To**.
9) Choose which program you would like to output the results to. The selected program
    will open with the results displayed. Choose to print according to the program used.
Question: **When I go to Print the GoldMine® Appointments List and the Call Back List I can't get it to print for another user.**

**Answer:** These reports allow you to print either one user or a range of users. To print a range of users, right-click the desired report and choose **Sorts.** With **Primary Sort** selected (being sorted by UserID) enter the first username in the "Start at:" field and the last user in the "End at:" field. Click **OK** to save the changes for that report.

PLEASE NOTE: GoldMine® sorts the usernames alphabetically. Therefore, if you had ANGELA, BILL, SARA, and TODD as GoldMine usernames you can choose to print these reports for everyone by putting ANGELA in the "Start at:" field and TODD in the "End at:" field. Or, you could choose not to include ANGELA by putting BILL in the "Start at:" field. Everyone in between the two chosen names will always be selected. To print just one user, place that name in both fields.

Question: **When running a GoldMine® Contact Report, if there is a page break in the middle of a long note, it does not show the rest of the note on the following page.**

**Answer:** According to FrontRange Solutions’ support, this is an incompatibility with the Windows 2000 and Windows XP operating systems. Our solution to this problem is using similar Crystal Reports such as the "History Report" instead of the GoldMine® report "Contact History Report w/Notes”. These reports are located under the Contact Reports section.

Question: **Some GoldMine® Label Reports start to run off of the label when I print them out. Can I adjust the placement of the text so they stay on the labels?**

**Answer:** If your office doesn't have another printer that you can print to without hassle then you can modify the reports page margins. This takes some trial and error so it is recommended to print test pages on regular paper (to be held against a labels sheet for comparison). Right-click on the report and choose **Layout.** Right-click again and choose **Report Settings->Options...** to modify the page margins on the report. Click **OK** when done, then click the **Save** button, then **Close**, and then run the report again to print out one page to see how your measurements came out. Repeat above steps, adjusting the margins, until you’ve gotten them to your liking.

Question: **When printing a calendar report, can you print schedules for more than one user at a time?**

**Answer:** GoldMine® Calendar Printouts cannot print the schedules of more than one user. However, the Breaking Away™ overlay does consist of a number of Crystal Report Calendar Printouts that will allow you to do this by adding the desired users as parameters.

Question: **How do I make my GoldMine® contact report or label report sort by the field I want it to? Even though I have the filter sorting by the field I want, the report sorts it differently.**
**Answer:** Report sorts will override filter sorts. On GoldMine® contact reports and label and envelope reports, you must configure the report sort by highlighting the report and clicking on the **Report Sorts** button on the toolbar in the Reports Center, or by right-clicking on the report and selecting **Sorts**. This will open the report properties on the **Sort Orders** tab. You can sort by up to three different fields for a primary, secondary and tertiary sort. Click the **OK** button and then run the report as normal.

**Question:** Why won’t a GoldMine® Report pull data after I’ve sorted by a certain field?

**Answer:** The report sort was changed to a field not actually used in the report. Right-click on the report (in the Report Center) and choose **Sorts…** to change the sort criteria back.

**Question:** Why is my report blank? It even says "Report Created Successfully" in the bottom left-hand corner...

**Answer:** There are a couple ways to make the data appear if this happens: Minimize the report window and then restore it again; or you can use the scroll bars to move the screen around until the data appears.

**Sync**

**Question:** How much memory will I need on my PDA if I want to put all of my contacts and some calendar data on it?

**Answer:** The general rule of thumb is that your data will take up 1KB per contact record and 1KB per calendar/history entry (without notes). Therefore, if you have about 2000 contacts and sync over about 500 calendar/history entries at any given moment, this can take up around 2.5MB of space on your PDA.

**Question:** In which folder are a contact’s Linked Documents stored on my laptop after I sync to my remote install of GoldMine®?

**Answer:** By default, TICOMIX sets it up to not sync linked documents. If you know that your settings are different, you can check them by selecting, from the Main Menu, **Tools→Synchronize→Synchronize Settings.**
**Templates**

**Question:** When I open the blank letter template in the Document Management Center, it opens the letter in WordPad instead of Word. How do I get it to open in Word where I can utilize the GoldMine® menu?

**Answer:** This issue usually only pertains to the blank letter template. To resolve the issue, first open the Document Management Center and make sure that the user is set to "(public)". Then, right-click on the "Blank Letter" template and select Properties. Answer NO to whether you want to create your own customized version of the template. Next, click on the Browse button next to the filename (the button with three dots) and select the "blank.dot" file by double clicking on it. Then, check to make sure that the "App Identifier" field in the Document Template Properties window is blank. Click the OK button.

**Question:** When I go to edit a document template, I get an error stating, "Ambiguous Name Detected:TmpDDE". What should I do?

**Answer:** If you are editing a document template and you choose SAVE AS GOLDMINE TEMPLATE, closing Word before it says that the "Document has been saved as a GoldMine Merge Form" may cause this issue to occur. Also, stopping a mail merge that is in process may cause this issue to occur.

To resolve this issue, first open Microsoft Word. Then, go to the Tools menu and select Macro->Macros. Look for "TmpDDE" in the Macros list. If found, highlight it and click the Delete button. If not found, click on the Organizer button and look for "TmpDDE" in either list on the Macro Project Items tab. If found, highlight it and click the Delete button. If it is open, close the Organizer window by clicking the Close button. Now, go to the Tools menu in Word and select Templates and Add-Ins. You should see "GMLink.DOT" listed with a checkbox next to it. Make sure the checkbox is checked. Click the OK button. Close Word and re-open the document template from the Document Management Center.

**Question:** Why do I get a "Runtime Error: 438" when trying to edit a document template or perform a mail merge in the Document Management Center on just my computer?

**Answer:** This error can occur for a number of reasons, mainly that the GMLink isn't set up properly or just isn't installed.

1) Go to Tools->Macros->Security Settings and make sure "Low" is selected. Then click OK.
2) Go to Tools->Templates and Add-Ins... and make sure GMLINK.DOT is selected. Then click OK. (If GMLINK.DOT is not even visible then we need to reinstall the program.)
3) To reinstall the GMLink program we need to first uninstall it and delete erroneous files. Please refer to the Breaking Away™ Reference Manual, Section II – G – "Installing/Reinstalling the GMLink".

**Question:** How do I install the GMLink plugin so I can perform mail merges with a GoldMine® document template?
Answer: Please refer to "Installing/Reinstalling the GMLink" in Section II-G of this manual for detailed instructions.

Question: When I click on a document template in the Document Management Center, its preview is black. How can I see the preview of the template again?

Answer: There are several possibilities that cause this. They depend on what was happening before this was noticed. Many answers are given and it is suggested to move to the next answer only if the previous one didn't work for you:

1. Close the Document Management Center then open it back up and double check the preview.

2. Right-click and choose Properties. Check the "Template Filename" to make sure it is pointing to the appropriate path. In many cases this can be corrected by simply removing the path from the "Template Filename" so that literally only the file name itself appears (this causes GoldMine® to look for the template in the default location which is the Template folder within the GoldMine® root directory on the server). For example, you would change "V:\Template\Blank Letter.dot" to "Blank Letter.dot". Make the necessary changes (click the button with three dots to browse for the file in the correct path) and click OK.

3. Edit the template by adding a GoldMine® field to it, deleting the field right away and then "saving the changes" (as a GoldMine® Template). For further instructions on how to do this, please view the training vignette entitled "Inserting Fields into GoldMine® Document Templates."
## B – GoldMine® Field Properties

<table>
<thead>
<tr>
<th>Database</th>
<th>Table</th>
<th>Local Label</th>
<th>Field Description</th>
<th>Field Name</th>
<th>Type</th>
<th>Len</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact1</td>
<td>Add</td>
<td>Address 1</td>
<td>ADDRESS1</td>
<td>Character</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Add</td>
<td>Address 2</td>
<td>ADDRESS2</td>
<td>Character</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>City</td>
<td>City</td>
<td>CITY</td>
<td>Character</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Company</td>
<td>Company Name</td>
<td>COMPANY</td>
<td>Character</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>PriName/Contact</td>
<td>Contact Name</td>
<td>CONTACT</td>
<td>Character</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Country</td>
<td>Country</td>
<td>COUNTRY</td>
<td>Character</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Dear</td>
<td>Dear Salutation</td>
<td>DEAR</td>
<td>Character</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Mail to</td>
<td>Department</td>
<td>DEPARTMENT</td>
<td>Character</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Ext</td>
<td>Home Phone Extension</td>
<td>EXT1</td>
<td>Character</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Ext</td>
<td>(Pri) Work Phone Extension</td>
<td>EXT2</td>
<td>Character</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Ext</td>
<td>FAX Extension</td>
<td>EXT3</td>
<td>Character</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Ext</td>
<td>Alt Phone Extension</td>
<td>EXT4</td>
<td>Character</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Fax</td>
<td>FAX</td>
<td>FAX</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Pri Soc Security # / CoTaxID</td>
<td>Pri Social Security # / Company Tax ID #</td>
<td>KEY1</td>
<td>Character</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Sec Soc Security #</td>
<td>Sec Social Security #</td>
<td>KEY2</td>
<td>Character</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Advisor</td>
<td>Key 3</td>
<td>KEY3</td>
<td>Character</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Rep ID #</td>
<td>Key 4</td>
<td>KEY4</td>
<td>Character</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Last</td>
<td>Contact's Last Name</td>
<td>LASTNAME</td>
<td>Character</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Merge</td>
<td>Mergecodes</td>
<td>MERGECODES</td>
<td>Character</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Home Phone</td>
<td>Home Phone</td>
<td>PHONE1</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>(Pri) Work Phone</td>
<td>(Pri) Work Phone</td>
<td>PHONE2</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Alt Phone</td>
<td>Alt Phone</td>
<td>PHONE3</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Contact Type</td>
<td>Source (Lead)</td>
<td>SOURCE</td>
<td>Character</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>State</td>
<td>State</td>
<td>STATE</td>
<td>Character</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Title</td>
<td>Contact Title</td>
<td>TITLE</td>
<td>Character</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>Contact1</td>
<td>Zip</td>
<td>Zip Code</td>
<td>ZIP</td>
<td>Character</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Sec Work Phone</td>
<td>Sec Work Phone</td>
<td>UPHONE4</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Ext</td>
<td>Sec Work Phone Extension</td>
<td>UBA_WP2EXT</td>
<td>Character</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>(Pri) Cell Phone</td>
<td>(Pri) Cell Phone</td>
<td>UPHONE5</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Sec Cell Phone</td>
<td>Sec Cell Phone</td>
<td>UPHONE6</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Phone Pref</td>
<td>Phone Preference</td>
<td>UBA_PRFPHN</td>
<td>Character</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Add</td>
<td>Pri Employer Add</td>
<td>UBA_EMPAD1</td>
<td>Character</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Add</td>
<td>Sec Employer Add</td>
<td>UBA_EMPAD2</td>
<td>Character</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Anniv Date</td>
<td>Anniv Date</td>
<td>UBA_ANNVD</td>
<td>Date</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Annual Income</td>
<td>Pri Annual Income</td>
<td>UBA_INCOM1</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Annual Income</td>
<td>Sec Annual Income</td>
<td>UBA_INCOM2</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Annuities</td>
<td>Pri Annuity Exper</td>
<td>UBA_ANNU1</td>
<td>Number</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Annuities</td>
<td>Sec Annuity Exper</td>
<td>UBA_ANNU2</td>
<td>Number</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Author</td>
<td>Pri Author</td>
<td>UBA_AUTHR1</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Author</td>
<td>Sec Author</td>
<td>UBA_AUTHR2</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Bonds</td>
<td>Pri Bonds Exper</td>
<td>UBA_BONDS1</td>
<td>Number</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Bonds</td>
<td>Sec Bonds Exper</td>
<td>UBA_BONDS2</td>
<td>Number</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Car</td>
<td>Pri Car</td>
<td>UBA_CAR1</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Car</td>
<td>Sec Car</td>
<td>UBA_CAR2</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Chocolate</td>
<td>Pri Chocolate</td>
<td>UBA_CHOCL1</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>Contact2</td>
<td>Chocolate</td>
<td>Sec Chocolate</td>
<td>UBA_CHOCL2</td>
<td>Character</td>
<td>25</td>
<td></td>
</tr>
</tbody>
</table>
### Section III

#### B – GoldMine Field Properties

<table>
<thead>
<tr>
<th>Field Description</th>
<th>Field Name</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td>City of Employment</td>
<td>UBA_EMPCT1</td>
<td>Character 30</td>
</tr>
<tr>
<td>Secondary City of Employment</td>
<td>UBA_EMPCT2</td>
<td>Character 30</td>
</tr>
<tr>
<td>Client Start Date</td>
<td>UBA_CLSTDT</td>
<td>Date 8</td>
</tr>
<tr>
<td>Client Status</td>
<td>UBA_STATUS</td>
<td>Character 20</td>
</tr>
<tr>
<td>Pri Coffee</td>
<td>UBA_COFFE1</td>
<td>Character 25</td>
</tr>
<tr>
<td>Secondary Coffee</td>
<td>UBA_COFFE2</td>
<td>Character 25</td>
</tr>
<tr>
<td>Contact Method</td>
<td>UBA_CTMTH1</td>
<td>Character 15</td>
</tr>
<tr>
<td>Secondary Contact Method</td>
<td>UBA_CTMTH2</td>
<td>Character 15</td>
</tr>
<tr>
<td>Date of Death</td>
<td>UBA_DOD1</td>
<td>Date 8</td>
</tr>
<tr>
<td>Secondary Date of Death</td>
<td>UBA_DOD2</td>
<td>Date 8</td>
</tr>
<tr>
<td>Pri Drink</td>
<td>UBA_DRINK1</td>
<td>Character 25</td>
</tr>
<tr>
<td>Secondary Drink</td>
<td>UBA_DRINK2</td>
<td>Character 25</td>
</tr>
<tr>
<td>Date Last Updated</td>
<td>UBA_LSTUPD</td>
<td>Date 8</td>
</tr>
<tr>
<td>Pri Employer</td>
<td>UBA_EMPLOY1</td>
<td>Character 30</td>
</tr>
<tr>
<td>Secondary Employer</td>
<td>UBA_EMPLOY2</td>
<td>Character 30</td>
</tr>
<tr>
<td>Estate Planning</td>
<td>UBA_ESTPLN</td>
<td>Character 3</td>
</tr>
<tr>
<td>Fed Tax Bracket</td>
<td>UBA_TAXB1</td>
<td>Character 6</td>
</tr>
<tr>
<td>Secondary Fed Tax Bracket</td>
<td>UBA_TAXB2</td>
<td>Character 6</td>
</tr>
<tr>
<td>Fin1 Planning</td>
<td>UBA_FINPLN</td>
<td>Character 3</td>
</tr>
<tr>
<td>Pri Flower/Plant</td>
<td>UBA_PLANT1</td>
<td>Character 25</td>
</tr>
<tr>
<td>Secondary Flower/Plant</td>
<td>UBA_PLANT2</td>
<td>Character 25</td>
</tr>
<tr>
<td>Pri Gender</td>
<td>UBA_GENDR1</td>
<td>Character 1</td>
</tr>
<tr>
<td>Secondary Gender</td>
<td>UBA_GENDR2</td>
<td>Character 1</td>
</tr>
<tr>
<td>Gym Membership</td>
<td>UBA_GYM1</td>
<td>Character 25</td>
</tr>
<tr>
<td>Secondary Gym Member</td>
<td>UBA_GYM2</td>
<td>Character 25</td>
</tr>
<tr>
<td>Pri Home Attraction</td>
<td>UBA_HMATT1</td>
<td>Character 25</td>
</tr>
<tr>
<td>Secondary Home Attraction</td>
<td>UBA_HMATT2</td>
<td>Character 25</td>
</tr>
<tr>
<td>Household Assets</td>
<td>UBA_HASSET</td>
<td>Number 10</td>
</tr>
<tr>
<td>Pri ID Exp Date</td>
<td>UBA_IDEXP1</td>
<td>Date 8</td>
</tr>
<tr>
<td>Secondary ID Exp Date</td>
<td>UBA_IDEXP2</td>
<td>Date 8</td>
</tr>
<tr>
<td>Pri ID Issue Date</td>
<td>UBA_IDISS1</td>
<td>Date 8</td>
</tr>
<tr>
<td>Secondary ID Issue Date</td>
<td>UBA_IDISS2</td>
<td>Date 8</td>
</tr>
<tr>
<td>Pri ID Number</td>
<td>UBA_IDNUM1</td>
<td>Character 20</td>
</tr>
<tr>
<td>Secondary ID Number</td>
<td>UBA_IDNUM2</td>
<td>Character 20</td>
</tr>
<tr>
<td>Pri ID Type</td>
<td>UBA_IDTP1</td>
<td>Character 20</td>
</tr>
<tr>
<td>Secondary ID Type</td>
<td>UBA_IDTP2</td>
<td>Character 20</td>
</tr>
<tr>
<td>Pri Source of Income</td>
<td>UBA_INCSR1</td>
<td>Character 30</td>
</tr>
<tr>
<td>Secondary Income Source</td>
<td>UBA_INCSR2</td>
<td>Character 30</td>
</tr>
<tr>
<td>Initial Contact Type</td>
<td>UBA_INICON</td>
<td>Character 20</td>
</tr>
<tr>
<td>Pri Inv Objective</td>
<td>UBA_INVOB1</td>
<td>Character 30</td>
</tr>
<tr>
<td>Secondary Inv Objective</td>
<td>UBA_INVOB2</td>
<td>Character 30</td>
</tr>
<tr>
<td>Last Notebook Update</td>
<td>UBA_NBUPDT</td>
<td>Date 8</td>
</tr>
<tr>
<td>Life Insurance</td>
<td>UBA_LIFINS</td>
<td>Character 3</td>
</tr>
<tr>
<td>Pri Liquid Nt Worth</td>
<td>UBA_LNW1</td>
<td>Character 25</td>
</tr>
<tr>
<td>Secondary Liquid Nt Worth</td>
<td>UBA_LNW2</td>
<td>Character 25</td>
</tr>
<tr>
<td>Long-Term Care</td>
<td>UBA_LTC</td>
<td>Character 3</td>
</tr>
<tr>
<td>Marital Status</td>
<td>UBA_MSTAT</td>
<td>Character 10</td>
</tr>
<tr>
<td>Pri Movie Genre</td>
<td>UBA_MOVIE1</td>
<td>Character 25</td>
</tr>
<tr>
<td>Secondary Movie Genre</td>
<td>UBA_MOVIE2</td>
<td>Character 25</td>
</tr>
<tr>
<td>Pri Music</td>
<td>UBA_MUSIC1</td>
<td>Character 25</td>
</tr>
<tr>
<td>Secondary Music</td>
<td>UBA_MUSIC2</td>
<td>Character 25</td>
</tr>
</tbody>
</table>

© TICOMIX 2009, All Rights Reserved
### Section III

<table>
<thead>
<tr>
<th>Contact2</th>
<th>Mutual Funds</th>
<th>Pri Mut Fund Exper</th>
<th>UBA_MUTFN1</th>
<th>Number</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact2</td>
<td>Mutual Funds</td>
<td>Sec Mut Fund Exper</td>
<td>UBA_MUTFN2</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>Contact2</td>
<td>Net Worth</td>
<td>Pri Net Worth</td>
<td>UBA_NETW1</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Net Worth</td>
<td>Sec Net Worth</td>
<td>UBA_NETW2</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Newsletter</td>
<td>Newsletter</td>
<td>UBA_NEWSLT</td>
<td>Character</td>
<td>3</td>
</tr>
<tr>
<td>Contact2</td>
<td>Newspaper</td>
<td>Pri Newspaper</td>
<td>UBA_NEWSP1</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Newspaper</td>
<td>Sec Newspaper</td>
<td>UBA_NEWSP2</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Notebook Rec'd?</td>
<td>Notebook Rec'd?</td>
<td>UBA_NTBKRC</td>
<td>Character</td>
<td>3</td>
</tr>
<tr>
<td>Contact2</td>
<td>Occupation</td>
<td>Pri Occupation</td>
<td>UBA_OCCUP1</td>
<td>Character</td>
<td>30</td>
</tr>
<tr>
<td>Contact2</td>
<td>Occupation</td>
<td>Sec Occupation</td>
<td>UBA_OCCUP2</td>
<td>Character</td>
<td>30</td>
</tr>
<tr>
<td>Contact2</td>
<td>Options</td>
<td>Pri Options Exper</td>
<td>UBA_OPTNS1</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>Contact2</td>
<td>Options</td>
<td>Sec Options Exper</td>
<td>UBA_OPTNS2</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>Contact2</td>
<td>Other</td>
<td>Pri Oth Inv Exper</td>
<td>UBA_OTHIIE1</td>
<td>Character</td>
<td>20</td>
</tr>
<tr>
<td>Contact2</td>
<td>Other</td>
<td>Sec Oth Inv Exper</td>
<td>UBA_OTHIIE2</td>
<td>Character</td>
<td>20</td>
</tr>
<tr>
<td>Contact2</td>
<td>Packet Status</td>
<td>Prospect Packet Status</td>
<td>UBA_PROPKT</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Partnerships</td>
<td>Pri Prtnrshps Exper</td>
<td>UBA_PRTNR1</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>Contact2</td>
<td>Partnerships</td>
<td>Sec Prtnrshps Exper</td>
<td>UBA_PRTNR2</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>Contact2</td>
<td>Pet</td>
<td>Pri Pet</td>
<td>UBA_PET1</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Pet</td>
<td>Sec Pet</td>
<td>UBA_PET2</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Place of Issue</td>
<td>Pri Place of Issue</td>
<td>UBA_ISSUE1</td>
<td>Character</td>
<td>20</td>
</tr>
<tr>
<td>Contact2</td>
<td>Place of Issue</td>
<td>Sec Place of Issue</td>
<td>UBA_ISSUE2</td>
<td>Character</td>
<td>20</td>
</tr>
<tr>
<td>Contact2</td>
<td>Prefix</td>
<td>Pri Prefix</td>
<td>UBA_PREFX1</td>
<td>Character</td>
<td>5</td>
</tr>
<tr>
<td>Contact2</td>
<td>Prefix</td>
<td>Sec Prefix</td>
<td>UBA_PREFX2</td>
<td>Character</td>
<td>5</td>
</tr>
<tr>
<td>Contact2</td>
<td>Pri Birth Date</td>
<td>Pri Birth Date</td>
<td>UBA_BDAY1</td>
<td>Date</td>
<td>8</td>
</tr>
<tr>
<td>Contact2</td>
<td>Rating</td>
<td>Rating</td>
<td>UBA_RATING</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>Contact2</td>
<td>REITs</td>
<td>Pri REITs Exper</td>
<td>UBA_REITS1</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>Contact2</td>
<td>REITs</td>
<td>Sec REITs Exper</td>
<td>UBA_REITS2</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>Contact2</td>
<td>Restaurant</td>
<td>Pri Restaurant</td>
<td>UBA_REST1</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Restaurant</td>
<td>Sec Restaurant</td>
<td>UBA_REST2</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Retire Date</td>
<td>Pri Retire Date</td>
<td>UBA_RETDT1</td>
<td>Date</td>
<td>8</td>
</tr>
<tr>
<td>Contact2</td>
<td>Retire Date</td>
<td>Sec Retire Date</td>
<td>UBA_RETDT2</td>
<td>Date</td>
<td>8</td>
</tr>
<tr>
<td>Contact2</td>
<td>Retired?</td>
<td>Pri Retired?</td>
<td>UBA_RET1</td>
<td>Character</td>
<td>3</td>
</tr>
<tr>
<td>Contact2</td>
<td>Retired?</td>
<td>Sec Retired?</td>
<td>UBA_RET2</td>
<td>Character</td>
<td>3</td>
</tr>
<tr>
<td>Contact2</td>
<td>Season Tickets</td>
<td>Pri Season Tickets</td>
<td>UBA_SEASN1</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Season Tickets</td>
<td>Sec Season Tickets</td>
<td>UBA_SEASN2</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Sec Birth Date</td>
<td>Sec Birth Date</td>
<td>UBA_BDAY2</td>
<td>Date</td>
<td>8</td>
</tr>
<tr>
<td>Contact2</td>
<td>Sec Name</td>
<td>Sec Name</td>
<td>UBA_SECNAM</td>
<td>Character</td>
<td>40</td>
</tr>
<tr>
<td>Contact2</td>
<td>Shirt Size</td>
<td>Pri Shirt Size</td>
<td>UBA_SHIRT1</td>
<td>Character</td>
<td>5</td>
</tr>
<tr>
<td>Contact2</td>
<td>Shirt Size</td>
<td>Sec Shirt Size</td>
<td>UBA_SHIRT2</td>
<td>Character</td>
<td>5</td>
</tr>
<tr>
<td>Contact2</td>
<td>Snack</td>
<td>Pri Snack</td>
<td>UBA_SNACK1</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Snack</td>
<td>Sec Snack</td>
<td>UBA_SNACK2</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Source</td>
<td>Source</td>
<td>UBA_SOURCE</td>
<td>Character</td>
<td>40</td>
</tr>
<tr>
<td>Contact2</td>
<td>Stage</td>
<td>Stage</td>
<td>UBA_STAGE</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>State</td>
<td>Pri Employer State</td>
<td>UBA_EMPST1</td>
<td>Character</td>
<td>3</td>
</tr>
<tr>
<td>Contact2</td>
<td>State</td>
<td>Sec Employer State</td>
<td>UBA_EMPST2</td>
<td>Character</td>
<td>3</td>
</tr>
<tr>
<td>Contact2</td>
<td>Stocks</td>
<td>Pri Stocks Exper</td>
<td>UBA_STOCK1</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>Contact2</td>
<td>Stocks</td>
<td>Sec Stocks Exper</td>
<td>UBA_STOCK2</td>
<td>Number</td>
<td>2</td>
</tr>
<tr>
<td>Contact2</td>
<td>Survey Rating</td>
<td>Annual Survey Rating</td>
<td>UBA_SURVEY</td>
<td>Character</td>
<td>10</td>
</tr>
<tr>
<td>Contact2</td>
<td>Tax Plan/Return</td>
<td>Tax</td>
<td>UBA_TAX</td>
<td>Character</td>
<td>3</td>
</tr>
<tr>
<td>Contact2</td>
<td>TV Show</td>
<td>Pri TV Show</td>
<td>UBA_TVSHO1</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>TV Show</td>
<td>Sec TV Show</td>
<td>UBA_TVSHO2</td>
<td>Character</td>
<td>25</td>
</tr>
</tbody>
</table>

© TICOMIX 2009, All Rights Reserved
<table>
<thead>
<tr>
<th>Contact2</th>
<th>Unique Info</th>
<th>Unique Info</th>
<th>UBA_UNIQUE</th>
<th>Character</th>
<th>55</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact2</td>
<td>Unsubscribes</td>
<td>Unsubscribes</td>
<td>UBA_UNSUBS</td>
<td>Character</td>
<td>20</td>
</tr>
<tr>
<td>Contact2</td>
<td>Update Freq</td>
<td>Update Frequency</td>
<td>UBA_UPDFRQ</td>
<td>Character</td>
<td>11</td>
</tr>
<tr>
<td>Contact2</td>
<td>Wine</td>
<td>Pri Wine</td>
<td>UBA_WINE1</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Wine</td>
<td>Sec Wine</td>
<td>UBA_WINE2</td>
<td>Character</td>
<td>25</td>
</tr>
<tr>
<td>Contact2</td>
<td>Zip</td>
<td>Pri Employer Zip</td>
<td>UBA_EMPZP1</td>
<td>Character</td>
<td>10</td>
</tr>
<tr>
<td>Contact2</td>
<td>Zip</td>
<td>Sec Employer Zip</td>
<td>UBA_EMPZP2</td>
<td>Character</td>
<td>10</td>
</tr>
</tbody>
</table>
C - Breaking Away™ Hot Keys for Tabs Reference

You will hold the Control (i.e., Ctrl) key down and then press the appropriate key. Some keys are duplicated. Press the key again until the desired tab is displayed.

- **Ctrl + S** Summary
- **Ctrl + Q** Relationships
- **Ctrl + F** Fields
- **Ctrl + P** Paperwork
- **Ctrl + R** Favorites
- **Ctrl + C** Contacts
- **Ctrl + D** Details
- **Ctrl + V** GM+View
- **Ctrl + P** Pending
- **Ctrl + H** History
- **Ctrl + R** Referrals
- **Ctrl + L** Links
- **Ctrl + N** Notes
- **Ctrl + V** Events
- **Ctrl + A** Accounts
- **Ctrl + B** Beny’s
- **Ctrl + L** Life_Ins
- **Ctrl + F** Finl_Plan
- **Ctrl + T** Tax
- **Ctrl + S** Estate
- **Ctrl + C** LTC
- **Ctrl + M** Members
- **Ctrl + T** Tracks
D - LPL Compliance

**LPL Electronic Communications Policy**

All LPL reps that use the GoldMine® Contact Management System are now required to discontinue the use of the internal user-to-user e-mail feature. Please take the time to read this document which outlines in detail the new policies and the reasons behind them. For your convenience and to ensure you have the most updated version, this document is also located on BranchNet in the Resource Center under Regulatory → Compliance → Electronic Communication Policy. This version of the document is current as of 10/12/2007.

**LPL Electronic Communications Policy Guidance for Advisors using GoldMine® Software**

LPL Financial Advisors using the GoldMine® contact management software for electronic communications have asked for clarification and guidance on the use of GoldMine® to ensure compliance with LPL’s new Electronic Communications Policy. To assist those offices, LPL has researched the options with FrontRange Solutions and provided the following information.

The Electronic Communications Policy requires that LPL captures and archives the electronic messages sent between persons within the same branch. The GoldMine® Contact Management System contains functionality that allows messages to be sent directly between GoldMine® users, bypassing the Internet. In this process, the email does not get routed through LPL or an LPL-approved email hosting vendor where it can be captured and archived. Instead, the message is merely sent within the GoldMine® database from one user’s account to another.

In order to comply with the Electronic Communications Policy, GoldMine® users are now required to adhere to the following practices:

- ALL messages must be sent to a person’s Internet email address (e.g., john.doe@doefinancial.com). This includes cc’s and bcc’s.
- GoldMine® user to GoldMine® user messages are prohibited except in the case that it is sent to the person’s Internet email address.
- GoldMine® email distribution lists cannot contain entries that refer to a GoldMine® user account (i.e., all entries must point to an Internet email address).
- Sending email to GoldMine® user groups is strictly prohibited.
- Using the “To: GoldMine® user or group…” option is strictly prohibited when sending email.
- It is prohibited to set up email rules to send, forward, re-direct, etc. any email to a GoldMine® user except in the case where the email is sent to the respective person’s Internet email address.
These policies pertain to all versions and builds of the GoldMine® Contact Management System.

**Advisors Using Email Addresses @lpl.com**
Advisor offices using LPL email addresses exclusively need to ensure their GoldMine® software is using the LPL email servers to both send and receive email messages. In order to comply with the policy, it is imperative that the LPL email server (smtp.mail.lpl.com) be the only server named in the sending mail server configuration. Sending email using your ISP email server will not achieve compliance with the policy.

GoldMine® users must send messages to each other by using the person’s Internet email address @lpl.com. This can be easily accomplished by having a GoldMine® system administrator set up a Contact Record in the GoldMine® system for each person in the branch office and specifying the firstname.lastname@lpl.com email address in the Contact Record. In addition, any Distribution Lists created using persons in the branch office must use their Internet Email address.

**Advisors Using DBA Domain Name Email addresses**
Advisor offices using email addresses at the DBA Domain Name can achieve compliance with the new policy by first moving the hosting of their email accounts to one of the LPL-approved email hosting vendors. Please see the Electronic Communications Policy information posted on the BranchNet Resource Center for guidance. Once this is accomplished, the GoldMine® system must be configured to send and receive all email through the email hosting vendor servers. Sending email using an ISP email server will not achieve compliance with the policy.

GoldMine® users must send messages to each other by using the person’s Internet email address. This can be easily accomplished by having a GoldMine® system administrator set up a Contact Record in the GoldMine® system for each person in the branch office and specifying their Internet Email address at the DBA Domain Name (john.doe@doefinancial.com) in the Contact Record. In addition, any Distribution Lists created using persons in the branch office must use their Internet Email address.

**GoldMine® Configuration Recommendations**
In order to facilitate proper adherence to the new policy, the following practices are recommended:

- Create a GoldMine® Contact Record for each person that contains their email address as hosted through an LPL-approved email hosting vendor. Then, when sending an email “internally” to another person in your office, open their respective contact record first and click on the “E-mail” field to initiate the composition of a new message.
- Make sure all current and future email distribution lists are set up to only include actual Internet email addresses as opposed to GoldMine® usernames.
- Make sure all current and future email rules are set up such that they do not send any email to GoldMine® users without it being sent to their respective Internet

© TICOMIX 2009, All Rights Reserved
Please note that you may experience slight delays in receiving your email messages when it is properly sent to your Internet email address as compared to your GoldMine® user account. This is normal and should be expected.

Since there currently is no feature built into GoldMine® to prohibit sending an email to a GoldMine® user without sending it to their respective Internet email address, it will be essential that these policies and practices are properly communicated to all staff within your firm. Further, it will be your responsibility to enforce these policies accordingly. Please refer to your GoldMine® VAR for assistance with implementing these policies as necessary. The LPL Home Office has requested that FrontRange Solutions add the ability for a GoldMine® system administrator to disable the GoldMine® User to User messaging feature. In order to further our compliance with the industry regulations, we suggest that each branch office using GoldMine® contact FrontRange Solutions and request this enhancement as well. This ability may become part of an upcoming product enhancement.

Thank you for your prompt attention to this matter.

For broker/dealer use only. Not for use with the public.
Member NASD/SIPC
E - Customizing Breaking Away™

The Breaking Away™ overlay is customizable to you and your business. Reports, automated processes, templates, etc. can all be customized to fit your needs and general requirements. There are a few guidelines to follow when doing this so that your customizations are not overwritten when new updates for the overlay are installed on your system.

When customizing the reports, automated processes, and templates in the Breaking Away™ overlay, you need to first “clone” them. This produces a copy so that you can make changes and not affect the original.

If you want to add or arrange any custom fields to the overlay, create a new, separate screen (i.e., tab). Make sure to give the tab a unique name so as not to duplicate a name being used on an existing tab.

Breaking Away™ comes with many detail types already configured. Some of these also have separate tabs assigned to them. These are for referencing different detail records on the Details tab. In order to avoid conflicting with functionality of the Breaking Away™ system, do not customize any that are already configured. Instead, create your own new detail types as desired. Again, if you assign them a tab, be sure not to duplicate an existing tab name.

To customize a filter, you should create a new one rather than making changes to the original.

The Knowledge Base contains links to documents you can customize. To do this, you open the document and save it as a separate document with a new name. You can then make changes to it. When completed you can create a new link for it in the Knowledge Base. Instructions for this are located in the Breaking Away™ Reference Manual in Section II.

Feel free to contact TICOMIX’s Technical Support Team at 1(866)TICOMIX regarding customizing your Breaking Away™ overlay. We are happy to assist you.